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NOTICES, RESTRICTIONS, DISCLAIMER, WARRANTY

Copyright Notice

ThisUser’s Manua and the Met Manager™ software are copyrighted © 1999-2002.

Y ou may print copies of this User’s Manual only for use by you (or your employees) and
only for use in supporting avalid license of the Met Manager ™ software. Y ou may not
distribute or transfer the User’s Manual outside of your organization.

Restrictions on Use of the Software

Installation and use of the enclosed software are governed by the terms of a Software
License Agreement. This agreement is available during installation of the software and
from the "Help" menu of the installed software. Y ou can also access this agreement as a
Microsoft Word® document file from the CD containing the software. If you (and your
employer) have not read the agreement or do not understand and agree to all of itsterms
and conditions, then do not install or use the software.

Disclaimer
Where the definitions and disclaimers defined below are different from the License
Agreement, the definitions and disclaimersin the License Agreement shall prevail.

Definitions:

a. “Licensor” means vendor, agent, or supplier of the Licensed Product (defined bel ow)
and as specifically defined in the License Agreement.

b. “ Licensee” meansthe individual or entity acquiring or using the Licensed Product
(defined below).

c. “Licensed Product” means (i) the computer program(s) in binary, executable or other
form associated with the License Agreement, whether resident on media or installed
on acomputer, (ii) Software Updates (defined below), and (iii) Documentation
(defined below).

d. “ Software Updates’ means enhancements, corrections, modifications or additions to
the Licensed Product including but not limited to replacement versions of the Licensed
Product.

e. “ Documentation” means auser’s manual or other materials and documentation
accompanying the Licensed Product or related to the installation or use of the Licensed
Product. Documentation may be in hardcopy or electronic format.

f. * Instrumentation” means one or more devices, sensors, or subsystems at asingle Site
(defined below) and used directly or indirectly to measure, detect, indicate or control a
variable or value.
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0. “ Results” means the data or derivative data that the Instrumentation or Licensed
Product creates, acquires, averages, totals, calculates, displays, presents, records,
stores, transmits, summarizes, reports, or uses.

h. “ Ste” meansthe single, contiguous physical location of Licensee' s operations where
the Instrumentation is located.

i. “Computer” means a microcomputer containing the Microsoft Windows® operating
system software (“OS’), provided, however, the Licensed Product is compatible with
the OS and isintended by Licensor to execute on the same microcomputer with the
OsS.

J. “Authorized Computer(s)” means either (i) in the event Licensee does not obtain a
Multi User Certificate (defined below), a single Computer located at the Site, or (ii) in
the event Licensee obtains a Multi User Certificate (defined below), one Computer for
each Authorized Computer specified in the Multi User Certificate, all of which are
located at the Site.

k. “Multi User Certificate” means an origina and authentic “ Certificate of Multi-User
Software License” purchased by Licensee and signed by Licensor specifying the
maximum number of Authorized Computers at the Site on which the Licensed Product
may be installed and used.

Licensor does not have any control over the conditions under which the Licensee uses the
Licensed Product and does not and cannot warrant the Results obtained by such use.
Licensor does not warrant the features, functions or contents of the Licensed Product or
that the Licensed Product or Results obtained from use or operation of the Licensed
Product will be uninterrupted or error free. Licensor is not responsible for problems
caused by operating characteristics of any computer hardware or operating system (OS)
on which the Licensed Product isinstalled or operated, or which occur as aresult of the
use of the Licensed Product in conjunction with software or with hardware which is
incompatible with the OS or with the Licensed Product. The Licensed Product is
furnished “AS 1S’ and without warranty as to the performance or the Results which
Licensee may obtain by using the Licensed Product. Licensee assumesthe entirerisk as
to the results and performance of the Licensed Product.

Licensee understands that Instrumentation is, by its nature, sensitive, and may be affected
over time by external forces. Itis, therefore, entirely incumbent on Licensee to routinely
(i) inspect, maintain, and calibrate the Instrumentation, (ii) perform quality assurance
with respect to the Instrumentation and its integration with the Licensed Product, (iii)
perform quality control with respect to the Instrumentation and its integration with the
Licensed Product, and (iv) validate and verify the Results for reasonability. The failure
of Licensee to do any of the foregoing on aroutine basis may negatively impact the
quality and reliability of the Results. Unless agreed under a separate written contract,
Licensor shall have no obligation to inspect, maintain, or calibrate the Instrumentation,
perform quality assurance or quality control, or validate or verify the Results. Licensee
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further acknowledges that persons using the Licensed Product are responsible for the
supervision, management, and control of the Licensed Product. This responsibility
includes, but is not limited to, the determination of appropriate uses for the Licensed
Product and the selection of the Licensed Product and other programs or Instrumentation
to achieve the intended Results. Persons using the Licensed Product are responsible for
establishing the adequacy of independent procedures for testing the reliability and
accuracy of the Results, including all data created, acquired, averaged, totalized,
calculated, displayed, presented, recorded, stored, transmitted, summarized, reported, or
used by the Licensed Product.

No representations are made with respect to the contents of this User’s Manual. Further,
we reserve the right to revise this manual and to make changes to the content from time
to time without obligation to notify any person of such revision.

Trademark Notice
Met Manager™, Met Viewer™ and Met Mirror™ are trademarks of Sensible
Technologies, Inc., Houston, Texas.

Trademarks or trade names are subject to state and federal laws concerning their
authorized use or other infringements. The fact that some product marks or names in this
manual may not bear atrademark symbol DOES NOT mean that the product name or
mark is not registered as a trademark or trade name. Any queries concerning the
ownership or existence of any trademarks or trade names mentioned in this manual
should be independently confirmed with the manufacturer or distributor of the product.

Revision Notice (of this User’s Manual)

Release Number | Rev | Date of Release Description

450.078.001 1.0 | April 20, 2002 Initial release

450.078.001 1.1 | June 18, 2002 Incorporate customer feedback

450.078.001 1.2 | July 21, 2002 Include software enhancements

450.078.001 1.3 | August 14, 2002 Maintenance release

450.078.001 1.4 | September 16, Graph and wind rose auto-scale
2002 enhancements; new trouble-shooting

section; new calibration capability

450.078.001 1.5 | December 6, 2002 | Add agriculture and energy parameters
and reports. Add “difference” asa
derived parameter.

Warranty
No warranties are made with respect to thisUser’s Manual. The software is warranted
per the terms of its accompanying Software License Agreement.

Notices -iii- Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

TABLE OF CONTENTS

NOTICES, RESTRICTIONS, DISCLAIMER, WARRANTY ..t i
1 INTRODUGCTION. ...ttt e ettt e s s eae e s s st e e s s e bee e s sabe e e s eabbesssabeeesssabaeesasbeesssbeeessssrenesan 1-1
1.1 [ =T 1-1
1.2 FEATURES OF MET MANAGER SOFTWARE .....uuttitiieeiiiiiiiirieesssssssssssessssssssssssssssesssssssssssssesssanns 1-1
1.3 FEATURES OF MET MIRROR SOFTWARE ..o itttitiiee e esittetie e s e s e ssibaseee s s s s ssasasesssssssesssbssssasseenns 1-3
14 FEATURES OF MET VIEWER SOFTWARE ....ccoiiitttitiie e s cesiibetie e s s s s ssbbasees s s s s sssssasssssesssesssssssssesseenns 1-3
15 ORGANIZATION OF USER’ S IMANUAL «.uuttiiiieiiiiiitteiiee e s eesiatteeseesssesasbssseessssssssssssessessssssssssessssnns 1-3
2 OV ERVIEW ...ttt ettt sttt e e e ettt e s e et e s st a e e s ettt e s saaeeeesasbeeesaabeeessasseessabeeeessnsbenesanes 2-1
2.1 MINIMUM REQUIREMENTS FOR USING THE SOFTWARE .....cciiiteeeeeeteeeeeeeeesessveeesesseeesssseessssseeeeas 2-1
2.2 OVERVIEW OF THE SOFTWARE SUITE ...veeiiictiieeeiteeee s eteeeeereesssseeesssssessssssesesssssesssssesssessesssssenes 2-1
A R €= 1 = - 2-1
222  Met Manager SOMWAIE.......coiiiiieierieieeie ettt 2-2
2.2.3  MELMITTON SOMWAI Bttt ettt et e e ettt e e s et et e s s e e e s e abaeessaaseessasbeeessbenesanes 2-2
224  MELVIBWES SOFIWAIE ...eeeieeeiie et ee ettt sttt e s st e s sttt e e seaeeeessabeeassssaesssasseeesssbesessnseeessane 2-2
225 PrOJECE FOIOES ... oottt bbbt e et e b e bbb esaeeae e e aneas 2-3
2.3 SCENARIOS FOR USING MET MANAGER, MET VIEWER AND MET MIRROR ...uvvviieeiiiiiiinieeeeeeane 2-3
2.3 1 GENEAl OVEIVIEW...... ettt e ettt e s ettt e st e s s st e e s sebae e s sbaeessssbesssasseeessabeeessabensssne 2-3
232 Scenario 1: Met Manager Only; Local PC (NON-NEWOTK) .......cccevverierevesiereceeeeeesee e 2-3
233 Scenario 2: Met Manager and Met Viewer; Peer-to-Peer Network.........coccveveceeveceinennn, 2-4
234 Scenario 3: Met Manager and Met Viewer; File Server NEtWOrK........ccovevvevevevenevesnenne, 2-5
235 <cenario 4: Met Manager, Met Viewer and Met Mirror; File Server Network
WIth MITrOred Database........cceeiviiieieiiie ettt sre s e sbes e sbe s e ebessreesares 2-6
3 INSTALLING AND CONFIGURING MET MANAGER........ ettt 31
31 INSTALLING THE SOFTWARE ....oittttiieeeeiiesitteeesesssesassssssesssssssssseeesssssssssssssasssssssssssssesssssassssnes 31
3.2 STEPS TO SETTING UP MET MANAGER ..veeiieiiiiitteiiee e e eesttee e e e s s s e sabeee s e s s sessasbasesasssessbbssesasssenns 31
33 CREATING A NEW PROJECT ...evvtiiiiii ettt ee sttt s e s s s e saatbae e s e s s s esaabseesesssssssbbasesesssessbbenesasssanas 3-3
3.3.1 Creating a New Project from SCratCh..........cccoriiiiiienereeeeee e e 33
3.3.2 Creating a New Project froman EXisting Project ..........coveerrieienine e 3-6
34 CONFIGURING THE SITE SETTINGS ....ccittitiieeiiiiitteeieeessisssreeseesssasssssssssssssssssssssssssssssssssssessssssnns 3-9
35 CONFIGURING THE DATA SOURCE .....uttiiiiiiiiiiititiiee e s e ssibaseeee s s s esbareees s s s sesababasesesssesasasesssessas 3-10
351  OVErVIEW Of DAta SOUICES......ccveeievee ettt ettt s te s s s s e s s be s s bessabessbessabessabessareeas 3-10
352 “Direct Connect” Data SOUrCe ProPErti€S.......ccccvereiirieieseseeeeeeseeseseesseseseesseseeseeeens 314
35.3 “Datalog Capture (Modem)” Data Source Properti€S......ccovvveveereererenenieseseesieeeeneens 314
354 “Datalog Capture (COM Port)” Data Source Properties........cccoveeeeeeeverenesesiesnnnnns 3-16
355 CSVor DatalLog“File Import” Data Source PrOperti€S......ccouverevenieveseneneeeeseeieneens 3-16
3.6 ASSIGNING SENSOR CHANNELS TO THE DATA SOURCE ...cieviiiiititiieee et iee e sararen e e 3-16
3.7 ASSIGNING PARAMETERS TO STORE IN THE DATABASE ...eiiiiiiiitieeieee ettt iee e siaraeee e s 3-23
38 DEFINING THE DATA TABLES OF THE DATABASE......cccctttiieei ettt estarae e s e s s e ssarases e s s eans 3-29
3.9 CONNECTING TO THE DATA SOURCE (BEGIN ACQUIRING DATA) .....oiuiiirieierienee e 331
4 USING MET MANAGER ...ttt e ettt eetae e st e e s eate e s snaeessesbeeseenrenesannneas 4-1
4.1 CONNECTING TO A PROJECT ..uuttiiiieiiiiiiitiieie e e eestbeee e e s s s esaabbasssesssasasbssseesssassssbasssesssessssrssssesssasns 4-1
4.2 CONFIGURING THE PROJECT ..uuttiiiie ettt ettt essitte e e e s s e satbase e e s s s s saabbaneeesseesanbbanesesseanns 4-2
4.3 VAT ALY 1= N OO RRRON 4-3
44 VIEWING DATA TABLES. ..utttttiiiiiiiitiettieeeeesittereeesseesssssseeesssssassssseeesssssassasssessesssasssssssesesssnssnnres 4-4
45 VIEWING EVENT LOGS ... uuttiiiiiiiiiiiiiiiie e e e sttt e e e s e sitbaae e e e s e s sebasaeeesssssnsasseeesesssessssesesesssnnsnnres 4-5
46 VIEWING INSTANTANEOUS DATA ....uttiiieiiiiiiiieitie e e e escirreeeee s e e sssasseeessesssssssseeesesssessnssesssesssnsnnnes 4-7
4.7 MAINTENANCE AND CALIBRATION ...uuttiiiieiiieiitrerieesssesissssteessessssssssessssssssssssssssesssssssssssssesssenns 4-9

Table of Contents -iv- Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

471  Setting the Status of @ ChannEl ..o 4-9
472  Calibrating @ Channel ... e 4-9
v C T Yo V= Ui g To TE= W B T o 0o oo OSSO 4-9
474  Packing the Database..........ccurriiriiriirieieie ettt e sb e e e e e 4-9
475 Restructuring the Database..........ccooeiiiiiiee e e e 4-9
4.8 CREATING TREND CHARTS ...utiiuiiiieesieesteesreseeseesmeesseessessesseesseesseessesssesssesseesseesseensssnsssnesssesnns 4-10
481 Creatinga New Trend Chart ... s s 4-10
4.8.2 Exampleof a 0-360 Scalar Wind Direction Trend Chart .........cccccevevievenievesecesceceeceennn, 4-13
4.8.3 Exampleof a 0-540 Scalar Wind Direction Trend Chart .........cccceveeevenieveveseseeeeseenens 4-16
484  Adding Sandard Deviation of Wind Direction to the Trend Chart..........ccccoovvvvecveenen. 4-19
485  Setting up a Dual Trend Chart with Wind Speed and Wind Direction.........cccccceeevverenee. 4-21
ST 1 - Tor = g Tox o RS 4-25
49 VIEWING TREND CHARTS. .. ceittiiiiiesteesteeteeteeseesteesteesbestessessessaeesaeessssnsesnsesseassesssessesnsessenss 4-26
491  Opening & Trend Chart.........oooieieiieee e e sae e eaeas 4-26
4.9.2  Automatically Opening a Trend Chart at Startup.........ccoceeerererieeneene e 4-26
4.9.3  TheTrend Chart TOOI Bar ...t st s s sae e seeneeeas 4-26
494 Deeting aTrend Chart.........ccciieii it e e snees 4-27
4.10 ADDITIONAL EXAMPLES OF TREND CHARTS....coittiittieeiee e stee st enessnesseessee s e e sseseesneesneesees 4-28
4.10.1 =T 1= TSR 4-28
4.10.2 Ambient Temperature and Relative HUMIdity.........cccooovvvvieiecceceee e 4-30
4.10.3 RS o] F= Tl == o [ LA o o (SRRSO 4-33
411 CREATING INDICATOR VIEWS ...ttt sttt ettt sne st e s sr bt sb e nn e n e e sne s 4-34
4111 GELLING SEAMEA......c.eeveieieeiertieei et b e b 4-34
4112 Description Of the TOOI Bar ........coccieiieiririeirereeneeeese e 4-36
4113 Creating a Wind DireCtion INAiCALO ..........ccoeeririeirineree e 4-37
4114 Creating a Wind Speed INAICALON ..........coiiiririeeee e 4-44
4115 Positioning the Wind Direction and Wind Speed Indicators ..........ccoovereieieeiinnenene. 4-45
4116 Creating Ambient Temperature INdiCatorS..........cooeierenererieee e 4-46
4117 Creating Rain INiCALONS .......cueieiesese et s re e e 4-51
4.11.8 The Final “ Current Weather” Indicator VIEW........c..covveveiinenne s 4-53
412 USING INDICATOR VIEWS. ..c.ueiiueeiteenteeteeresseesseesie s s snssessseesseessessesnessseesseesesnsesnsesaessaesssesnnes 4-54
412.1 Opening an INAICALOr VIBW..........ccoeiirere e seesie e e et sneeneennens 4-54
4122 Automatically Opening an Indicator View at Startup........cccceeveeeveereresiesesesesseeseens 4-55
4123 Renaming an INdiCAtOr VIBW .........cocciiirieiniiieirieeie et 4-55
4124 Deleting an INdICALOr VIBW........ccouceiireirierieinenieenie st 4-56
413 CREATING A WIND ROSE ...ttt sttt ettt sttt st sae e saeenee st e saeenseenee 4-57
4131 LT ] gTo S = (=" OSSPSR 4-57
4132 Description Of the TOOI Bar ........coooiiiiiieeeee e e 4-57
4.13.3 Creating @ WINA ROSE ..ot s 4-58
4134 Editing @ WINA ROSE ......coieieiece ettt st sa et s ne s re e 4-61
414 VIEWING WIND ROSES......coittitieiieiesieestee e s e s s sne s e sneesre e nesnnesanesneesaeesneenneennas 4-61
414.1 Opening aWINA ROSE VIBW.......cc.ciiiiciiecieeeeee sttt sa et sttt st neeneennens 4-61
414.2 Automatically Opening a Wind Rose View at Sartup........cccceeveeeveerernneseseesesseeseens 4-61
415 CONFIGURING DATA TABLE VIEW AND REPORT OPTIONS ......cciitirterieeieeeeneseesresre e sreseeeenes 4-62
415.1 Configuring the OPLiONS ........ccvviie e eens 4-62
4152 Configuring the Data View COIUMNS.........coooiiriiirieiees e 4-62
4.15.3 Configuring the RepOrt COlUMNS.........coeiiirieiriieeree e e 4-62
4154 Configuring the REPOrt HEATES ........coeiiiriiiieeee e e 4-63
4155 Setting Up @n AULO REPOIT ..ottt e e 4-64
4.16 CONFIGURING STARTUP OPTIONS .....utitteteeteseesueesseasseesesssesseassesssesssesasssssssseessesssssnsesnssssesnes 4-64
417 GENERATING REPORTS .....ctiiiiiiiiiiiesieestee e et ste et eas e eaeesbe e be e besssesaeesaeesaeeseeeseenseeneanseanes 4-65
417.1 (T L]0 = (= o [ RSSSN 4-65
417.2 Description of the TOOI Bar ......c.ccvceiiieiececeece e st 4-66
4.17.3 (D= 1= R = o 1= = oo 4-67
4174 Daily SUMMArY REPOI.......ceeeie ettt st sr e e e s 4-68
4175 (D= Y = T g1 =1 B o 4-69

Table of Contents -v- Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

4.17.6 Monthly Parameter REDOMT ........ooeiiireeniereeesereee sttt s 4-70
4.17.7 Monthly WINnd Frequency REPOI ..ottt 4-71
4.17.8 Monthly Data RECOVENY REPOIT.........ooiiiiireeeireeie ettt s 4-72
4.17.9 Chill HOUF REPOIT ...ttt sttt e st see b e 4-74
4.17.10 Chill UNit REPOIT ...ttt sttt st s sb e een 4-75
41711  Growing DEgreeS REPOIT .....ccviciii ettt sa et st re e e enaeneas 4-76
41712  Evapotranspiration REPOIT ........cc.cceeierireieseseseeteeeesee e sres e sae e ssesseeseeseessesaessessesnens 4-77
41713  Heating DegreeS REPOI ......ccvce i sie ettt s reene e e enaennas 4-78
41714  Co0ling DegreeS REPOM ......cciveiiiiiieeceereee e s et e e e e e ae et sreene e eneenaanees 4-79
4.18 WVWINDOW MENU ...viiitieiieeeiteectee s steeete e e stee et e e steeste e e steesatesssseesnbeesseesnseesseesnsesssessnsesanseesnsenan 4-80
4.19 L L= T = N 4-80
420  EXPORTING DATA ..ooiiiiiiic bbb e 4-81
421 SETTINGUPA PRINTER ..ottt bbb s 4-84
422  EXITING THE PROGRAM ....ciitiiiitiiteinti sttt s s 4-84
5 MAINTENANCE AND CALIBRATION.....co oottt see e stee s et e e sree e s s nre e snte e s nee s 51
51 SETTING THE STATUS OF A CHANNEL .veeeiitiieeeitieeecteeeeetreeeetreeeesateeesenseeesssseessssseeesesseessnnns 51
52 L7 NI =] Ny 1 N S 5-1
521  Overview of the Calibration PrOCESS.........ccoviiiiieiiriecieeire ettt sre e sre e ens 51
5.22 Calibrating Sensor-based Channels...........cocciviiiii s 5-2
5.2.3 Recovering Calibration COeffiCientS ........ccoevevirieie s 59
53 ACTIVATING A DEBUG LOG .....ooiiiieiiei st ctee st ste s ste e te e s te e sate e steesnae s snaeesnae s snaeennaeesnaeenenans 5-10
54 PACKING THE PROJECT DATABASE ....ooiiictiie e ceee ettt e e ettt e s st e e st e e s e nee e e snne e e enntee e ennneeessnnenen 5-11
55 RESTRUCTURING THE PROJECT DATABASE ....ciiciieitie e estte e riteestee e siee e tee e snaeestae e snaeesnae e snne s 5-13
6 TROUBLESHOOTING ....ooi ittt ettt et tee e te s st e s be e s ebeesnbe s sebeesnte s sbeesnbessbeesnbessseesnreesn 6-1
6.1 TECHNICAL REQUIREMENTS RELATED TO MICROSOFT WINDOWS.......ccoivieeieerieeeieesieeesee s 6-1
6.2 STANDARD TIME AND DAYLIGHT SAVING TIME .eeeiiiiiieeeiiee e eeee ettt e et eaeee et e e e e 6-1
6.3 INETWORKING. ... cutiieiitiie e ettt e e eittee e e ettt e e eetaeeeeesteeeessbeeeeasseeasassseaaaasseeesassesasasseeasaasseessanseeasassenanan 6-2
6.4 FREQUENTLY ASKED QUESTIONS....cccctttitiriiseessreesisessstesssessssessssessssesssssssssessssessssessssssssssssssnssns 6-3
L R B T {1411 (o] SR 6-3
(O B T = o o [0 = PPV PPPR 6-3

(O TG B B T = B o 1 [ o TSP 6-4
L = 0= ot S 6-5
LTS 1 (S 1 (o S 6-5
(ST I B T v R = o] [OOSR 6-5
6.4.7 Data Source Parameters and Database Parameters............cccovveveeieeneececceesee e 6-6
(ST T B T - Y 1= Y SRR 6-8
(SRS T 1 ¢ 0o [ o 7= T (OO RPROPSRRTTN 6-8
6.4.10 100 o= Lo TR PSRRI 6-9
6.4.11 WVINA ROSE......eeeciic ettt ettt e e e st e e ae e e s bt e e st e e sbeeesaeeeebeeesaseesbeeesaseebesesseeenrenan 6-9
6.4.12 REP IO TS, ..ttt e a e b e be e ree s 6-9
6.4.13 Wind Speed and Wind Direction Parameters.........oceceveeeveeeceeseese e seeeens 6-10
6.4.14 COMMUNICALIONS ....cveeieetecie e see st et ete e e ereeebe et e et e ebesabesaeesbeesreesseensesnsssreesseebeenrenns 6-11
6.4.15 MISCEIIANEOUS ...ttt ettt e bt e et e e besaaesaeesbeesreenneeareenns 6-11

Appendix A: Acquired and Derived Parameters
Appendix B: Met Mirror Utility

Appendix C: Met Database Utility

Appendix D: Command Line Options
Appendix E: Calibration Overview

Table of Contents -Vi- Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

1 INTRODUCTION

1.1 General

Congratulations on your selection of Met Manager™ software with your weather
(meteorological) station. Met Manager provides a powerful and easy way to acquire and
view weather datain avariety of ways.

Weather systems are used in many applications including air quality monitoring,
diffusion modeling, environmental health and safety (EH& S), environmental studies,
agriculture, education, energy, fire weather, research, etc. Generally, the purpose of a
weather station is to measure and report data that is representative of the local
environment. This data may include any combination of wind speed, wind direction,
temperature, humidity, pressure, solar radiation, and precipitation (or rainfall).
Additional data may include voltage, user-defined parameters, agricultural parameters
(soil moisture, soil temperature, leaf wetness, and so forth) and many others (see
Appendix A for acomplete list).

1.2 Features of Met Manager Software
Some of the features of the Met Manager software include:

e Acquires datain real-time when supported by the datalogger in your weather
station. Thelink between the PC computer and the weather station’ s data logger
isseria RS-232 by direct connection. The connection is usually by serial cable,
short haul modem, or wireless radio modem. Depending on the capabilities of the
datalogger, the weather station may measure sensory data as fast as once per
second.

e Acquires data by capturing it from the internal memory of the datalogger (if
supported by your datalogger). The link between the PC computer and the data
logger is usualy by dial modem or cellular modem, but can also be a direct
connection.

e |sdatabase-centric. Acquired datais stored in adatabase on a PC computer,
workstation, or a Microsoft®-compatible network file server.

e Storesacquired datainto database tables at user-selected intervals of 1, 5, 10, 15,
20, and 30 minutes and hourly. The data can represent averages, totals,
minimums, maximums, standard deviations, change, rates of change, and so forth.
Y ou can easily view historical data of any of the tables by simple reverse
scrolling.

e Thedatarecordsin each datatable can be kept indefinitely, or can be deleted
from the database by a user-defined "wrap" interval (expressed in days). For
example, you may want to keep 1-minute data for 7 days, 5-minute data for 90
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days, and 15-minute and hourly data indefinitely.

e Calculates many derived parameters from the measured parameters. For example,
general industrial and non-industrial derived parameters include wind chill
temperature, heat index temperature, dew point temperature, wet bulb
temperature, peak wind speed, scalar and resultant vector horizontal wind speed
and direction, unit vector wind direction, Sigma Theta (standard deviation of
horizontal wind direction), Sigma Phi (standard deviation of vertical wind
direction), and so forth. Energy derived parameters include heating and cooling
degree days. Agricultural derived parameters include growing degree days and
hours, reference and crop evapotranspiration, and chill units and hours.
Additionally, when acquiring data in real-time from adirect connection to the
datalogger, Met Manager can derive minimums, maximums, change, rates of
change, difference, and standard deviations for most parameters.

e |s"project-based.” Dataisstored in aproject folder that you name.

e Makes extensive use of trend graphics. Y ou can setup named trend charts with
multiple traces per chart, use of dual y-axis, and so on. These graphs can also be
printed and copied to the clipboard.

e Displaysawind rose for graphically viewing wind speed and wind direction data
asajoint frequency distribution. You can select time periods of 1, 3, 6, 8, and 12,
hours, and daily, weekly, monthly or custom-defined.

e Displays readings with one or more indicator views. Y ou can setup multiple
indicator views to indicate current readings with the use of digital indicators,
vertical bar graphs, 120°, 180° and 270° meters, wind direction labels (e.g., SSE,
CALM, etc.) and wind direction indicators.

e Generates serially-complete data tables. Missing data records are flagged with a
missing statustag. Invalid and calibration data are also tagged within the data
tables.

e Letsyou change the units of measurement for display and reporting purposes.
e Handles sensor slope and offset calibration needs.

e Generates fault, communication error, and system event logs. Acquired sensory
datais automatically range-checked against limits that you define.
Communication faults are logged for system failure diagnostic purposes.

e Generates anumber of very useful reports including various datalog reports,
daily summary report, rainfall report, wind frequency distribution report, monthly
parameter reports, and monthly data recovery. Agricultural summary reports
include reference and crop evapotranspiration, chill hours/units, and growing
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degree days/hours. Energy summary reports include heating and cooling degree
days.

¢ And has many other features including data export to another drive path in
comma-delimited (CSV), Paradox and dBase formats, a report header that you
define, and so on.

Met Manager can run on a variety of Microsoft Windows operating systems (Windows
95, 98, NT 4.0, 2000, and XP). Met Manager can run on a desktop PC or notebook
computer, or on aworkstation of a Microsoft-compatible network. Network
architectures include peer-to-peer and file server.

1.3 Features of Met Mirror Software

The use of Met Mirror™ software is optional. Met Mirror allows you to create and
maintain amirror image of data tables on a network file server from a database managed
by Met Manager on aworkstation. This allows you to acquire and store weather data on
aworkstation independently of the network, but then replicate the data to the network for
use by others (by the use of Met Viewer as discussed below). Should the network go out-
of-service for some reason, or be down for maintenance, Met Manager will continue to
store its data on the local workstation. Then, when the network is back online, Met
Mirror can be reactivated to “catch-up” the mirrored datatables. The Met Mirror
software is automatically installed with the Met Manager software.

1.4 Features of Met Viewer Software

Met Viewer™ software is useful for allowing other network users to have access to the
weather database. 1n a peer-to-peer or file server network, Met Viewer attachesto the
database maintained by Met Manager, or to areplicated database maintained by Met
Mirror. With Met Viewer, you can recal, view, graph, indicate, report, and export the
datain avariety of ways, and in the same way as Met Manager.

The Met Viewer software product is purchased separately from Met Manager. Met
Viewer licenses are available for 1, 5, 10, 20, 50, and unlimited number of users (at one
physical site location).

1.5 Organization of User’'s Manual

Section 2 provides an overview of the software including minimum computer
regquirements, and use of Met Manager, Met Mirror and Met Viewer in both non-
networked and networked environments.

Section 3 discusses software installation and configuration.
Section 4 provides a detailed description on using Met Manager.

Section 5 discuses maintenance and calibration operations.
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Section 6 includes some pointers on troubleshooting, and alist of frequently asked
guestions.

Appendix A isalist of acquired and derived parameters managed by the software.
Appendix B isan overview on installing, configuring, and using the Met Mirror software.

Appendix C provides an overview on installing and using the Met Database Utility
(MetDBU) software.

Appendix D provides command line options useful for starting Met Manager, Met
Viewer and Met Mirror in particular ways.

Appendix E presents an overview of the calibration process. An endpoint-to-endpoint
calibration is discussed, as well as pros and cons to consider when deciding where and
how to make calibration adjustments.
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2 OVERVIEW

2.1 Minimum Requirements for Using the Software

The Met Manager software is usually installed on a desktop or notebook personal
computer (PC), or on aworkstation. Minimum and recommended requirements are listed
below.

PC computer with a Pentium or compatible processor

Pentium Il (or compatible) or higher processor recommended

Processor speed of 180 MHz (300 MHz or higher recommended)

Microsoft Windows® 95/ 98/ NT4.0/ 2000 / XP Operating System (98 or later
recommended)

32 MB RAM memory (64 MB or more recommended)

e Hard disk space requirements: less than 10 MB for programs; database storage
requirements vary depending on the number of data channels, frequency of data,
and time period of data stored. A minimum configuration may require 5 to 10
MB of data storage, and a maximum configuration may require 100 or more MB.
Display resolution of 800 x 600 (1024 x 768 or higher recommended)

CD-ROM drive (for installation of the software only)

Standard floppy disk drive (for some installations only)

A printer is recommended but not required

A modem may be required for some applications

Standard Microsoft® network protocols are required when used in a network

2.2 Overview of the Software Suite

2.2.1 General

The Met Manager™ suite of software includes Met Manager™, Met Viewer™, and Met
Mirror™. Met Manager and Met Mirror come together on one CD. Met Viewer is
purchased separately.

Met Manager acquires data from the data logger of a weather station, processes and
stores both acquired and derived datainto a project database, and lets the user view,
trend, indicate, and report the project data. The project database can be located on a
standal one desktop PC, on aworkstation of a network, or directly on a network server.

Met Manager can run by itself, or in conjunction with Met Viewer™ and/or Met
Mirror™ software.

Met Mirror is used to mirror a copy of the master project database to other locations
within a network. Itsuseis optional.
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Met Viewer allows other workstations in a network setting to view, trend and report the
project data. Met Viewer getsits data directly from the original or amirrored project
database.

This manual focuses on Met Manager and Met Mirror, but also provides an overview of
the Met Viewer software.

2.2.2 Met Manager Software

Met Manager acquires sensory data from a data logger and derives many additional
parameters (see Appendix A). Data parameters, whether acquired or derived, are saved
in a user-defined project database for viewing, trending, and reporting.

Met Manager makes data available to the user in several formats: data tables, trend
charts, indicator pages, wind roses, and reports. Met Manager also logs communication
and sensor faultsthat it detects.

Some of the reports provided by Met Manager include data table reports, daily summary
report, daily rainfall report, monthly parameter reports, monthly wind frequency report,
and data recovery report.

Additional features of Met Manager include user selection of measurement and display
units, applying slope and offset calibration values to each sensor channel, and exporting
of the database in comma-delimited ASCII, Paradox, and dBase file formats.

2.2.3 Met Mirror Software

Met Mirror softwareis used only in a networked environment and its use is optional.
Met Mirror isused to mirror a copy of Met Manager’s project database to another
computer on a peer-to-peer or file server network. Typically thisis done for the
following reasons:

e Met Manager can store its data on alocal workstation, and in away that is
independent from other users on the network. Other users may access the
copy created and managed by Met Mirror, but cannot access the original
project database.

e Met Mirror isalso useful for situations in which the network may temporarily
go out of service. Inthissituation, Met Manager continues to acquire and
store data on its local workstation, and Met Mirror will update the mirrored
copy on the network when the network server is back on line.

The Met Mirror software is discussed in Appendix B.

2.2.4 Met Viewer Software

Met Viewer software is used only in a peer-to-peer or file server-based networked
environment. The operation of Met Viewer isvery similar to Met Manager. The primary
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difference isthat Met Manager getsits data from the data logger and stores that data and
additional derived data into a project database. Met Viewer does not get data from a data
logger. Met Viewer getsits data from the project database.

A separate User’s Manual is available for Met Viewer with the purchase of Met Viewer
software.
2.2.5 Project Folder

The weather database managed by Met Manager is stored in a“project” folder
(directory). The project folder is governed by the following general rules:

e Met project folders are generated by Met Manager or mirrored by Met Mirror.

e Met Manager, Met Mirror and Met Viewer can access a project folder through
any valid Microsoft® operating system mechanism that supports read/write/create
access permission for the connected system. Connection mechanismsinclude, but
are not limited to, alocal folder, alocal area network (LAN) shared folder, a
remote access (RAS) connection to a shared folder, etc.

e TheMet Viewer program can access any valid project folder. Thisfolder can
exist on alocal path or anetwork path. The network path can be through aLAN
or remote access dial-up connection. Met Viewer must have read/write/create
access permission to the project folder.

2.3 Scenarios for Using Met Manager, Met Viewer and Met Mirror

2.3.1 General Overview

Itisrelatively easy to acquire sensor-based data with Met Manager. However, it isalso
important to be able to have easy access to the data once it is acquired. In this section,
several scenarios provide an overview on how data can be distributed and accessed.

2.3.2 Scenario 1: Met Manager Only; Local PC (Non-network)

In this scenario, Met Manager storesits weather data in a database in a project folder
named “A Met Project” (it can be any name - you name it when you configure Met
Manager) on the“C:” hard drive of a desktop computer, as shown in the figure below.

Local PC (Not Networked)
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This scenario is very common for the following cases:

e With Met Manager, a PC computer has adirect link (hard wire, direct modem,
or wireless) to adatalogger of aweather station. The project databaseis
stored on the PC and is not shared with othersin a network.

e With Met Manager, a PC computer dials out to the wesather station. The data
log is captured from the data logger and is stored on the PC in a project
database. The database is not shared with othersin a network.

Requirements include:

e TheMet Manager user must have read/write/create access permission to the
project folder.

e The Met Manager program must have read/write/create access permission to
the Windows registry.

2.3.3 Scenario 2: Met Manager and Met Viewer; Peer-to-Peer Network

In this example, Met Manager stores its database in a project folder named “A Met
Project” on the local workstation’s“C:” hard drive. One or more users can then connect
directly to the main Met Manager project folder (in this example, “c:\A Met Project”)
with the Met Viewer software using standard Microsoft peer-to-peer networking
protocols.

Peer-to-Peer Network
Requirements include:

e TheMet Manager user must have read/write/create access permission to the
project folder located on its workstation.

e TheMet Manager program must have read/write/create access permission to
the Windows registry on its workstation.
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e Met Viewer peer-to-peer network users must have read/write/create access
permission to the project folder located on Met Manager’ s workstation.

e TheMet Viewer program must have read/write/create access permission to the
Windows registry on its workstation.

2.3.4 Scenario 3: Met Manager and Met Viewer; File Server Network

The following example demonstrates a file server network with Met Manager and two
Met Viewer users. Met Manager runs on aworkstation and creates and maintains its
project folder on the server (in this example, “\\server\share\Met\Site 2”). One or more
Met Viewer users (on other workstations) then connect directly to the main Met Manager
project folder on the server (“\\server\share\Met\Site 27).

File Server Network
Requirements include:

e TheMet Manager user must have read/write/create access permission to the
project folder located on the network file server.

e TheMet Manager program must have read/write/create access permission to
the Windows registry on its workstation.

e Met Viewer network users must have read/write/create access permission to
the project folder located on the network file server.

e TheMet Viewer program must have read/write/create access permission to the
Windows registry on its workstation.
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2.3.5 Scenario 4: Met Manager, Met Viewer and Met Mirror; File Server Network

with Mirrored Database

This scenario demonstrates a file server network with Met Manager, Met Mirror and two
Met Viewer users. Met Manager manages a master project folder located on its local
workstation (in this example, “c:\A Met Project”). Met Mirror creates and mirrors a copy
of the master database of the project folder onto the server (in this example
“\server\share\Met\Site 2”). One or more Met Viewer users then connect directly to the
mirrored project folder on the server (“\\server\share\Met\Site 2").

File Server Network - Mirrored Project Database

Requirements include:

The Met Manager user must have read/write/create access permission to the
master project folder located on its workstation.

The Met Manager program must have read/write/create access permission to
the Windows registry on its workstation.

Met Mirror resides on the same workstation as Met Manager. Met Mirror
mirrors a copy of the master project database to the network file server. Thus
the Met Mirror user must have read permission to the master project folder
located on its workstation and read/write/create permission to the mirrored
project folder located on the network file server.

The Met Mirror program must have read/write/create access permission to the
Windows registry on its workstation.

Met Viewer network users connect directly to the mirrored project folder
located on the network file server. Thus, Met Viewer users must have
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read/write/create access permission to the project folder located on the
network file server.

e TheMet Viewer program must have read/write/create access permission to the
Windows registry on its workstation.
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3 INSTALLING AND CONFIGURING MET MANAGER

3.1 Installing the Software

IMPORTANT: Met Manager uses the Windows registry to retain information about how
it was last shut down. Thisinformation isthen read from the registry on startup.
Therefore, Met Manager must be installed in away that it can have create/read/write
access to the Windows registry. Before installing the software, ensure that your
Windows log-on profile is configured to allow Met Manager to have create/read/write
access to the Windows registry.

Refer to Section 2.3 for scenarios for using Met Manager, Met Viewer, and Met Mirror.
Included are requirements for project folder read/write/create access permission
depending on your application requirements.

To install the software simply place the Met Manager installation CD in to the CD drive.
Theinstall program should automatically run. Then follow the on-screen instructions.

If the install program does not automatically run, then follow these steps (with the CD in
the CD drive):

1. Click on the"start" button (on Windows desktop), then select the "run" menu
item.

2. Typed:\install.exe (replace "d" with the drive designator of your CD drive) and
press the OK button.

IMPORTANT: After installing the software, be sure to review the README.TXT text
| filelocated on the installation CD. This file includes additional documentation not
| included in this User's Manual aswell asalist of known issues with the software.

3.2 Steps to Setting Up Met Manager
After the Met Manager software isinstalled, it must be configured for use. Follow these
steps:

1. Onyour computer, check the Microsoft Windows' computer date, time and
time zone settings. Correct them if necessary. Ensure that the Windows-based
daylight saving time adjustment setting is checked (enabled) if daylight saving
time applies to your computer during any time of the year.

2. Create aproject folder to store data and configuration settings. Y ou have two
options: 1) create a new project from scratch or 2)create a new project from an
existing project. See Section 3.3.
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10.

11.

12.

13.

14.

Configure site settings such as latitude, longitude, elevation, and time zone.
See Section 3.4.

Configure the data source. This defines where the sensory data comes from; for
example, continuous direct-connection with the datalogger in real time or by
dial-up connection to the internal memory log of a datalogger. See Section 3.5.

Assign parameters to the data source. This defines the various sensor channels
and ordering of datareceived from the data logger, and the base units,
measurement height, decimal display digits, and slope and offset coefficients to
convert the acquired measurement to base units. See Section 3.6.

Assign parameters to be stored in the database. This defines both acquired
sensor parameters and derived parameters to be stored in a database for later
viewing, trending, reporting and exporting. See Section 3.7.

Define data tables and related time interval s to hold the database parameters.
Tablesinclude 1, 5, 10, 15, 20, 30-minute, and hourly time intervals. See
Section 3.8.

Connect to the data source. With this step, Met Manager can begin receiving
data from the weather station. See Section 3.9.

After following the instructions in Section 3.9, verify that Met Manager is
receiving data from the data source. View the data from the Instantaneous View
(see Section 4.6) and the Data View (see Section 4.4). If you have intermittent
communication problems, review the “ Current Data Source Events’ tab of the
Event Log. See Section 4.5.

Calibrate the weather station sensors and subsystems. See Section 5.2 and
Appendix E.

Review the “ Current Faults’ tab of the Event Log to ensure that all measured
values are within the minimum-to-maximum range defined for each data source
parameter. See Sections 4.5 and 3.6.

Configure new trend charts and review existing ones (if any). See Sections 4.8,
4.9 and 4.10.

Configure new indicator pages and review existing ones (if any). See Sections
4.11 and 4.12.

Configure anew wind rose or review an existing one (if any). See Sections
4.13 and 4.14.
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15. Configure the Data View and report options. See Section 4.15.

16. Configure display options when Met Manager is started. See Section 4.16.

IMPORTANT: Configure Met Manager to automatically startup when Windows starts
up. Place a shortcut of the Met Manager executable program (MetMgr.exe) in the
Windows “ Startup” folder. Thisfolder may be located under “ Administrators’, “All
Users’, “Default Users*, or may be applicable only to your particular log-on profile
depending on your version of Microsoft Windows. Check with your network or system
administrator for the proper startup folder to contain the Met Manager shortcut.

Command line options can be used to force Met Manager to open a particular project and
data source when starting up in Windows. Command line options are not required, but if
you use them, you will want to assign them to the Met Manager shortcut in the Windows
“Startup” folder. See Appendix D.

3.3 Creating a New Project

Met Manager storesits datainto a“project”. A project issimply afolder name that you
assign, and is alocation for holding the data and configuration settings associated with
the project. To create anew project, select “New Project” from the File menu. Seethe
figure below.

Y ou have two options: 1) create a new project from scratch or 2) create a new project
based on an existing project. Each of these optionsis explained below.

3.3.1 Creating a New Project from Scratch

In the example below, a new project is created from scratch on drive C of the local
workstation, and is named “ Weather Data’.
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(The above figure is an example only; your configuration may be different.)

Be sure to include the drive designator to the project path/folder name. In the above
example, the drive designator is“C:\"; yours may be different. Y ou can also pressthe
“browse” button to locate the path or folder that will contain your project folder.

Y ou must configure all elements of a new project that is created from scratch. Follow
these steps in the order given:

1. Configure your site settings for the location of the weather station. These settings
include latitude, longitude, elevation and time zone. See Section 3.4.

2. Configure the data source; that is, define where the sensory data comes from and
properties such as serial communications port or modem and phone number, baud
rate and so forth. See Section 3.5.

3. Assign parametersto the data source. This defines the various sensor channels
and ordering of datareceived from the data logger, and the base units,
measurement height, decimal display digits, and slope and offset coefficients to
convert the acquired measurement to base units. See Section 3.6.
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4. Assign parameters to be stored in the project database. This defines both acquired
sensor parameters and derived parameters to be stored in a database for later
viewing, trending, reporting and exporting. See Section 3.7.

IMPORTANT: Besureto review all wind speed and wind direction database
parameter assignments for your particular application. Wind speed database
parameters include scalar wind speed and resultant wind speed. Wind direction
database parameters include scalar wind direction, resultant vector wind direction,
and unit vector wind direction. USEPA or other state or local governmental
requirements may require specific parameters, or may require all, depending on
your application. When in doubt you may wish to record all of them. That way,
the datawill be available should you later need it.

5. Define datatables and related time intervals to hold the database parameters.
Tablesinclude 1, 5, 10, 15, 20, 30-minute, and hourly time intervals. See Section
3.8.

IMPORTANT: USEPA or other state or local governmental requirements may
require that you record your data at specific intervals, usually 15-minutes and
hourly. However, you may wish to also record 1-minute data with a short wrap
interval of 7, 14, or 30 days and 5-minute data with awrap interval of 1to 3
months. That way you can inspect the data at a higher frequency. In order to
minimize data storage and potential problems with larger data tables, we
recommend that you limit your 1-minute data table to 1 month (30 days) of
storage or less, your 5-minute data table to 6 months (185 days) or less, and your
10-minute data table to 1 year (365 days) or less. The 15-minute, 20-minute, 30-
minute, and hourly data tables can be kept indefinitely.

6. Connect to the data source. With this step, Met Manager can begin receiving data
from the weather station. See Section 3.9.

After you have connected to the data source and followed the guidelines of Section 3.9,
then complete these steps:

1. Verify that Met Manager is receiving data from the data source. View the data
from the Instantaneous View (see Section 4.6) and the Data View (see Section
4.4). If you have intermittent communication problems, review the “ Current Data
Source Events’ tab of the Event Log. See Section 4.5.

2. Cdlibrate the weather station sensors and subsystems. See Section 5.2 and
Appendix E.

3. Review the“Current Faults’ tab of the Event Log. If it isempty then all
measured values are within the minimum-to-maximum range defined for each
data source parameter. See Sections 4.5 and 3.6.
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4. Configure new trend charts. See Sections 4.8, 4.9 and 4.10.

5. Configure new indicator pages (views). See Sections4.11 and 4.12.
6. Configureawind rose. See Sections4.13 and 4.14.

7. Configure the Data View and report options. See Section 4.15.

8. Configure display startup options. See Section 4.16.

9. Configure Met Manager to automatically startup when Windows starts up.

3.3.2 Creating a New Project from an Existing Project

A new project can be created from an existing project. Met Manager ssmply copies over
the existing project configuration settings to the new project folder. This greatly
simplifies setting up a new project.

In the example below, a new project is created on drive C of the local workstation, and is
named “Weather Data”. This new project is created from an existing project named
“seawall site” that islocated on drive C in folder “projects’.

(The above figure is an example only; your configuration may be different.)

This method is useful for starting a new project to hold the weather data while keeping
your existing site settings, data source parameter settings, database parameter settings,
data table settings, trend charts, and indicator displays. The new project gets the old
configuration settings and begins a new database from those settings.

This method is also useful for starting a new project with configuration settings supplied
by the manufacturer of the weather station. Check your weather station
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documentation to seeif you can create a new project based on an existing factory-
supplied configuration. If available, the factory configuration will usually be supplied
on a separate floppy disk or CD. This can save you time in getting your project
configured and operating.

Be sure to include the drive designator to the project path/folder names. In the above
example, the drive designator is*“C:\”; yours may be different. Y ou can also pressthe
“browse” button to locate the path or folder that you want to put your project folder in.

Y ou must configure some of the elements of anew project that is created from an existing
project. Configuration stepsinclude:

1. Check your site settings. These will be zero if you created your project from a
factory-supplied configuration. See Section 3.4.

2. Check your data source assignment and configure its properties as needed,
especially the communication port or modem settings. See Section 3.5.

3. Check your sensor channel assignments to the data source. Add or delete channel
assignments as needed. See Section 3.6.

4. Check your measured and derived parametersto store in the PC’s database. Add
or delete database parameters as needed. See Section 3.7.

IMPORTANT: If you are creating a new project from afactory-supplied
configuration, then be sure to review all wind speed and wind direction database
parameter assignments for your particular application. Wind speed database
parameters include scalar wind speed (default) and resultant wind speed. Wind
direction database parameters include scalar wind direction (default), resultant
vector wind direction, and unit vector wind direction. The factory-supplied
configuration may only include the default parameters. However, only you (or
your employer) can determine which parameters apply to your particular
application. USEPA or other state or local governmental requirements may
require specific parameters, or may require all, depending on your application.
When in doubt you may wish to record all of them. That way, the datawill be
available should you later need it.
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6.

Check your data tables to hold the parameters in the project database; 1-minute
table, 5-minute table, and so forth. Make any needed changes to the configuration
such asincluding or excluding tables from the database, or modifying the “wrap
interval” of each table. See Section 3.8.

IMPORTANT: USEPA or other state or local governmental requirements may
require that you record your data at specific intervals, usually 15-minutes and
hourly. However, you may wish to also record 1-minute data with a short wrap
interval of 7, 14, or 30 days and 5-minute data with awrap interval of 1to 3
months. That way you can inspect the data at a higher frequency. In order to
minimize data storage and potential problems with larger data tables, we
recommend that you limit your 1-minute data table to 1 month (30 days) of
storage or less, your 5-minute data table to 6 months (185 days) or less, and your
10-minute data table to 1 year (365 days) or less. The 15-minute, 20-minute, 30-
minute, and hourly data tables can be kept indefinitely.

Connect to the data source to begin acquiring data. See Section 3.9.

After you have connected to the data source and followed the guidelines of Section 3.9,
then complete these steps:

1.

Verify that Met Manager is receiving data from the data source. View the data
from the Instantaneous View (see Section 4.6) and the Data View (see Section
4.4). If you have intermittent communication problems, review the “ Current Data
Source Events’ tab of the Event Log. See Section 4.5.

For anew system, calibrate the weather station sensors and subsystems. See
Section 5.2 and Appendix E.

Review the “ Current Faults’ tab of the Event Log. If it isempty or there are no
current faults, then all measured values are within the minimum-to-maximum
range defined for each data source parameter. See Sections 4.5 and 3.6.

Modify existing trend charts and create new ones as appropriate. See Sections
4.8, 4.9 and 4.10. Y ou may haveto acquire data for awhile (from afew hoursto
aday or so) so that you can see how the trend chart handles the data.

Modify existing indicator pages and create new ones as appropriate. See Sections
4.11and 4.12.

Modify the existing wind rose or create a new one as appropriate. See Sections
4.13 and 4.14. Aswith trend charts, you may have to acquire datafor awhile so
that you can see how the wind rose handles the data.

Review and configure the Data View and report options. See Section 4.15.
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8. Review and configure display startup options. See Section 4.16.
9. Configure Met Manager to automatically startup when Windows starts up.

3.4 Configuring the Site Settings

Site settings are used to define the location of the weather station and time zone
information. To configure the site settings, select the Setup menu and then “ Site
Settings’:

Next, define the latitude, longitude, and elevation at the location of your weather station,
and the time zone:

Latitude and longitude are a coordinate system used to locate points on the earth’s
surface. Latitude is the angular distance, in degrees, minutes and seconds of a point north
or south of the Equator. Longitude isthe angular distance, in degrees, minutes, and
seconds of a point east or west of the Prime Meridian (Greenwich, England). Longitudes
are measured in half circles of 0 deg to 180 deg East and from O deg to 180 deg West of
the Prime Meridian.
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All USA points are located with northern latitude and western longitude. Y ou may be
able to get latitude and longitude for your location from the world wide web. Simply
search the web for the keywords “latitude” and “longitude”. The web also has calculators
for converting decimal degrees to the “ degree, minute, second” format required by Met
Manager.

Enter the elevation of the location of the weather station in meters.

The "Time zone offset" is normally zero, but can be set to +30 or -30 if your specific time
zoneis not listed but is 30 minutes from the closest time zone listed in the "Time zone"
list box. Usually the “Time zone offset” is not required since most worldwide times
zones are listed.

Note: The latitude, longitude, and time zone settings are used in calculations that require
locating the orientation of the sun. Elevation is useful for estimating barometric pressure.
Be sure to define the elevation in meters.

Latitude, longitude and elevation settings are required for calculating reference
evapotranspiration. Be sureto properly setup these parametersif you are using Met
Manager to calculate r efer ence evapotranspiration.

3.5 Configuring the Data Source

3.5.1 Overview of Data Sources

Met Manager getsits raw sensor-based data from a data source. A data sourceissimply
an object such as adatalogger or datafile that is the source of sensory-based data.

Met Manager commonly interfaces to the following types of data sources depending on
the capabilities of your datalogger:

e “Direct Connect” data source. Thisincludes adatalogger that is directly-
connected to the computer on which Met Manager resides, and that regularly
transmitsits datato Met Manager. The direct connection can be by serial
cable, short haul modem, other direct-connect modem, or wireless radio
modem.

Choose a“ Direct Connect” data source when the PC computer is directly-
connected to the data logger of the weather station and you want to frequently
(at least every few seconds or so) get data from the logger.

e “DatalLog Capture (Modem)” data source. Thisincludes aremote data logger
that storesits datainto an internal memory log and must be periodically
captured by Met Manager. Met Manager connects to the data logger with a
dial modem or cellular phone.
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Choose a“Data L og Capture (Modem)” data source when you wish for Met
Manager to get data from the internal memory log of a remote data logger by
telephone modem or cellular phone dialup.

e “DatalLog Capture (COM Port)” datasource. Thisincludes a datalogger that
is directly-connected to a COM (serial) port of the computer on which Met
Manager resides but that storesits data into an internal memory log and only
periodically transmitsitsinternal log to Met Manager on request of Met
Manager. The direct connection can be by serial cable, short haul modem,
other direct-connect (i.e., non-dial) modem, or wireless radio modem.

Choose a“Data L og Capture (COM Port)” data source when the PC is directly
connected to a data logger by serial communications (COM) and you wish to
capture data from the log memory of the datalogger periodically, but rather
infrequently. For example, this option could be used to get data once a day,
every few days, or on demand.

This data source is also useful when your weather station isin aremote
location with no telephone access. Y ou travel to the remote location with a
notebook PC, connect up, and then with Met Manager you capture the data
from the data logger to the notebook PC.

e CSV or datalog “File Import” data source. Choose this data source to build
the Met Manager database by importing acomma-delimited (CSV) fileor a
datalog file that has already been saved to disk.

Note: Different data logger applications support different types of data sources. Some of
the data sources defined above may not be available to you, depending on the particular
capabilities of your system.

To configure your data source, first select the Setup menu, then “Data Sources”:

Configuring Met Manager Page 3-11 Rev: 1.5




Met Manager ™ User’s Manual Copyright © 2002

If no data sources have been assigned, then the following dialog will be displayed.

Pressthe “New” tool button to pick and assign a data source for your particular
application:

Press the down arrow button to select the type of data source that you want to create:

Direct Connect

Data L og Capture (COM Port)
Data L og Capture (Modem)
Data Log File Import

CSV File Import
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Note: Thelist above shows different types of data sources for different data logger
applications. Your list may be different and may not include al of the above types of
data sources, depending on the capabilities of your system.

After picking adata source from the list, adisplay similar to the following is shown, with
the new data source then being added to the “ Data Sources’ display:

(The above figure is an example only; your configuration may be different.)

IMPORTANT: With your mouse, select the data source that you want to use and then
press the “ Set as Default” button to make that particular data source the active one. A
little check mark should appear above the data source, and the name will be assigned as
the default in the “ Default Data Source” field at the bottom of the dialog box.

Note: Actual data source names may include a one or two word descriptor that identifies
the datalogger and precedes the names given above.

CAUTION: While the above figure shows that multiple data sources can be created for
an application, you may activate only one data source for a particular project. Therefore
you should create only one data source for your particular application. Remove unused
data sources by deleting them (as explained below).

To delete a data source, select itsicon, then press the “ Delete” button. Y ou can always
recreate it later by pressing the “New” button should your application requirements
change.

To rename a data source, select the data source icon, then press the “Rename” button.
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IMPORTANT: The name of the data source may be used by other services of the Met
Manager Suite of software; for example for startup automation of Met Manager (see
Appendix D). Therefore, if you change the name of the data source, be sure to
reconfigure any other servicesthat refer to that data source with the new name.

Once a data sour ce has been created, you must further edit its properties. Select the
data source icon with the mouse, then press the “Properties’ button (or double-click the
icon). The following sections discuss ways to configure the properties of different types
of data sources.

3.5.2 “Direct Connect”’ Data Source Properties

To set the properties of the “Direct Connect” data source, select itsicon with the mouse
(or double click it), then pressthe “Properties’ button. Configure the communications
COM port setting, baud rate, and sample rate. The following example shows
communications with the data logger through the PC COM1 port at a baud rate of 9600.
A samplerate of 5 seconds means that Met Manager will receive data from the data
logger every 5 seconds.

(The above figure is an example only; your configuration may be different.)

Note: The data logger must be programmed to transmit its datato Met Manager at the
configured samplerate. Programming the data logger is outside of the scope of the Met
Manager software. Refer to your weather station or data logger manuals or consult with
your weather station or data logger vendor.

3.5.3 “Data Log Capture (Modem)” Data Source Properties

To set the properties of the “Data Log Capture (Modem)” data source, select itsicon with
the mouse (or double click it), then press the “Properties’ button. Configure the active
modem device, phone number, sample rate, and number of channelsin the datalog:
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(The above figure is an example only; your configuration may be different.)

Note: Prior to setting up the “Data Log Capture (Modem)” data source, you must first .
install the computer’s modem in Microsoft Windows. Thisistypically done with modem |
software supplied by the modem manufacturer, and is outside the scope of the Met
Manager software. If not installed beforehand, then the “modem device” field list may be
blank. i

Be sure to obey the phone number dialing rules at your location. Some places require a
10-digit phone number for local calls. Most places require a1 before the 10-digit
sequence for long distance calls. Some internal telephone systemsrequire dialing a9
followed by a short delay to get an outside line. To do this, enter 9 followed by a comma.
Each comma creates a two second delay. To make the delay longer, simply insert more
commas. For example, suppose you wish to dial along-distance number to area code
“123" and need to select 9 to get an outside line. The entry format would be 9,1-123-
456-7890.

IMPORTANT: Set the sample rate to match the rate in which the data logger storesits
| datawithin itsinternal log memory. For example, this may be once every 5 minutes

| (00:05:00), 15 minutes (00:15:00) or once per hour (1:00:00). In the above example, a

| sample rate of 15 minutes means that the data logger will log a data record to its internal
| memory every 15 minutes.
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Note: Some data logger configurations may not require the “Number of channelsin data
log” field above. Inthat case the field will be missing from the dialog. Other
configurations may have a“clear” setting for user control over clearing the memory log
of the data logger.

Note: The data logger must be programmed to store data into its internal memory log and
to transmit the log to Met Manager when requested by Met Manager. Programming the
datalogger is outside of the scope of the Met Manager software. Refer to your weather
station or data logger manuals or consult with your vendor.

3.5.4 “Data Log Capture (COM Port)” Data Source Properties

To set the properties of the “Data Log Capture (COM Port)” data source, select itsicon
with the mouse (or double click it), then press the “Properties’ button. Configure the
serial communications port (COM1, COM2, etc.), baud rate, sample rate, and number of
sensorsinthedatalog. Thisissimilar to configuring the “Data L og Capture (Modem)”
data source above except that you configure a serial communications port instead of a
modem.

3.5.5 CSV or Data Log “File Import” Data Source Properties

To set the properties of a“File Import” type of data source, select itsicon with the mouse
(or double click it), then press the “ Properties’ button.

(The above figure is an example only; your configuration may be different.)

Configure the sample rate to match the time interval of the data within the imported file.
The format is“hh:mm:ss” where “hh” is hours, “mm” is minutes, and “ss’ is seconds.
For example, if the data records are 15 minutes apart, then set the sample rate to
“00:15:00".

3.6 Assigning Sensor Channels to the Data Source

The purpose of assigning sensor channels to a data source (typically a data logger but
sometimes an import datafile) isto let Met Manager know the order and type of
information coming from the data source. Y ou must have separate documentation on
sensor channel assignments from your wesather station supplier.

The linkage between Met Manager and the data source is defined by the type and order of
data within the output data stream of the data source:
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Data Source Data Stream

Example Data Stream

09/16/2002,07:30:00,4.23,326,21.3,29.92,0.00,78.1,11.53,23.4,653,1234
—_—— T o — —_—

L—— Checksum (optional)
Solar Radiation
Enclosure Temperature

Battery Voltage

Relative Humidity

Rainfall

Barometric Pressure

Ambient Temperature

Wind Direction

Wind Speed

Time (Capture and File Data Sources Only)

Date (Capture and File Data Sources Only

The above figure is meant to show an example of a data stream to illustrate the importance of
ordering within the stream. Your configuration will probably be different. Depending on your
particular data logger model, continuous direct-connect data sources may not include the date and
time parameters (if these parameters are assigned by Met Manager). The checksum helps to
identify communication errors but is optional with some data loggers. Also, the above example
shows a comma as a data delimiter; however, other data sources may use other delimiters.
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CAUTION: Unlessyou are setting up a brand new project, and you wish to add or |
remove one or more sensor channels or database parameters to (or from) the project, then |
follow the guideline below. Read al of the steps below before making any changes. '
Then make the changes in the order given.

Guideline for Adding or Deleting Data Source or Database Parameters

1. Before adding or removing data source parameters (that represent sensors) or

database parameters:

a. Stop Met Manager (exit the program).

b.

If you have a peer-to-peer network configuration, then stop any Met
Viewer users attached to the master project folder. The master project
folder isthe one managed by Met Manager.

Back up the master project folder (or copy the entire project folder to an
archive location). Be sureto first exit the Met Manager program (step a),
so that Met Manager will not be adding new data to the project database
while the backup (or copy) program isrunning. The purpose of the
backup (copy) isto both protect your master weather database should you
make a mistake, as well as to archive your master database before making
substantial changesto it. Keep in mind that removing sensors from the
data source will likely affect your derived database parameters.

2. If you are using the optional Met Mirror software to mirror your local weather

database to a network file server or other location, then:

a. Stop Met Mirror and cause it to exit (see Appendix B).

b.

Create a new empty project folder on the network file server to retain the
modified mirrored project database. Use Windows File Explorer (or
similar software) to create the new empty destination project folder on the
network server.

3. With Met Manager, make any needed data source parameter (sensor) and database

parameter additions or deletions:

a Restart Met Manager.

b.

C.

Close Met Manager’ s connection to the data source, if it is currently
active. Choose the “Close Connection” item under the “ Setup” menu.
Make the data source parameter additions or deletions by following the
instructions below these guidelines (remainder of Section 3.6 and below
step 5).

Make any needed database parameter additions or deletions as discussed
in Section 3.7. Met Manager will automatically restructure its database
when you are finished (as signified by pressing the OK button on the
Database Parameters Editor dialog). Thusit’s best to make all database
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parameter additions and deletions at one time before pressing the OK
button.

e. Reconnect Met Manager to the data source. From the Setup menu, choose
“Connect to ...” and connect to the appropriate data source. Met Manager
should then begin acquiring data from the data source, and storing that
data into the modified project database.

4. |f you are using the optional Met Mirror software, then:

a. Point Met Mirror through Met Mirror’ s definition settings to the new
project folder pathname. Simply change the name of the destination
folder to the new path. Save Met Mirror’s new definition settings. See
Appendix B.

b. Restart Met Mirror. Asappropriate, first modify any Met Mirror startup
command line options (if used).

c. Copy al Met Viewer user settings files from the original mirrored project
location to the new location. The file names end with the extension
“.mvs’. DO NOT COPY ANY ADDITIONAL FILES. Use Microsoft
Windows Explorer or equivalent software to make the copy. This step
ensuresthat al Met Viewer users can now access the new project database
with their current view settings.

5. If you have Met Viewer users, then:

a. Haveeach Met Viewer user open the project at the new pathname
location.

b. Haveeach Met Viewer user adjust indicator views, wind roses, and trend
chartsto reflect the changes (additions and deletions) to the database.

c. Asappropriate, modify any Met Viewer startup command line options (if
used).

Data types (pressure, precipitation, temperature and so forth) are assigned to the various
sensor channels of the active data source. To assign sensory data types to the data source,
select “Data Source Parameters’ from the Setup menu:
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(The above figure is an example only; See Appendix A
for alist of all supported Data Source Parameters.)

Note: If the parametersin the top of the above figure are not displayed, then select “Close
Connection” from the Setup menu to show them. ‘

As shown in the figure above, the example data source was configured with 9 sensor-
based channels (see the Data Source Parameter List in the figure). Each channel was
setup by selecting and dragging a data type from the top box to a channel number in the
left-hand box. The data type must match the sensor that is associated with that channel.
Then, each channel’ s assigned data type is converted to a data source parameter by
selecting the channel name in the left-hand box and editing its properties in the right-hand
box.

For example (and as shown above), a“ Temperature” datatype was initially assigned to
channel 3 by selecting the “Temperature” data type from the top box and dragging and
dropping it onto channel 3. Then that channel was converted from a data type to a data
source parameter by setting its properties in the right-hand box: (1) renaming it to
“Ambient Temperature” in the “Description” property, (2) setting its base unitsto °C, (3)
setting its height (level) above the ground to 2 meters, (4) setting its slope and of fset
values to convert the value received from the data source to base units, and (4) setting its
range of valid values (in base units).

Similarly, the “Precipitation” datatype was initially assigned to channel 5 and then
converted to a data source parameter by renaming it to “Rain” in the “ Description” field
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and setting its other properties. Also, “Pressure” was renamed “ Barometric Pressure”,
“Humidity” as“Relative Humidity”, and “Voltage” as “Battery Voltage’.

The“EMPTY” datatype allows you to remove a channel assignment, or to define adata
value to ignore within the received data stream. Just drag and drop the “EMPTY”
parameter to a channel number. Or, select the channel number that you wish to delete,
and press the “delete” key on your keyboard.

In the right-hand box, the “Base units’ represents the units that Met Manager assigns to
the parameter after applying the base unit conversion slope and offset values. These slope
and offset values are typically used for converting araw value (data source parameter) in
voltage or counts to avalue in the base units, or for converting a value received in one
engineering unit to another. If the received value is already in the desired base units, then
the slope should be 1 and the offset 0 (asin the above figure). Calibration slope and
offset corrections are assigned el sewhere; see Section 5.2.

The “Height (meters)” field is the measurement height of the sensor above the ground (or
below ground for soil moisture sensors), in meters. Met Manager uses this parameter as a
label, for example to identify wind speed at two different heights on atower or soil
temperatures at different depths. 1f you are not concerned about using height as alabel,
then you may leave thisfield blank.

Note: The above height parameter is used only as alabel and is not used in calculations.
However, the calculation of some derived parameters may depend on the height of the
sensor. In that case, the derived parameter will have a separate height-related parameter
for you to set up (see Section 3.7).

The “User override status” field alows the user to override the channel’s “normal” status
with “calibrate” or “invalid” status. Thisis useful in keeping questionable data out of the
database by flagging the channel with “calibrate” or “invalid” status when the systemis
first started up. Onceinitia data has been acquired and verified, then the “User override
status’ can be set to "none"’. The normal statusis“none” (i.e., no override of the status).

The “Decimal display digits’ field isthe number of decimal placesto display to the right
of the decimal point when showing the parameter on the left-hand side of the
Instantaneous View (see Section 4.6).

The “Minimum” and “Maximum” fields are used for range checking of the parameter.
When new datais received from the data source, the data parameter’ s value is range-
checked in base units, and after applying calibration adjustments. When Met Manager
detects that a parameter’ s value is out-of-range, then Met Manager |ogs the date/time,
parameter, and fault value in afault log and sets the status of the parameter to “invalid”.
Refer to Section 4.5. The parameter status returnsto “valid” when back in range.

To summarize, the above figure shows that 9 channels of data are received in the data
stream from the example data source. Each channel began as a data type (for example,
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temperature or precipitation) and was then assigned some property values to convert it to
adata source parameter. Properties include a descriptive name (for example, ambient
temperature or rainfall) and height. By supplying additional information, you can assign
base units, linear conversion slope and offset values for converting the received raw value
into the base units, and so forth.

Wind speed has some additional information related to calm winds:

(The above figure is an example only; your configuration may be different.)

The *calm wind threshold” is that value below which the wind should be considered
cam. The unit of the “calm wind threshold” is specified in the “Base units’ field. The
value you should assign for the threshold usually depends on the manufacturer’s
specifications of the wind speed and wind direction sensors, and is the highest of the two.
For example, if the manufacturer-assigned calm threshold for the wind speed sensor is
0.5 mph and for the wind direction sensor is 1.0 mph, then the “calm wind threshold”
should be set to 1.0 mph.

Met Manager will set wind speed readings less than the calm threshold to one of:

e Useasis- Thewind speed value will not be adjusted when it is below the calm
wind threshold. However, the wind direction value will be set to O to indicate
cam winds.

e Zero (0.0) - The wind speed value will be set to 0.0 when below the calm wind
threshold. The wind direction value will be set to O to indicate calm.

e Y Threshold - the wind speed value will be set to %2 the calm wind threshold
value when below the calm wind threshold. The wind direction value will be
set to O to indicate calm.

For example, in the above figure, wind speed values below 1.0 mph will be set to 0.0
mph. Wind speed and wind direction will be considered calm.
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Note: Some weather systems may consider both 0 and 360 degrees as awind direction
from the north. To avoid ambiguity, Met Manager reports a non-calmwind direction in
the range of 1 to 360 degrees, and sets a calmwind direction to 0 degrees. Essentially,
during calm winds there is no wind direction.

Note: It is possible that the wind speed sensor’ s output is reading below the calm wind

threshold because the sensor has malfunctioned. In this case, you probably do not want
your wind direction values to be set to calm. By simply flagging the wind speed sensor
as“invalid”, the calm setting will be ignored for the wind direction sensor. Flagging a

channel to “invalid” is amaintenance function that is described in Section 5.1.

Note: If you do not wish Met Manager to set the wind direction to calm based on the
wind speed, then set the “ Calm wind threshold” value to 0.0. Calm wind will not be
detected, and a measured calm wind speed of 0.0 will indicate calm.

3.7 Assigning Parameters to Store in the Database

The purpose of assigning parameters to store in the database is to be able to later view,
trend, report, and export the data represented by the parameters. These parameters
include both acquired and derived parameters, and are referred to as “ database
parameters.”

CAUTION: Please review the caution in Section 3.6 when adding or deleting database
parameters. Unless you are setting up a brand new project from scratch, then very
carefully follow the guideline of Section 3.6 titled “ Guideline for Adding or Deleting

Data Source or Database Parameters' .
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To assign parameters to the database, select “ Database Parameters’ from the Setup menu:

Note: If the top part of the above display is not shown, then select “ Close Connection”
from the Setup menu to show it. Thetop part of the display is not shown when Met
Manager is acquired data.

The “Acquired Parameters’ above are those that you setup earlier as “data source
parameters’. One at atime, drag and drop the ones you want to store in Met Manager’s
database to the “ Database Parameter List” (left-hand box). Usually you will want to store
all of them, so drag and drop each one, one at atime.

Next select the Derived - Standard, Wind, Agriculture, Energy or Other tab from the top
window, and drag and drop parameters of interest. Refer to Appendix A for alist and
brief explanation of each derived parameter.

The “Derived - Standard” tab is shown below:

Configuring Met Manager Page 3-24 Rev: 1.5



Met Manager ™ User’s Manual

Copyright © 2002

The “Wind” tab is shown below:

The“Agriculture” tabis:

The“Energy” tabis:

The “Other” tab is shown below:
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Note: Your version of Met Manager may include additional parameters not listed above. |
Refer to Appendix A for alist of the latest parameter data types and derived parameters

reported by Met Manager.

The figure below shows an example of parameters that have been assigned (dragged and
dropped) to the Database Parameter List for storage into the Met Manager project
database.

(The above figure is an example only; your configuration may be different.)

In the above example, peak wind speed was setup as the maximum wind speed, high
temperature as the maximum temperature, low temperature as the minimum temperature,
and low relative humidity as the minimum relative humidity. The “maximum” and
“minimum” derived parameters originated from the “ Other” tab.

Similar to the Data Source Parameters display of Section 3.6, the “decimal display digits”
field represents the number of digitsto the right of the decimal point for the parameter
listed on the right-hand side of the Instantaneous View (see Section 4.6).
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IMPORTANT: You must assign a name to the “column heading” field. Thisassigned
name becomes the name of the parameter for display, trending, and reporting purposes.
Make it short but descriptive, in order to minimize the width of the column. For
example, awind speed parameter might be named “WSPD” or “WS”, scalar wind
direction as“WDIR” or “WD”, resultant vector wind direction as “vWDIR” or “VWD",
unit vector wind direction as“uvWDIR”, “uvWD”, or “UVWD”, ambient temperature as
“TEMP’ or “TE”, maximum (or high) ambient temperature as “maxTEMP’, “maxTE” or
“MAX TE”, soil temperature as“Soil TEMP” or “SOIL TE”, relative humidity as
“RHUM” or “RH” and so forth.

If you fail to assign a name to the column heading, then you will see column headings
without a name, and various parameter selections as“ New Parameter.” If this happens
to you, go back and assign a column heading to fix the problem.

Note: In a network setting, the users of the optional Met Viewer™ software will see the
same column heading field names that you assign in Met Manager. Also these
assignments will be printed within some of the reports. Make sure that the column
heading names are short but descriptive and unambiguous to all personnel that will use
the data.

Since aderived parameter depends on one or more primary parameters, it is helpful (but
not required) to assign the needed primary parameters to the database parameter list
before they are needed by a derived parameter. For example, the “ dewpoint” derived
parameter depends on ambient temperature and relative humidity. Therefore, it is best to
assign the ambient temperature and relative humidity parameters to the database
parameter list before assigning the dewpoint parameter. In all cases, avoid circular
references.

The order of assignment of the various acquired and derived parameters to the database
parameter list defines the final order of the parameters within the database and the initial
order of the column headings within the Data View (the Data View is discussed in
Section 4.4.) Although not required, consider assigning the most important parameters
first (in your judgement), and group like parameters together. In the above example, the
wind speed and wind direction parameters were assigned first. Also, the ambient
temperature, high temperature and low temperature were grouped together so that their
natural display order would be next to each other.
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Note: All database parameters require one or more parameter reference assignments. For
example, the “Wind Speed” database parameter shown above requires awind speed data
source parameter type. To change the assignment of this parameter reference, press the
F6 key, or click on “Edit”. If more than parameter reference of the sametypeislisted,
then typically choose the one beginning with the channel number (for example “[1] Wind
Speed”). That oneisthe *data source” parameter and represents the channel’ s “ acquired”
value after applying slope and offset values. However, in some cases it may be
appropriate to select a derived parameter as the input argument, if the database parameter
depends on it.

Note: In some cases when configuring a derived database parameter, the display units are
not known until the parameter’ s argument has been assigned. For example, if you want
to derive a“maximum” type database parameter, drag and drop the “maximum”
parameter from the “Other” tab to the database list, rename it, then choose its argument
(which can be any parameter), and finally select the display unit of choice.

Note: Notice the circle with an “x” on the “ Sigma-Theta, Std Dev Wind Direction (2m)”
parameter above. Thisindicatesthat an improper parameter reference assignment, or no
assignment, had been made to that database parameter. Edit the “ Parameter References’
list to fix the problem. In this particular example, no parameter reference had yet been
assigned. Assignment of the “[2] Wind Direction” reference parameter fixed the
problem.

Note: Met Manager assigns to each database parameter a“ Database tag” as shown in the
figure above. Thistag isthe name of the field within each date/time stamped record of
each table of the database that contains the value of the parameter.

To delete a parameter from the Database Parameter List, select it with your mouse and
then press the “delete” key on your keyboard. Met Manager displays the following
message to make sure that you intended to delete the parameter:
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To confirm deletion, type Y ES in the requested field and then press the “Delete” button.

3.8 Defining the Data Tables of the Database

Now that you have decided which measured and derived parametersto savein a
database, it’s time to decide which data tables to include in the database. Each data table
represents a different frequency of data. From the Setup menu, select “Data Tables’. A
figure similar to the following is then shown:

(The above figure is an example only; your configuration may be different.)

Select the various data tables to be included in Met Manager’ s project folder. For each
table chosen, also select an option:
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o Keep dataindefinitely. Inthismode, the datais retained in the selected data
table indefinitely.

e Delete dataolder than. In this mode, only the last specified number of days
are retained in the selected datatable. For example, if “30” daysis specified
for the 1 minute table, then at midnight, data older than 30 days will be
deleted from the 1 minute datatable. Thisisreferred to as“wrapping” the
datatable.

Note: Normally, if the datais used for EPA or other regulatory purposes, it is best to
retain the 15-minute and hourly data indefinitely. However, we recommend that you
[imit the 1-minute data table to 30 days (or less). Depending on the number of
parameters being stored in the data table, atypical datarecord may be 200 to 300 bytesin
size. For al-minute datatable at 1,440 records per day, this represents a growth of the
1-minute data table at about 281K to 422K per day. A typical 30-day 1-minute datatable
would thus be 8.5 MB to 12.5 MB in size. Similarly, a5-minute data table should be
limited to 185 days (about 6 months), and a 10-minute data table should be limited to 365

days (ayear).

IMPORTANT: When datais “deleted” in the database, it is marked as deleted and can
no longer be viewed. However it is not entirely removed. To remove the data entirely,
you must “pack” the database. Thisis done from the Setup menu, and Pack Database
selection, and is explained in Section 5.4. If some of the tables are “wrapped”, then you
should pack the database on aregular schedule as explained in Section 5.4.

Note: Usually for anew project, the data tables are not created by Met Manager until the
moment the dataisfirst acquired from the data source. This gives you the opportunity to
get the data source parameters and database parameters configured properly, and without
restructuring of the database (since it doesn’t yet exist.) Also, you can later check or
uncheck tables to begin or stop adding data to them.

Technical Note: The project database isin Paradox 4 format, level 7. Met Manager
connects to these files through the Borland Database Engine (BDE) which is
automatically installed on your computer during installation of the software. The
database is indexed.
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CAUTION: Do not connect directly to the database with another database manager or
with a spreadsheet program such as Quattro Pro. Unpredictable results may occur
including complete loss of the data. If you wish to experiment, do so with a mirrored
copy that no other software isusing. If aproblem occurs, you may have to delete the
mirrored copy, and restart the mirror software to recreate it, but at least you won’t have
damaged your master database. See Appendix B for operation of Met Mirror software
that allows mirroring of the project database.

CAUTION: Do not create a copy of the database with a copy program (such as
Microsoft Windows Explorer) while datais being logged to the database. During the
copy process, new data may be added to the database by Met Manager (or Met Mirror).
The copy process can interfere with adding this data by causing index tables to get out of
synchronization. The correct procedure isto stop Met Manager (and Met Mirror if
running), and then perform the copy. Alternatively, although quite abit slower, let Met
Mirror perform the copy.

3.9 Connecting to the Data Source (Beqgin Acquiring Data)

If you have followed the above steps, then your system is nearly configured. Now you
can connect to a data source and begin collecting data. From the Setup menu, you have
two options to connect to a data source:

1. Select “Connect to”. A figure similar to the following is then displayed (but
usually with only one data source item in the list):
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Note: The above figure shows an example of various data sources that can be
created from the Setup menu, “Data Sources’ submenu. However, not al of the
above data sources are available to all datalogger configurations (and the actual
data sources may have different names than shown above). If your list is blank,
then you need to first create the data source from the “ Data Sources’ submenu.
And we recommend that you create only one data source per project.

2. Or, if you had previous set a data source as “default” (with alittle check mark
above it; see Section 3.5), then simply select “Connect to data source name’
where “data source name” is the name of the default data source.

If you wish afull-time direct connection to the data source (for example, to your local
weather station’s data logger) then select the “ Direct Connect” data source (or similar
name). All of the following conditions must be met:

Y ou have a direct connection to the data logger (by serial cable, direct-
connect modems, or wireless radio modems).

Y our datalogger is programmed to transmit out a data stream at aregular and
repetitive interval and in away that Met Manager understands. Thisinterval
isusually every second or every five seconds depending on your data logger

capability.

Y ou have tested the link between the datalogger and the computer that Met
Manager resides on, and have confirmed independently of Met Manager (i.e.,
with Met Manager shut down) that data is being repetitively transmitted from
the datalogger to the computer. Y ou may have to use vendor-supplied
software to perform the test, or the Windows Hyperlink program.

Y ou have properly created and configured a “ direct-connect” data source
(from the “Data Sources’ submenu) with a communications port, baud rate,
and sampl e rate that matches the configuration of the datalogger.

Y ou can choose a*“Data Log Capture (COM Port)” data sourceif all of the following
conditions are met:

Y ou have a direct connection to the data logger (by serial cable, direct-
connect modems, or wireless radio modems).

Y our datalogger has been programmed to store datain itsinternal log for a
period of time (for example, every minute, 5 minutes, or 15 minutes), and Met
Manager is aware of how to retrieve data from the log of your particular data
logger.
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e Youwant Met Manager to periodically capture (i.e., retrieve) the log on your
request (i.e., not automatic).

e You have tested the link between the datalogger and the computer that Met
Manager resides on, and have confirmed that data can be transmitted from the
internal memory log of the datalogger to the computer. Y ou may have to use
vendor-supplied software to perform the test, or the Windows Hyperlink
program.

e You have properly created and configured a“Data Log Capture (COM Port)”
data source (from the “ Data Sources’ submenu) with a communications port,
baud rate, and sample rate that matches the configuration of the data logger.
In this case the sample rate is the rate at which the datalogger logs a data
record into its internal memory (for example, once each minute, 5 minutes, or
15 minutes).

Y ou can choose a“Data Log Capture (Modem)” data sourceif all of the following
conditions are met:

e Your datalogger islocated remotely from Met Manager and you do not have
adirect connection to the data logger, but do have telephone modem or
cellular modem access to the data logger.

e Your datalogger has been programmed to store datain itsinternal log for a
period of time, and Met Manager is aware of how to capture (i.e., retrieve)
data from the log of your particular data logger.

e Youwant Met Manager to periodically retrieve the log on your request.

e You haveinstalled the appropriate dial-out modem on the computer that Met
Manager resides on. You have aso installed the appropriate modem hardware
at the data logger.

e You have tested the dial-out link and have confirmed that alog file can be
received by the computer that hosts Met Manager. Y ou may have to use
vendor-supplied software to perform the test, or the Windows Hyperlink
program.

e You have properly created and configured a“Data Log Capture (Modem)”
data source (from the “ Data Sources’ submenu) with a modem device, phone
number, and samplerate. In this case, the sample rate is the rate at which the
datalogger logs a data record into its internal memory (for example, once
each 1 minute, 5 minutes, or 15 minutes).
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Y ou can choose aCSV or DataLog “File Import” data source if all of the following
conditions are met:

e You do not have adirect or dial connection to the datalogger, but you do have
the datain a compatible file format.

e You have properly created and configured a CSV or datalog “File Import”
type of data source (from the “Data Sources’ submenu). Y ou have set the
sample rate property of the File Import data source to match the time interval
of the datafile.

CAUTION: Do not mix and match data sourcesin aproject. A project
should be configured with one and only one data source. Otherwise you run
the potential of contaminating your project database because there is not
necessarily a unique mapping between each data source’' s parameters and the
database’ s parameters. (It may be possible to setup a common mapping
between the data sources, but you will have to experiment. Experiment with a
project database that is not important to you.)

Select the appropriate data source, and press the “ Connect” button to activate the
connection.

Note: You may get an error message if the “ Connect” button is pressed and you do not
have avalid connection.
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4 USING MET MANAGER

4.1 Connecting to a Project

The first step to acquiring data from a weather station is to assign a place to store the data
and project settings. Thisplaceiscalled a“project” and is simply afolder (directory) on
a desktop or notebook computer, workstation, or network server.

A new project is created from the File menu with selection of “New Project”:

Y ou have two options: (1) create a new project from scratch, or (2) create a new project
from an existing project. Follow the stepsin Section 3.3.

If aproject already exists, then the project can be opened from the File menu with
selection of “Open Project.” Thisresultsin adialog box (not shown) that allows you to
browse and find an existing project folder.

Note: Met Manager checks to ensure that the project you selected is actually areal Met
Manager project. If it doesn’t find certain files within the project folder, the following
error message is given:
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4.2 Confiquring the Project

After aproject has been created, the project must be configured. The steps are:

1.

10.

11.

Configure site settings such as latitude, longitude, elevation, and time zone.
See Section 3.4.

Configure the data source. This defines where the sensory data comes from; for
example, continuous direct-connection with the datalogger in real time or by
dial-up connection to the internal memory log of a datalogger. See Section 3.5.

Assign parameters to the data source. This defines the various sensor channels
and ordering of datareceived from the datalogger, and the units, measurement
height, decimal display digits, and coefficients (slope and offset) for converting
to base units. See Section 3.6.

Assign parameters to be stored in the database. This defines both acquired
sensor parameters and derived parameters to be stored in a database for later
viewing, trending, reporting and exporting. See Section 3.7.

Define data tables and related time interval s to hold the database parameters.
Tablesinclude 1, 5, 10, 15, 20, 30-minute, and hourly time intervals. See
Section 3.8.

Connect to the data source. With this step, Met Manager can begin receiving
data from the weather station. See Section 3.9.

After following the instructions in Section 3.9, verify that Met Manager is
receiving data from the data source. View the data from the Instantaneous View
(see Section 4.6) and the Data View (see Section 4.4). If you have intermittent
communication problems, review the “ Current Data Source Events’ tab of the
Event Log. See Section 4.5.

Calibrate the weather station sensors and subsystems. See Section 5.2 and
Appendix E.

Review the “ Current Faults’ tab of the Event Log to ensure that all measured
values are within the minimum-to-maximum range defined for each data source
parameter. See Sections 4.5 and 3.6.

Configure new trend charts and review existing ones (if any). See Sections 4.8,
4.9 and 4.10.

Configure new indicator pages (views) and review existing ones (if any). See
Sections 4.11 and 4.12.
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12. Configure anew wind rose or review an existing one (if any). See Sections

4.13 and 4.14.

13. Configure the Data View and report options. See Section 4.15.

14. Configure display options when Met Manager is started. See Section 4.16.

15. Configure Met Manager to automatically startup when Windows starts up.

Place a shortcut of the Met Manager executable program (MetMgr.exe) in the
Windows “ Startup” folder. Thisfolder may be located under “ Administrators’,
“All Users’, “Default Users®, or may be applicable only to your particular log-
on profile depending on your version of Microsoft Windows. Check with your
network or system administrator for the proper startup folder to contain the Met
Manager shortcut.

Command line options are not required but are useful for forcing Met Manager
to open a particular project and data source when starting up in Windows. If
you use a command line option, you will want to assign it to the Met Manager
shortcut in the Windows “ Startup” folder. See Appendix D.

4.3 View Menu
The following figure shows the View menu:

The View menu alows you to:

View the data tables (referred to as the Data View). See Section 4.4.

View event logs (Event Log View). See Section 4.5.

View instantaneous data (I nstantaneous View). See Section 4.6

Create and view trend charts (Trend Chart View). See Sections 4.8, 4.9 and
4.10.

Create and view indicator pages (Indicator View). See Sections4.11 and 4.12.
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e Create and view awind rose (Wind Rose View). See Sections4.13 and 4.14.

e Set view and report options. See Section 4.15.

e Set display options when starting Met Manager (startup options). See Section
4.16.

4.4 Viewing Data Tables
To view the datatables, select “Data Tables” from the View menu. Below is an example
of the datatable view (or simply Data View).

(The above figure is an example only; your configuration may be different.)

Each data table that you enabled when setting up the software (in Section 3.8) shows up
on a separate tab on the Data View. Select the tab with your mouse to view the data.

To review the past data history, press the Page Up key, or drag the thumb bar located on
the right of the display up or down with your mouse. Y ou can aso pan the view to see
channels of datathat may be located to the right of the display view. Drag the bottom
horizontal thumb bar to the left or right to pan the view.
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The “Auto Update” button (located in the upper left corner) is used to keep the display
from being refreshed when new data arrives. Press this button to “freeze” the view.
Pressit again to unfreezeit. The operation of the button is:

e When highlighted (depressed), the display will update (refresh) with the
arrival of new data. Thisisthe normal setting.

e When not highlighted (not depressed), the display will not be affected by the
arrival of new data.

When the Data View has been positioned so that the most current record is not
highlighted, then atimer is started to keep new incoming data from refreshing the view.
Within 15 minutes of no keyboard or mouse activity (that changes the highlighted
record), the timer times out, and the view is refreshed (if the Auto Update button was
highlighted prior to changing the Data View).

To goto thefirst or last record in the data table, or to force an auto-update, right-click
with your mouse somewhere on the Data View. The following options are then

displayed:

Note: Met Manager presents its data stamped with local standard time. During daylight
savings time, the time stamp may be less than your local computer time by one hour.

45 Viewing Event Logs

Met Manager tracks communication faults, sensor faults, and system events. To view the
event logs, select “Event Logs’ from the View menu. Below is an example of the Event
Log View:
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When there are eventsin the “ Current Data Source Events’ or “Current Faults’ logs,
select the event and then press the “ Acknowledge Event” button to tell Met Manager that
you are aware of the event. Met Manager will retain the event in the respective “ All Data
Source Events’ or “All Faults’ log, but will remove the event from the “Current ...” log.
Or you can press the “ Acknowledge All Events’ button to acknowledge all events within
a“Current ...” event log.

System events are always retained in the “ System Events” log.

Refer to the following table for alist of various event codes:

Event
Type of Event Log Code | Description of Event
Data Source Events | 1001 | Communications timeout
1002 | [count] Incorrect packet format.
“Count” is the number of occurrences. If count =1
then reported at date and time of occurrence. If
count > 1 then reported at the end of the hour of
occurrence.
Faults 2001 | Vaue of parameter back within min/max limits
2002 | Reserved
2003 | Reserved
2004 | Min limit fault value (V) limit (L) unit
Where “V” = value that triggered fault, “L” = imposed
minimum limit, “unit” = reported unit
2005 | Max limit fault value (V) limit (L) unit
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Where “V” = value that triggered fault, “L” = imposed

maximum limit, “unit” = reported unit

System Events 3001 | Project opened
3002 | Project closed
3003 | Logging started
3004 | Logging stopped
3005 | Parameter set to VALID (or invalid or calibration

status)

3006 | Datasource parameter setup changed

3007 | Database parameter setup changed

3008 | Datatable setup changed

3009 | Pack SUCCESSFUL for table TBL 1, TBL 2, etc.
(or unsuccessful statusis reported)

3010 | Datatable restructure status (one of):

e Restructuring table TBL 1, TBL 2, etc.

¢ Nofieldsto remove

e Adding fieldsDB1, DB2, etc.

e Restructure successful for table TBL 1, etc.

4.6 Viewing Instantaneous Data

The Instantaneous View is useful when Met Manager is directly-connected to a weather
station and gets data from the data logger of the weather station on afrequent basis.
Below is an example of the Instantaneous View:
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(The above figure is an example only; your configuration may be different.)

In the above figure, the channels on the left side of the display represent the acquired
“data source’ parameters that were received from the data source (e.g., datalogger), and
after both base unit conversion and calibration adjustments have been applied. See
Section 3.6. These values are in base units.

The channels on the right side of the display represent the “database” parameters that
were configured in the Database Parameter List, and that are to be stored in the data
tables. See Section 3.7. These values also include calibration adjustments.

Once you have connected to a data source (e.g., a datalogger), Met Manager can begin
receiving data. If the data sourceis of the kind “direct-connect”, and your datalogger is
working and properly connected to the same computer that is running Met Manager, then
Met Manager should begin receiving the data. In that case, the Instantaneous View will
update at the sample rate specified in the properties of the data source, and the “Missing”
status will changeto “Valid”, “Invalid”, or “Calibrate” depending on the prior
configuration of the channel. See Sections 3.6 and 5.1.
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Note: If necessary, consult other information supplied with the weather station or data
logger to independently confirm that the weather station is properly connected to the
computer. With Met Manager not running (that is, shut down), use instructions separate
from this User’s Manual to confirm that datais flowing between the datalogger and the
computer. For example, with some dataloggers, and in conjunction with manufacturer-
supplied instructions, you can use Microsoft’s “Hyperlink” program to connect to the
datalogger and view the data on your computer. Or there may be a special diagnostic or
test program supplied with your weather station hardware. In summary, you cannot
expect Met Manager to receive the data from the data logger if the data is not arriving at
your computer, or if thereisa cabling or communication problem of some kind.

4.7 Maintenance and Calibration

4.7.1 Setting the Status of a Channel

To activate specia maintenance functions such as setting a data source parameter to
invalid or calibration status, see Section 5.1.

Note: If adata source parameter is set to invalid or calibration status, then derived
| database parameters that depend on that parameter will also be set to invalid or
\ calibration status.

4.7.2 Calibrating a Channel

To set the calibration coefficients (slope and offset) of a data source parameter (channel),
See Section 5.2.

4.7.3 Activating a Debug Log

For troubleshooting, you may want to capture and inspect the raw data coming from your
datalogger. You can setup atext file to hold the raw dataif your datalogger has a
continuous connection to the computer. See Section 5.3 for activating a debug log file.

4.7.4 Packing the Database

The database managed by Met Manager must be periodically packed to permanently
remove records that have been deleted. This affects those data tables that have been
setup with a“wrap” interval. See Section 5.4 for arecommended pack schedule and
more information.

4.7.5 Restructuring the Database

The database managed by Met Manager must be restructured when additions or deletions
are made to the database parameters. Met Manager normally handles this restructure on
its own when additions or deletions are made. However, see Section 5.5 on guidelines to
follow if the normal restructure operation did not compl ete for some reason.
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4.8 Creating Trend Charts

4.8.1 Creating a New Trend Chart

Y ou can easily setup single or dual-axis and single or dual trend charts to review your
weather data. Each trend chart can have multiple traces.

To create anew trend chart, select “ Trend Charts’, then “New Trend” from the View
menu:

A new blank trend chart is shown below.

Let’s setup atrend chart titled “Wind Direction” based on 15-minute scalar wind
direction.
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IMPORTANT: You must have a*“scalar wind direction” database parameter already
configured in order to create a“wind direction” trend chart by using the information in
this section. If you don't have a*“ scalar wind direction” database parameter but have
setup aresultant vector or unit vector wind direction parameter, then use that instead in
order to follow along with the example. It'salso best if some wind direction data has
already been acquired.

Press the “Edit Trend Settings’ tool button located on the tool bar. The *Edit Trend
Settings” dialog is then shown:

Givethe trend chart anamein the “Name” field and atitlein the “Title’ field. The name
you provide is the name that appears in the Trend Chart list of the View menu, aswell as
Met Manager’s “Window” menu. Overtype the default name “New Trend” with “Wind
Direction”. The“Title” isthe information that you want to appear at the top of the trend
chart. Setit alsoto“Wind Direction” if that’s the title you want on the chart. Then
check the appropriate boxes to filter certain types of data from the trend chart:

e Check “Show valid data” to display valid data on the chart. Thisbox is
checked for normal operation.

e Check “Show partial data’ to display partial data on the chart. Partial data
occurs when some valid samples were acquired over the time interval, but less
than three-quarters of the expected data. For example, if the data sample rate
is 5 seconds and the data reporting interval is 15 minutes, then valid data will
be flagged as “partial” if fewer than 135 samples are acquired over the
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interval (afull 15-minute interval would have 180 five-second samples). This
box is checked for normal operation.

Similarly, check the remaining boxes to display other types of data. Checking
these boxes is useful when diagnosing problems. These boxes are normally
unchecked.

The following dialog shows the new settings:

Note: Met Manager tags a channel’s data, and any parameters derived from that channel,
according to the channel’ s accumulated valid, invalid, calibration, missing, or partial
status, based on the following rules:

If more than three-fourths of the acquired samples are valid, then the channel
istagged as “valid”. Samplesthat are detected by Met Manager as being
invalid (i.e., out-of-range), in maintenance mode, undergoing calibration, or
are missing are not included in the valid set.

If at least one valid sample is acquired during the reporting interval, but fewer
than three-fourths, then the channel’ s result istagged as “ partia (p)”

If the samples acquired during the reporting interval are invalid then the
channel’ s result for the reporting interval istagged as “invalid (x)”. Samples
can be invalid because of out-of-range detection, or because the user put the
channel into “invalid” maintenance mode.

If the samples acquired during the reporting interval arein calibration mode,
then the channel’ s result for the reporting interval istagged as “calibration
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(c).”

e |f all samples acquired during the reporting interval are missing, then the
channel’ s result for the reporting interval istagged as “missing (m)”

4.8.2 Example of a 0-360 Scalar Wind Direction Trend Chart

Now let’s set up the left vertical axis (Y axis) to show the wind direction parameter’s
values. Select the “Axis Settings’ tab near the top of the dialog. Check the “Show Y
axis’ box, then set the “Title” of the axisto “Degree”. For the axistype, select “Normal”
to set up anormal singletrend chart. Inthe“Datatype” list box, select the type of the
parameter, in this case a“wind direction” type. For “Units’, select “deg”. We want the
vertical axis scaleto be fixed in the range of 0 to 360 degrees, so uncheck the “Use
automatic scaling” box. Set the minimum wind direction value to 0 and the maximum to
360. Specify “Major steps’ of 8 to give 8 major graduations of 45 degrees each across
the 360 degree range. Specify “Minor steps’ of 3 to divide each mgor graduation into 3
subintervals of 15 degrees each.

Several traces can be added to atrend chart. Let’s begin by adding a“scalar wind
direction” trace to the wind direction trend chart. Select the “Data Traces’ tab near the
top of the dialog:
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Pressthe “Add” button to add anew trace to the trend chart. Name the trace title “ Scalar
Wind Direction”. Assignit to the left axis. Pick atrace type of “line€” and select atrace
color of red. Finally, select the actual parameter to be assigned to the trace. Within the
project there are multiple parameters of the “wind direction” type. We areinterested in
trending the scalar wind direction, so that’s the one to select:

(The above figure is an example only; your configuration may be different.)

Now it'stime to select the datainterval. From the “Data Traces’ tab, click on the “Data
interval” list box to see alist of the data tables that were previously setup in Met
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Manager. Inthe example below, Met Manager was configured to maintain 1 minute, 15
minute, and hourly data tables (in Section 3.8) in the project database. For our example,
we want to trend 15-minute data, so we will assign the 15-minute data interval:

Note: In the “Data Traces’ tab, you can uncheck the box to the Ieft of the tracetitle. This
| will disable thetrace. (It's checked by default when anew trace is added.) Thisisuseful |
| when you have several traces assigned to atrend chart, but you want to disable one for

| some reason. Y ou can always check it later to re-enableit.

Click the OK button to accept the settings. Our example wind direction trend chart is
displayed, based on a 0 to 360 degree range:

Using Met Manager Page 4-15 Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

(The above figure is an example only; your configuration may be different.)

| Note: Data cannot be trended until it has been acquired.

4.8.3 Example of a 0-540 Scalar Wind Direction Trend Chart

The above example shows the wind direction trace jumping back and forth between 0 and
360 degrees. This happens on 0-360 wind systems when the wind direction is from the
north. To avoid this, let’s change the scale to a 0 to 540 degree range and select a special
trace function to map the 0 to 360 degree wind direction to a 0 to 540 degree range.

First, select the “ Scalar Wind Direction” trace on the “Data Traces’ tab, and press the
“Edit” button. Thisbrings up the “Edit Trace Settings’ dialog:
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Press the “Edit Trace Function” button, and pick the “Wind direction in 0-540 deg range”
trace function from the list box:

Next, change the axis range on the “ Axis Settings’ tab to match the special trace function
of 0to 540 degrees. Also specify “Major steps’ of 12 and “Minor steps’ of 3 to give 12
major graduations of 45 degrees each across the range and 3 subintervals of 15 degrees
each for each major graduation:
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Pressthe “OK” button to show the wind direction now mapped to a 0 to 540 degree
range:

(The above figure is an example only; your configuration may be different.)
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Note: By convention, acalm wind direction is set to 0 degrees and a north wind direction i
is set to 360 degrees. During calm winds, the wind direction trace will go to zero (unless |

you have calm wind detection disabled).

4.8.4 Adding Standard Deviation of Wind Direction to the Trend Chart

IMPORTANT: You must have a* Sigma-Theta standard deviation” database parameter
already configured in order to create a“ Sigma-Theta’ trace by using the information in
this section. It'salso best if some standard deviation data has already been acquired.

Now let’s add a second trace to the trend chart. Since the Y-axisis of the “degree” type
(i.e., wind direction), then additional traces assigned to that axis must also be of the same
type. Let’'sadd the standard deviation of wind direction, commonly known as “ Sigma-
Theta’. From the “Data Traces’ tab, pressthe “Add” button, name the trace “ Sigma
Theta” and assign it to the “Left Y axis’. Specify the“Trace Type” asaline. Set the
trace color to black:

The resulting trend chart shows the standard deviation of the wind direction asa“sigma
theta’ trace along the bottom of the chart:
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(The above figure is an example only; your configuration may be different.)

Let’s center the Sigma Theta trace about the wind direction trace. Select the “Sigma
Theta” trace on the “Data Traces’ tab. Then pressthe “Edit” button to change its
propertiesto a“Trace Type” of “Error Bar”, “ Parameter (Value/Avg/Mean)” to “ Scalar
Wind Direction”, and “ Parameter (Std Dev/Error)” to the “ Sigma Theta, standard
deviation” database parameter. Be sure to press the “ Edit Trace Function” button and set
the trace function to “Wind direction in O - 540 deg range”:
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Thiswill center the Sigma Theta trace on the Scalar Wind Direction trace as an “error
bar”, and asillustrated below:

(The above figure is an example only; your configuration may be different.)

4.8.5 Setting up a Dual Trend Chart with Wind Speed and Wind Direction

IMPORTANT: You must have “wind speed” and “peak wind speed” database !
| parameters already configured in order to create atrend chart by using information in this |
| section. It'salso best if some wind speed and peak wind speed data have already been |
| acquired.

Dual trend charts can be created with one trend chart using one axis (either left or right)
and the other trend chart using the other axis. In this case, each trend chart can use only
one axis. Building on the previous example, let’s create an “upper” trend chart that
displays scalar wind direction and standard deviation of wind direction (as Sigma-Theta)
onitsleft axis. Let'salso createa”lower” trend chart that displays wind speed and peak
wind speed on itsright axis. The two charts together form a composite “ upper/lower”
trend chart display.

Begin by editing the Wind Direction trend chart that was previously setup. On its “ Chart”
tab, rename the chart and itstitle to “Wind Direction and Wind Speed” because it will
become a composite chart:
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Let'susealeft Y axis on the upper chart and anew right Y axis on the lower chart. Since
the Wind Direction chart already usesthe left Y axis, let’ s reassign the left axis display
from “normal” to “upper”:

Next let’s setup the new right Y axis on the lower chart. On the “ Axis Settings’ tab,
select theright axis, check the “Show Y axis’ box, provide atitle of “mph” for the axis,
select “lower” asthe display type, set the “Datatype” to “Wind Speed”, units of “mph”,
turn off automatic scaling, set the “Minimum” to O, “Maximum to 25, “Major steps’ to 5
and “Minor steps’ to 5:
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From the “Data Traces’ tab, add a new wind speed trace and assign it to the right axis.
Set the trace type as a line with the color black. Set the “ Parameter (Vaue/Avg/Mean)”
list box to “Wind Speed”, asthisis the database parameter to assign to the trace.

Next from the “Data Traces’ tab, add a peak wind speed trace and aso assign it to the
right axis. Set the trace type as aline with the color red. Set the “ Parameter
(Vaue/Avg/Mean)” list box to “Peak Wind Speed”:
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The final result is shown below:

(The above figure is an example only; your configuration may be different.)

Note: If you have asingle trend chart with dual axes, and one axisis setup to use
automatic scaling (on the “ Axis Setting” tab)”, then be sure to set the other axisto also
use automatic scaling. That way the software can optimize axis readability with a
common grid overlay.
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4.8.6 Trace Functions

In the previous examples, the 0-540 wind direction and Sigma-Theta traces required the
use of aspecia trace function to map the 0-360 degree values to arange of 0-540
degrees. All trace functions are explained below:

1.

Accumulate (reset on limit). Used to accumulate a parameter’ s values until a
limit isreached, and then the trace isreset to zero. The reset value is specified
asanumber. For example, this trace function can be used to accumulate the
rain parameter until 1.0 inch has accumulated, then the trace is reset to zero.

Accumulate (reset on time difference). Used to accumulate a parameter’s
values until acyclical time lapse has occurred relative to midnight. The reset
value is specified in the format of hours and minutes (hh:mm). For example,
this trace function can be use to accumul ate the rain parameter cyclically
every 8 hours (8:00) beginning at midnight. Every eight hours the trace will
reset to zero.

Accumulate (reset on inactivity time). Used to accumulate a parameter’s
values until the parameter value is unchanged for a specified period of time.
This period is called the “inactivity time.” Theinactivity time has aformat of
hours and minutes (hh:mm). For example, this function can be used to mark
rain events when no rain has occurred for a specified time.

Wind direction in O - 540 deg range. Used to map a0 to 360 degree wind
direction parameter to a 0 to 540 degree range. Thisisuseful for trending a
polar parameter (i.e., wind direction) on arectangular chart and in which you
do not want the trace to “ paint” when the wind direction is from the north. No
argument is required.

Minimum (reset on time difference). Used to trace a parameter’ s minimum
value over acyclical time period relative to midnight. For example, you can
use this function to track the minimum ambient temperature every 6 hours.

Minimum (reset on absolute time). Used to trace a parameter’ s minimum
value until an absolute reset time has been reached. For example, you can use
this trace function to track the minimum ambient temperature until 12:00 noon
(standard time) every day.

Maximum (reset on time difference). Used to trace a parameter’ s maximum
value over acyclical time period relative to midnight. For example, you can
use this trace function to track the maximum ambient temperature every 8
hours and the maximum daily peak wind speed every 24 hours.

Maximum (reset on absolute time). Used to trace a parameter’ s maximum
value until an absolute reset time has been reached. For example, you can use
this trace function to track the maximum ambient temperature until 5:00 pm
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(17:00 standard time) every day and the maximum daily peak wind speed until
midnight (24:00 standard time).

Note: Only one trace function of a given type can be assigned to the same parameter on
the same axis. For example, you cannot assign more than one “accumulate (reset on time
difference)” trace function to arain parameter that is setup to use the left axis. However,
you can make one assignment to the left axis, and another to the right axis.

IMPORTANT: Some of the arguments to the trace function allow you to set the time
with aformat of hh:mm (hours:minutes). When setting the “mm” part, do not assign a
time value that has higher resolution than the data table interval that drivesthe trace. For
example, with atrace setup to use the hourly data table, the “mm” value should aways be
“00”. Datafrom the hourly table cannot be resolved to less than an hour. Similarly,
suppose you have setup a data trace based on the 15-minute datatable. The “mm” value
should always be in increments of 15 minutes (i.e., “00”, “15”, “30”, or “45").

49 Viewing Trend Charts

4.9.1 Opening a Trend Chart

Once trend charts have been created, they can be opened from the View menu and “ Trend
Charts’ selection. Once opened, they can also be selected from the “Window” menu (see
Section 4.18).

4.9.2 Automatically Opening a Trend Chart at Startup

Y ou can define which trend charts you want to automatically open when the software
starts up. See Section 4.16.

4.9.3 The Trend Chart Tool Bar
The following tool bar rests above the trend chart:

The “update trend” tool is used to refresh or freeze the display. When
in the depressed position, the trend chart will refresh when new data
arrives. When in the out position, the trend chart is frozen and will
not be updated with the arrival of new data. The operation of this
tool issimilar to the “ Auto Update” button of the Data View.

The“zoom” tool is used to define and expand a rectangular area of
the trend chart. Position the mouse in the upper left hand corner of an
imaginary rectangular area of the trend chart. With the left mouse
button pressed, drag the mouse to the lower right corner of the
imaginary rectangle and release the mouse button. The rectangular
areawill expand to fill the chart. To reverse the action, pressthe
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“zoom” tool again.

Click the “zoom in date axis’ tool to zoom in on the date and time.
For example, if the date/time axis grid isin increments of 2 hours,
then upon pressing the tool, the date/time axis grid will change to
increments of 1 hour.

Click the “zoom out date axis’ tool to zoom out on the date and time.
For example, if the date/time axis grid isin increments of 1 hour, then
upon pressing the tool, the date/time axis grid will change to
increments of 2 hours.

Click the “day snap” tool to snap the trend chart to atime frame of 1
day.

Click the “month snap” tool to snap the trend chart to atime frame of
1 month. Thisisonly effective for trend charts that can hold a month
of data without being scrolled. These trend charts have dataintervals
of 15 minutes, 20 minutes, 30 minutes or hourly. Trend charts based

on 1-minute, 5-minute, and 10-minute intervals do not normally show
amonth of data at atime.

Thisisa“DataNavigation Toolbar”. Click on the first of these
buttons to go to the start of the database (start of trace). Click on the
last button to go to the end of the database (end of trace). Click on
the left pointer to scroll the chart to the left. Click on the right pointer
to scroll the chart to the right. Y ou can also scroll the chart by
moving the scroll bar located below the trend chart.

This“edit trend settings” tool button provides access to creating and
editing atrend chart.

Use the “print trend graph” tool to print the trend chart to the printer.
Note: Before using this button, make sure that the printer has been
properly setup. Go to the File menu and “Print Setup” option to
review the printer settings. Configuring your printer or installing its
printer driver is outside the scope of this manual.

Click on the “copy trend graph image” tool to copy an image of the
trend chart to Microsoft Window’ s clipboard. Once in the clipboard,
you can paste the image to aword processor or other program.

4.9.4 Deleting a Trend Chart

To delete atrend chart, go to the View menu, select “Trend Chart” and then “Delete
Trend”. Select atrend chart to delete and then press the “Delete” button:
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4.10 Additional Examples of Trend Charts

4.10.1 Rainfall

IMPORTANT: You must have arain database parameter already configured in order to |
create arainfall trend chart by using the information in this section. It's also best if some
rain data has already been acquired. |

Begin by creating anew “Rain” trend chart with both left and right axes, and based on a
15-minute datainterval. Configure the left axis asa* precipitation” data type and with a
range of 0to 0.2 inches with 10 major steps (for increments of 0.02 inches). Create ared
“Rainfall” trace by assigning a“rain” database parameter to the left axis and using a
“bar” trace type. Set the left axisto a“normal” display type. No special datatrace
function is required.

Next, configure the right axis as a“precipitation” data type and with arange of 0 to 2
inches and 10 major steps (for increments of 0.2 inches). Createa“Daily Rainfal” trace
by assigning the same “rain” database parameter to the right axis but thistime using an
light blue “area’ trace type. Set the right axisto a“normal” display type. Setup atrace
function of “accumulate (reset on time difference)” to totalize (cumulate) the 15-minute
rainfall values from midnight. The reset timeis*“24:00” which causes the cumulative
trace to reset to zero every 24 hours from midnight.
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Note: When both the left and right axes are assigned to a“normal” display type, then the
resulting trend chart is a single chart with both aleft and aright axis. Recall that 5
assigning the left axis to the “upper” display type and the right axisto a“lower” display
type (or vice-versa) resultsin a composite “upper/lower” chart view with both upper and
lower trend charts.

On the “Data Traces’ tab, use the large up and down arrow buttons to reverse the order of
the “Rainfall” trace and the “Daily Rainfall” trace as shown:
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Now the Rainfall trace will be drawn last so that it won’t be masked by the “area’-type
Daily Rainfall trace. Theresulting “Rain” trend chart is shown below:

(The above figure is an example only; your configuration may be different.)

4.10.2 Ambient Temperature and Relative Humidity

IMPORTANT: You must have several temperature-type database parameters already
configured in order to create atrend chart by using the information in this section. It's
also best if the required data has already been acquired. For a complete configuration to
follow along with this example, the following database parameters are needed: dew point
temperature, wet bulb temperature, heat index temperature, wind chill temperature,
ambient temperature, and relative humidity. 1f you don’t have one of the parameters, just
ignore setting it up in the instructions below.

Begin by creating a new “ Ambient Temperature and Relative Humidity” trend chart with
both left and right axes, and based on a 15-minute data interval. Configure the left axis
as a“temperature” datatype and with arange of 20 to 120 °F and 10 major steps (for
increments of 10 °F).

Create and assign severa temperature-type traces to the left axis of the trend chart (assign
adifferent color to each trace):

1. A “Dewpoint” trace by assigning a“dewpoint” database parameter to the | eft
axisand using a“line” trace type. No special trace function is required.
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2. A “Wetbulb” trace by assigning a “wetbulb temperature” database parameter
to theleft axisand using a“line” trace type. No specia trace function is
required.

3. A “Heat Index” trace by assigning a“heat index” database parameter to the
left axisand using a“line” trace type. No special trace function is required.

4. A “Wind Chill index” trace by assigning a“wind chill temperature” database
parameter to the left axisand using a*“line” trace type. No special trace
function is required.

5. An*“Ambient Temperature” trace by assigning an “ambient temperature”
database parameter to the left axis and using a“line” trace type. No special
trace function is required.

Next, configure the right axis as a“relative humidity” data type and with arange of 20 to
120% in steps of 10 (for increments of 10%). Create a“Relative Humidity” trace by
assigning the “relative humidity” database parameter to the right axisand using a“line’
trace type. No special trace function is required.

Note: While relative humidity should never be greater than 100%, we chose to scale it to
the same as the temperature scale to make it easy to “read” the temperature traces from |
either axis.

The final trend chart is shown below. By looking at the trend chart you can easily see
that a cool front occurred. Because the relative humidity climbed to 100%, it isaso
likely that rainfall occurred during the same time period.
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(The above figure is an example only; your configuration may be different.)

Note: When setting up both aleft and right axis for asingle “normal” trend chart, it is
important to set the scaling and major steps (graduations) so that the grid lines overlay
between traces that use the |eft axis and traces that use the right axis. In the example
above, we have chosen the same step sizes for both axes.

Y ou may wish to disable a trace from appearing on the trend chart. Simply uncheck the
box to the left of the datatrace name. For example, it may be useful to disable the “Heat
Index” trace in the winter time and the “Wind Chill” trace in the summer time:
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4.10.3 Solar Radiation

IMPORTANT: You must have solar radiation and solar energy database parameters i
| dready configured in order to create atrend chart by using the information in this section. |
| IU'salso best if the required data has already been acquired. '

Begin by creating anew “ Solar Radiation” trend chart with both left and right axes, and
based on a 1-minute data interval. Configure the left axis as a“solar radiation” data type
and with arange of 0 to 1000 watts per square meter (W/m?) with 20 major steps (for
increments of 50 W/m?). Use ayellow “area’ trace type. No special trace function is
needed for the solar radiation parameter.

Next, configure the right axis as a“solar energy” datatype and with arange of 0 to 50
MJm? and 10 major steps (for increments of 5 MJm?). Create adaily “solar energy”
trace by assigning the solar energy parameter to the right axis and with agreen “line”
trace type. Setup atrace function of “accumulate (reset on time difference)” to totalize
(cumulate) the 1-minute solar energy values from midnight. The reset timeis*24:00”
which causes the cumulative trace to reset to zero every 24 hours from midnight.

The figure below shows the resulting “ Solar Radiation” trend chart on a sunny day.
Notice the “dips’ in the solar radiation trace. These dips were caused by atelephone pole
and its overhead wires momentarily casting a shadow on the solar radiation sensor. (Itis
best to install a solar radiation sensor where it will never receive a shadow; however, it's
not always possible.)
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(The above figure is an example only; your configuration may be different.)

4.11 Creating Indicator Views

4.11.1 Getting Started

Y ou can easily create one or more Indicator Views for displaying weather data. In this

section we will show you how. For instructional purposes, we have setup Met Manager

with a“direct-connection” data source, an “instantaneous’ sample rate of 5 seconds, and
the following database parameters:

Wind speed

Scalar wind direction
Ambient temperature
Relative humidity
Barometric pressure
Rain
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To create anew Indicator View, select “Indicator Pages’, then “New Indicator Page”
from the View menu:

The following dialog is presented to allow you to name the new indicator page. Overtype
the default name of “New Indicator Page” with the name that you want to give to the
indicator page; for example, “ Current Weather” or “Primary Indicators’.

After naming the page and clicking the OK button, the following blank Indicator View is
then displayed:
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Pressthe “Design Mode” tool button to go into design mode for creating a new
Indicator View. The design canvasis overlaid with a dotted grid and the remainder of the
tool bar becomes active:

4.11.2 Description of the Tool Bar
The following tool bar rests above the Indicator View:

Using Met Manager Page 4-36 Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

“Design mode” tool. Used to enable the creation and design of an indicator page.

“Digital display” tool. Select and drop the tool onto the canvas to add a digital
indicator to the page.

“Vertical bar graph” tool. Select and drop the tool onto the canvasto add a
vertical bar graph indicator to the page.

“120° meter” tool. Select and drop the tool onto the canvas to add a 120 °meter
indicator to the page.

“180° meter” tool. Select and drop the tool onto the canvas to add a 180 °meter
indicator to the page.

“270° meter” tool. Select and drop the tool onto the canvasto add a 270 ° meter
indicator to the page.

“Wind direction label” tool. Select and drop the tool onto the canvasto add a
wind direction sector indicator to the page.

“Wind direction indicator” tool. Select and drop the tool onto the canvasto add a
wind direction indicator to the page.

% | | “Deleteindicator” tool. Used to delete an indicator from the page. Select an
—— | existing indicator by clicking on it and then press the tool button.

“Edit indicator” tool. Used to edit an existing indicator. Select an existing
indicator by clicking on it and then press the tool button.

“Bring to front” tool. Used to bring an indicator to the front when two indicators
overlap each other. Select the indicator by clicking on it and then press the tool
button.

“Send to back” tool. Used to place an indicator in the background when two
indicators overlap each other. Select the indicator by clicking on it and then press
the tool button.

“Snap” tool. Used to snap an indicator to the background grid. Pressthe tool to
highlight it. Then either select, drag and move an existing indicator, or place a
new indicator on the page. The indicator will align with the background grid.
Thisisuseful for aligning indicators next to each other.

4.11.3 Creating a Wind Direction Indicator

Let’s create awind direction indicator that updates with instantaneous data. To add a new
wind direction indicator to the Indicator View, select and drop the “wind direction
indicator” tool onto the design canvas.
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Select the indicator with your mouse and right click on it (or press the “ Edit Indicator”
tool). This pops up amenu to allow you to edit the indicator’ s properties:

Select the “ Edit Properties” menu item. The “Edit Indicator Properties’ dialog is then
displayed. Set the parameter name to “ Scalar Wind Direction” (or other wind direction
parameter that your system may be configured with) and with units of “degrees’. Select
an interval of “instantaneous”:
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Next, select the “ Frame” tab and label the indicator as “ Current Wind Direction” on two
lines:

Select the “ Scale” tab to review the properties of the indicator’ s scale and arrow pointer:
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The “Bar/arrow Color” represents the color of the pointer when the indicator is showing
“valid” or “partially valid” data. The “Invalid Color” represents the color of the pointer
for indicating invalid, missing or calibration data. The “Scale Color” isthe color of the
major and minor tick-marks on the scale. The “Background Color” isthe color of the
scale background.

Now that we have assigned awind direction parameter to the indicator and given the
indicator aname (label), let’s review our prior assignment of the indicator’s unit by right-
clicking on the indicator:

We can also review our prior assignment of the indicator’ s update interval, or select a
new interval:
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Finally, select the indicator with your mouse and drag it onto the upper left of the design
canvas. You can size the indicator by grabbing the sides or a corner with the left mouse
button and dragging.

Now let’s add adigital indicator to the view, to show the current wind direction in
degrees. Select and drop a“digital indicator” tool onto the design canvas, and right-click
on it to show the pop-up menu:

In the same manner as for the wind direction indicator, select “Edit Properties’ and then
set the “Parameter” properties to scalar wind direction, units of degrees, and interval of
“instantaneous’. Select the “Frame” tab and turn off (uncheck) the bevel around the
digital indicator frame so that the digital indicator frame will merge with the background
of the wind direction indicator. Thiswill allow usto overlay the digital indicator onto the
center of the wind direction indicator:
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Y ou can define the width and numeric precision of the digital value from the “ Digital
Display” tab by setting the “Value format” field:

The “##0" part of the field defines the number of display character positions to the left of
the decimal point. For example, for one position, set that part of thefield to “0”. For two
positions, set it to “#0”, three positions to “##0”, and so forth. The “.0” part of thefield
defines the number of display characters to the right of the decimal point. For no
characters to the right of the decimal point, removethe®.0”. For one character, set it to
“.0”, for two characters set it to “.00”, and so on. For the wind direction digital indicator,

Using Met Manager Page 4-42 Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

let's set the “Value format” to “##0” for amaximum of 3 characters and without any
decimal places.

Now let’s place the digital indicator onto the wind direction indicator. Select the digital
indicator with your left mouse button and drag and drop the digital indicator into the
middle of the wind direction indicator:

If needed, resize the digital indicator by grabbing a corner with the left mouse button and
then dragging inward (smaller) or outward (larger).

Note: If for some reason the digital indicator goes behind the wind direction indicator
when you drop it on to the wind direction indicator, then select the wind direction
indicator with your mouse and click the “send to back” tool button. Thiswill force the
wind direction indicator behind the digital indicator.

Next, let’s add awind direction sector indicator to display the wind direction as a sector.
Select and drop the wind direction sector tool onto the design canvas, and then right-click
onit:

Set the sector indicator’ s “Parameter” propertiesto “scalar wind direction”, degree units
and instantaneous data interval. Similar to the digital indicator, drag the sector indicator
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to the middle of the wind direction indicator and just below the digital indicator. The
overall wind direction indicator is now complete:

4.11.4 Creating a Wind Speed Indicator

Let’sadd awind speed indicator to the Indicator View. Select and drop one of the meter
tools onto the design canvas. WEe'll use the 120° meter indicator. Select it, right-click on
it, and edit its properties. Set the “Parameter” tab to “wind speed”, units of “mph”, and
interval of “instantaneous.” Normally the indicator is named on the “ Frame” tab;
however, we will not name this indicator as we will later place adigital indicator below it
and we will name that one instead. On the “ Scale” tab, set the minimum and maximum
range. We'll use the range values of 0 to 50:
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The“Vaueformat” field defines the width and precision of the numeric labels on the
meter. For awider field width, specify more “#’ characters at the start. For additional
decimal places, add a decimal point and a zero for each additional decimal place desired.
For example, for a6 character value with 2 digits to the right of the decimal point,
specify the “Value format” field as “##0.00”.

Adjust the “Major steps’ and “Minor steps’ to your preference. The “Major steps”

define the number of intervals or major graduations over the range, in this case 5 intervals
over the range of 0 to 50 mph. The “Minor steps’ define the number of subintervals
between the steps; in this case, 5 subintervals for each step (2 mph per subinterval).

The completed wind speed indicator is shown below:

Add adigital wind speed indicator. Select and drop adigital indicator tool onto the
canvas. Set its parameter, units, and interval properties to the same as the wind speed
meter indicator. Name it “Current Wind Speed”:

4.11.5 Positioning the Wind Direction and Wind Speed Indicators

Position the wind speed meter indicator next to the wind direction indicator. Position and
resize the wind speed digital indicator below the wind speed meter indicator as shown in
the figure below:
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(The above figure is an example only; your configuration may look different.)

Position controls include the mouse for selecting and moving the indicator (dragging),
and the following keys:

o Left, right, up, down arrow keys to move the indicator in the respective
direction.

e Control-left, control-right, control-up, and control-down arrow keys for
smaller incremental movements. For example, a*“ control-left arrow key”
combination is made by pressing the control key (“Ctrl” on most keyboards)
and then simultaneously pressing the left arrow key.

Size controls include the mouse and some keys. With the left button of the mouse, select
the indicator, then drag the side or corner of the indicator to resizeit. With the keyboard,
press the shift-left, shift-right, shift-up, and shift-down arrow keysto “grow” or shrink
the indicator in the respective direction.

4.11.6 Creating Ambient Temperature Indicators

Now let’s add three ambient temperature indicators:

e A current temperature vertical bar graph
e A minimum daily temperature vertical bar graph
e A maximum daily temperature vertical bar graph

For speed in creating the temperature indicators, select and drop three vertical bar graphs
onto the design canvas. For thefirst “ Current Temperature” indicator, set its“ Parameter”
properties to an “ Ambient Temperature” parameter, °F units, “instantaneous’ interval,
and no specia function. From the “Frame” tab, name the indicator “Current
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Temperature”. From the “Digital Display” tab, set the “Vaue format” of the digital
display indicator to “##0.0” for a“Vaue format” field width of 5 with one decimal place.
From the “ Scale” tab, set the scale range for the meter scale from 0 to 100, and with zero
decimal placesin a“Vaueformat” field width of 3 (##0). Set the “Mgjor steps’ to 10
with 5 subinterval “Minor steps’. The “Bar width” isthe width of the vertical inner
scale. To make it skinny (and look like athermometer), set it to avalueof 3or 4. To
fatten it up, set it to ahigher value; for example, 16. This example uses 4.

Similar to the wind direction and meter indicators, the “Bar/arrow Color” represents the
color of the pointer when the vertical bar graph indicator (in this case temperature) is
showing “valid” or “partialy valid’ data. The “Invalid Color” represents the color of the
pointer for indicating invalid, missing or calibration data. The“Scale Color” isthe color
of the magjor and minor tick-marks on the scale. The “Background Color” isthe color of
the scale background (bar part). Experiment with these properties to achieve varying
visual effects.
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For the second “Minimum Daily Temperature” indicator, set it up the same asthe
“Current Temperature” indicator but with the following changes:

e Onthe*“Parameter” tab, set theinterval to “1 minute”. Apply a*“Function” of
“Minimum” with an auto-reset interval of 24 hours (24:00). Thiswill track the
minimum ambient temperature for 24 hours from midnight, and with an update
once per minute:

e Onthe“Frame” tab, name the indicator “Minimum Daily Temperature”.
e Onthe*“Scale’ tab, set the bar color to blue (to imply cold).

For the third “Maximum Daily Temperature” indicator, set it up the same asthe
“Minimum Daily Temperature” indicator but with the following changes:

e Onthe“Parameter” tab, apply a“Function” of “Maximum” with an auto-reset
interval of 24 hours (24.00) relative to midnight:

e Onthe“Frame’ tab, name the indicator “Maximum Daily Temperature”.

e Onthe“Scale” tab, set the bar color to red (to imply hot). Note that red may also
be used to indicate “invalid” (aswell as missing or calibration). This dua-mode
use of red is alright because the digital value will also turn red when the
indicator’svalueisinvalid.

In general, the following special functions (located on the “ Parameter” tab) are available
to most indicators:
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None - Use the parameter value without applying any special function.

Average - Average the parameter value. Most parameters are already averaged
when sent to the indicator; however, you may wish for the indicator to receive
data based on one interval and re-average the data based on another interval. For
example, to receive 1-minute values of ambient temperature and re-average them
over a5 minute interval, select the “ Average” function with areset interval of 5
minutes (0:05):

Totalize - Accumulate the parameter value over atime period relative to
midnight. Thisisuseful for summing rainfall data. For example, to accumulate
rain over a 24-hour period (relative to midnight), setup the rain indicator’s
properties as shown below. In the example below, the indicator’ s update rate is
once per minute because a new rain parameter value is sent to the indicator based
on the selected “1-minute” interval. Select the “ Automatic reset based on time”
field to auto-reset the indicator’ s value to zero when the reset interval has expired.
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e Minimum - Indicate the minimum value of a parameter over atime interval
relative to midnight. For example, if an ambient temperature indicator is set with
an interval of “instantaneous’, function of “minimum”, and auto-reset time of
“8:00”, then the indicator will update the minimum ambient temperature of the
first 8-hour time period (from midnight), will automatically reset, will show the
minimum temperature for the next 8-hour period and so forth. The update rate
will be the same as the instantaneous sampl e rate of the data received from the
data logger.

e Maximum - Indicate the maximum value of a parameter over atimeinterval, in
the same fashion as the “minimum” function.

Note: In the above cases, if “Manual reset” was selected instead of the “ Automatic reset
| based on time”, then the indicator would continue to apply the designated function until
| reset by the user. This manual reset is accomplished by right-clicking on the indicator

| and then selecting the “reset” item from the pop-up menu.
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Position the ambient temperature indicators below the wind direction indicator:

(The above figure is an example only; your configuration may look different.)

4.11.7 Creating Rain Indicators

Now let’s add two rain indicators; (1) avertical bar graph to show the daily total rainfall
and (2) adigital indicator to accumulate the rainfall until you manually reset it. Both
indicators will be set to update once each minute.
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Select and drop a vertical bar graph indicator onto the canvas. Set its “Parameter”
propertiesto “Rain”, “inch” unit, “1 minute” interval, “totalize” function, and
automatically reset every 24 hours (24:00). On the “Frame” tab, name the indicator
“Daily Rainfall”. On the “Digital Display” tab set the number of decimal digitsto twoin
afield width of 5 by setting the “value format” to “#0.00”. Onthe“Scale’ tab, set the
range of the indicator from 0O to 2 inches with a“Vaue format” of “#0.0” and adjust the
“Maor steps’ to 4 and the “Minor steps’ to 5. This allows the indicator to show up to 2
inches of rainfall per day with 4 major graduations and 5 minor graduations for a minor

increment of 0.1 inch:

For higher resolution, set the maximum value lower (say 1 inch) and adjust the major and
minor steps as needed.

Note: The indicator above will show up to 2 inches of rainfall per day before exceeding
the upper limit. However, the digital portion of the indicator will continue to show the
total amount of rainfall for the day.

Select and drop adigital indicator onto the canvas. Set its“ Parameter” propertiesto
“Rain”, “inch” unit, “1 minute” interval, “totalize” function, and “manual reset” function.
On the “Frame” tab, name the indicator “Cumulative Rainfall”. On the “Digital Display”
tab set the number of decimal digits to two by setting the “value format” to “#0.00”:

Using Met Manager Page 4-52 Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002

The digital indicator will accumulate rain until manually reset. To manually reset it, right
click on it and select the “reset” option.

Note: Currently when started, Met Manager clears al itsindicators and startstherain
accumulation from zero. Thisisalso true for minimum, maximum, average, and other
types of indicators.

Drag the “Daily Rainfall” bar graph indicator next to the “Maximum Daily Temperature”
indicator. Drag the “Cumulative Rainfall” digital indicator below the “Daily Rainfall”
bar graph indicator. Adjust the size as needed to fill the space.

Finally, add two more vertical bar graph indicators; one for relative humidity and the
other for barometric pressure. Name the first one “Rel Humidity (15-Minute)”. Set this
indicator to a“Relative Humidity” parameter, units of “%”, function of “None”, and
interval of 15 minutes. Set the “Value format” on the “Digital Display” tab to show a
field width of 3 without any decimal places (##0). On the “Scale” tab, set the bar scale
range from 0 to 100. Set the“Mgjor steps’ to 10 and “Minor steps’ to 5. Place the
indicator next to the rain indicator:

Similarly, set up abarometric pressure indicator. Name the indicator “Baro Pressure (15-
Minute)”. Set the parameter to “Barometric Pressure”, units of “inHg”, function of
“None’, and interval of 15 minutes. Set the “Value format” on the “Digital Display” tab
to two decimal places with afield width of 5 (#0.00). Similarly, on the“Scale’ tab, set
the scale’'s“Value format” to two decimal places with afield width of 5 (#0.00). Set the
bar scale range from 29.50 to 30.50. Set the “Magjor steps’ to 5 and “Minor steps’ to 4.
Place the indicator next to the relative humidity indicator.

Note: Adjust the range on your barometric pressure indicator to reflect the normal
barometric pressure variation in your area.

4.11.8 The Final “Current Weather” Indicator View

When finished adding or editing the indicators, press the “design mode” tool to
take the Indicator View out of design mode. The following figure shows the new
Indicator View:
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(The above figure is an example only; your configuration may look different.)

4.12 Using Indicator Views

4.12.1 Opening an Indicator View

To open an Indicator View, select “Indicator Pages’ from the View menu. Then select an
Indicator View to display, in this case the one named “ Current Weather”.
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Note: You can display an Indicator View that has aready been opened by selecting it
from Met Manager’s Window menu. See Section 4.18.

4.12.2 Automatically Opening an Indicator View at Startup

To automatically open an Indicator View when Met Manager starts up, set the Indicator
View’s check box in the “View” menu, “ Startup” submenu dialog:

(The above figure is an example only; your configuration may be different.)

Also see Section 4.16 for configuring various startup options.

4.12.3 Renaming an Indicator View
An Indicator View can be renamed in two ways.

1. If anIndicator View isthe active window then select the “View” menu, “Indicator
Pages’ submenu, and “Rename Indicator Page” item. The following dialog is
then displayed to alow you to rename the Indicator View:
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(The above figure is an example only; your configuration may be different.)

2. If anIndicator View is not the active window then select the “View” menu,
“Indicator Pages’ submenu, and “Rename Indicator Page” item. The following
dialog is then displayed to allow you to rename the Indicator View:

(The above figure is an example only; your configuration may be different.)

4.12.4 Deleting an Indicator View

To delete an Indicator View, select “Indicator Pages’ from the “View” menu. Then
select the “ Delete Indicator Page” item. The following dialog is displayed:

(The above figure is an example only; your configuration may be different.)
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Select the indicator page you wish to delete and press the “Delete” button.

Alternatively, delete all indicators from the Indicator View. Select each indicator one at a
time and press the delete key; then close the view. This deletes the view.

4.13 Creating a Wind Rose

4.13.1 Getting Started

With Met Manager you can easily create a Wind Rose as explained in this section. For
instructional purposes, we have setup Met Manager with a“direct-connection” data
source, an “instantaneous’ sample rate of 5 seconds, and the following parameters:

e Wind speed
e Scdar wind direction

4.13.2 Description of the Tool Bar
The following tool bar rests above the Wind Rose View:

The “update display” tool is used to refresh or freeze the display. Whenin the
depressed position, the wind rose will refresh when new data arrives. When in
the out position, the wind rose is frozen and will not be updated with the arrival of
new data. The operation of thistool is similar to the “ Auto Update” button of the
Data View.

Click the “day snap” tool to snap the wind rose to atime frame of 1 day.

Click the “month snap” tool to snap the wind rose to atime frame of 1 month.

Click the “edit” tool button to edit the properties of awind rose.

Use the “print” tool to print the wind rose to the printer. Note: Before using this
button, make sure that the printer has been properly setup. Go to the File menu
and “Print Setup” option to review the printer settings. Configuring your printer
or installing its printer driver is outside the scope of Met Manager.

Click on the “copy image’ tool to copy an image of the wind rose to Microsoft
Window’s clipboard. Once in the clipboard, you can paste the image to aword
processor or other program.
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The “Data Navigator” tool bar button adjusts the data set being sent to the wind rose:

Go to the beginning of the database

For monthly wind roses, set the wind rose to the previous month.

For weekly wind roses, set the wind rose to the previous week.

For daily wind roses, set the wind rose to the previous day.

For other wind roses, set the wind rose to the previous interval specified in the
“datarange” property

For monthly wind roses, set the wind rose to the previous day.
For weekly wind roses, set the wind rose to the previous day.
For daily or other wind roses, set the wind rose to the previous hour

Snap the wind rose to the beginning of the interval specified in the “data range
property” of thewind rose. For example, if the data range is one month, then
pressing this button will snap the wind rose to the first day of the month.

For monthly wind roses, set the wind rose to the next day.
For weekly wind roses, set the wind rose to the next day.
For daily or other wind roses, set the wind rose to the next hour

For monthly wind roses, set the wind rose to the next month.

For weekly wind roses, set the wind rose to the next week.

For daily wind roses, set the wind rose to the next day.

For other wind roses, set the wind rose to the next interval specified in the “data
range” property

M

Go to the end of the database

4.13.3 Creating a Wind Rose

To create awind rose, select “Wind Rose” from the View menu. The first time you do
thisin anew project, the “Edit Wind Rose Graph Settings’ dialog below will
automatically appear since Met Manager knows that the wind speed and wind direction

parameters need to be assigned. Otherwise press the “ Edit” tool button. The dialog
is shown below:
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(The above figure is an example only; your configuration may be different.)

Select adatainterval for thewind rose. For wind roses, thisinterval isnormally the
hourly interval. Assign the wind speed and wind direction parameters. In this example,
these parameters are wind speed and scalar wind direction.

Pick adatarange from the “Datarange’ list box. Choicesarel, 3, 6, 8, and 12 hours, 1
day, monthly and custom. “Custom” allows you to generate awind rose over a date and
time range that you define:

The above start and end date/time ranges define one day beginning at 12 am (time 00:00)
on 7/2/2002 and ending at midnight on 7/2/2002. To generate awind rose for the first
hour of the day, specify:
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Check the “Use automatic scaling” box to have Met Manager automatically adjust the
grid size, or uncheck this box and specify a graph maximum in percent. For example, a
setting of 50% will scale the wind rose graph radius to show a maximum of 50% of the
winds along any given radius. Set the “Major steps’ to be the number of major
graduations along the radius.

Y ou can click on the “Rose Color Selection” fields to change the color of the various sub-
ranges of the wind speed. Also, you can name the wind rose in the “ Chart title” box.

An example of awind rose is shown below:

(The above figure is an example only; your configuration may be different.)
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4.13.4 Editing a Wind Rose
To edit awind rose, open it (e.g., from the View menu), then click the “ Edit” tool button

. Edit the properties as needed.

4.14 Viewing Wind Roses

4.14.1 Opening a Wind Rose View
To view aWind Rose, select “Wind Rose” from the View menu to open it:

Note: Y ou can display a Wind Rose that has already been opened by selecting it from
Met Manager’s Window menu. See Section 4.18.

4.14.2 Automatically Opening a Wind Rose View at Startup

To automatically open a Wind Rose View that you' ve created, set its check box in the
View menu, “ Startup” dialog. Also see Section 4.16 for configuring various startup
options.

(The above figure is an example only; your configuration may be different.)
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4.15 Configuring Data Table View and Report Options

4.15.1 Configuring the Options

To configure Data View and report options, select “Options” from the View menu. The
following dialog will be presented:

(The above figure is an example only; your configuration may be different.)

4.15.2 Configuring the Data View Columns

Y ou can decide which database parameters will be visible on the Data View and their
column order. From the above figure, check the parameter if you want it to bein the
Data View. To reposition a parameter’s column order on the display, select the
parameter with your mouse and then use the up and down arrows to move the parameter
inthelist.

Y ou can aso set the units, number of display digits, and column width for each
parameter. These settings only affect the DataView.

4.15.3 Configuring the Report Columns

Similar to the Data View, you can decide which database parameters will be visiblein the
“datatablelisting” type of reports and their column order. These reportsinclude the Data
Table Report and the Daily Summary Report.

Select the “Report Columns” tab. Then check the parameter if you want it to show up in
thelisting. To reposition a parameter’ s column order within the listing, select the
parameter with your mouse and then use the up and down arrows to reorder the
parameter.
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(The above figure is an example only; your configuration may be different.)

Note: Thereport listing is printed in “landscape” orientation to maximize the number of
columns that can be fit in the report. However, Met Manager currently allows formatting |
of only one report (of the “datatable listing” type). Thus, you must decide which are the
most important parameters for listing in the report. Uncheck the least important '
parameters.

4.15.4 Configuring the Report Header

To configure a header that will show up on all reports, select the “Report Headings’ tab.
Then define entries for each heading line:

(The above figure is an example only; your configuration may be different.)

Each line of the heading is centered within the header area of the reports.
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4.15.5 Setting up an Auto Report

If you have a printer connected to the computer, you can set up Met Manager to
automatically generate a Daily Summary Report. Select the “ Auto-Report” tab.

Check the “Enable Daily Summary Auto-Report” box to enable an auto report.

Some facilities may want to generate a Daily Summary Report on a schedule that does
not end at midnight. Y ou can do this by specifying the last hour of the report in the “Last
hour ending at” field.

Y ou can also specify the local time that the report isto print.

4.16 Configuring Startup Options

Many views may be defined for aMet Manager project including the Data View, Event
Log View, Instantaneous View, multiple Trend Chart Views, multiple Indicator Views,
and aWind Rose View. To avoid having to manually open these views when Met
Manager first starts, you can configure some startup options. Select “ Startup” from the
View menu to show the following dialog:

(The above figure is an example only; your configuration may be different.)
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Check the various views that you want Met Manager to automatically load when the
program isfirst started. You can also select aview (from the list) with your mouse and
then use the up and down arrow keysto reorder it. This ordering affects the order that the
views are opened as well as the order of thelist of views located in the Windows menu
(see Section 4.18). In the above example, the last view in thelist titled “Wind and
Temperature” will be the view on top following startup.

4.17 Generating Reports

4.17.1 Getting Started
To generate reports, select the “Reports’ menu:

Then select individual reports from the menu:

1. DataTables Report. Generates a columnar listing of a subset of one of the
available data tables.

2. Daily Summary Report. Generates adaily summary listing for a specified
date of the hourly datatable.

3. Daily Rainfall Report. Generates a multi-column report of rainfall for every
day in the chosen date range.

4. Monthly Parameter Report. Generates a monthly diurnal variation report for a
chosen database parameter and for a chosen month.
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5.

10.

11.

12.

Monthly Wind Frequency Report. Generates a monthly wind frequency
report.

Monthly Data Recovery Report. Calculates the monthly percent of data
recovery for all database parameters.

Chill Hour Report. Generates a multi-column report of daily chill hours and
accumulated chill hoursfor every day in the chosen date range.

Chill Unit Report. Generates a multi-column report of daily chill unitsand
accumulated chill units for every day in the chosen date range.

Growing Degrees Report. Generates a multi-column report of daily growing
degree days or hours (user-specified) and accumul ated degree days (or hours)
for every day in the chosen date range.

Evapotranspiration Report. Generates a multi-column report of daily
reference or crop evapotranspiration (user-specified) and accumul ated
evapotranspiration for every day in the chosen date range.

Heating Degrees Report. Generates a multi-column report of daily heating
degree days and accumulated heating degree days for every day in the chosen
date range.

Cooling Degrees Report. Generates a multi-column report of daily cooling
degree days and accumulated cooling degree days for every day in the chosen
date range.

Each of the reportsis explained in the following sections.

4.17.2 Description of the Tool Bar

The following tool bar rests above the report when being previewed:

Show entire page

Zoom to page width

Zoom in the report

Zoom out the report

i | | Gotofirst page of the report

Go to previous page of the report

p | | Goto next page of the report
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Go to last page of the report

Print the report view to the printer. Note: Before using this button, make sure that
the printer has been properly setup. Go to the File menu and “Print Setup” option
to review the printer settings. Configuring your printer or installing its printer
driver is outside the scope of Met Manager.

Lloze I

Close the report view

4.17.3 Data Tables Report

To run the Data Tables Report, select it from the “Reports’ menu. Then pick the data
table of interest and define the start and end date and time range:

The above date range specifies one day beginning on January 5, 2002.
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An example of a Data Table Report is shown below:

Met Marager Report System Report Genersted 44772002 9:47:43 AM
Your company or westher station name
Address or location of the weather station
Other infom ation you warit in the header of reports
Data Table
Date/Tine ws Peak W3 VUL D WD TE EF Rain FH SR 3E
CET {mph) [£:234] igector) ideg) °cy {inHy) {inch) [£3] (Ww™Z) (NI /w™E)
Zm Zm Z2m Z2m Zm lm lm b4 Em Zm

01705702 01:00 a5 1.2 82 E 1z 10.0 3001 000 7.2 o 00000
01/05/02 02:00 9.4 15.3 92 E 10 10.4 z9._97 0.00 984 o 00000
01/05/0% 03:00 3.9 l4.6 89 E 15 10.23 79._95 0.00 985 o 00000
01/05/0& 04:00 11.& 2Z.8 107 ESE 1z 0.2 259.91 0.0s 93.9 a 0.oo000
01/05/0& 05:-00 14_E 21.7 112 ESE 11 A 25.84 0.0z 93._E u} 0.oo000
01/05/0& 0&5:00 8.4 19.2 1z5 SE 14 1z.0 25.85 0.0s 93.9 u} 0.oo0o00
01/05/0& 07:00 3.0 28.9 1l4 ESE Z& 13.9 z29.79 0.04 93_E u} 0.oo000
01705702 08:00 1z.0 z1.0 152 S3E z0 14.8 3.8z 0.13 9.2 Z 00083
01/05/02 09:00 5.0 lg.z 239 NNW 7L Lyl 988 036 99,3 z  0.0072
01/05/0Z 10:00 &0 13.z 350 W zg 0.0 z9._90 0.za 99,39 10 0.03&0
01/05/0& 11:00 EE 1z.1 1l& NNE 27 0.E 29.91 o.oz 93.9 5z 0.1274
01/05/0& LZ:00 4.8 11.0 Z0 NNE z8 0.9 z29.89 o.0o0 933 9z 0.23211
01/05/0& 13:00 2.1 6.4 353 N 40 11 & z25.88 o.00 93.9 z0z 0.7z83
01/05/0& 14:00 £l 9.6 210 HNW Z& 1z2.7 25.85 0.0l 96._4 243 1.2340
01705702 15:00 5.8 1z.1 z76 W z7 1z.% zZ3_85 0.00 944 8% 0.3152
01/05/02 16:00 ] 13.2 302 WNW z4 1z.5 z9._85 0.00 al.6 104  0.3735
01/05/02 17:00 55 11.4 3203 WNW z1 1z.3 z9._83 0.00 1.9 33 0.1373
01/0540& 12:00 6.5 15.0 207 NW 24 L1 29.91 0.oo0 93.E 1 0.o00z0
01/05/0& 19:00 E.6 l4.6 Z1EZ NW 24 0.7 29.96 0.0l 92.6 a 0.oo000
01/05/0& Z0:00 7.8 1.7 212 NW 24 9.5 29.99 0.0z 942 a 0.o0o000
01/05/0& Z1:00 8.9 17.1 209 NW zl 8.7 20.0z o.oo0 93.9 a 0.oo000
01/05/0Z zZ:00 ] 17.1 314 HNW 3 5.5 3003 0.o0 85,4 o o.o00o
01705702 £3:00 5.9 13.2 311 NW z4 7.5 3005 0.00 860 o 00000
01/05/0Z 24:00 4.1 8.2 235 WNW zZE 6.4 3004 0.00 9.8 o 00000
Data Table Page 1

4.17.4 Daily Summary Report

To run the Daily Summary Report, select it from the “Reports” menu. Then define the
end date and time.

The“end time” allows a 24-hourly daily report that is not midnight-to-midnight. Some
industrial facilities use this feature.
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An example of a Daily Summary Report is shown below:

Met Marager Repot System Repott Genersted 40772002 9:50:27 AW
Your company of westher station name
Adoress or location of the weather station
Other infom ation you wart in the header of reports
Daily Summary Repert - January 5, 2002
Date/Tine we Pesk WE Rt D WD TE ETP Rain SR ZE
CET (mphl {nph) izector) {deg) [aed] {inHer) finch) (£ 3] (W2 (MI/m™E)
2 m Zm 2 m 2 m Zm lm lmn Zm Zm 2w

0ly05/02 01:00 8.5 13.9 sz E 1z 0.0 30.01 o.on 7.2 o 0. 0ooo
01/0E5/0Z 0Z:00 9.4 15.3 92 E 10 10.4 29.97 o.oon 98.4 o o.oooon
0l/0E/0F 02:00 2.9 ld. & 23 E 1k 0.2 £9.39E o.on 22. & o 0. 0ooo
01705702 04:00 11.5 2Z.8 107 ESE 1z 1.3 29.391 0.0& 3.3 o 0. nooo
01/0E5/0Z 05:00 145 21.7 113 ESE 11 1.7 29.84 0.0z 99.5 o 0.ooo00
0l/05/0Z 06:00 8.4 13.2 125 BE 14 1z.0 29.85 0.0e 23,9 o 0. 0ooo
0170540z 07:00 13.0 £8.9 1ll4 ESE Z6 13.3 28.79 0.04 3.5 o 0_0ooo
01/05/0F 08:00 1.0 1.0 1EFZ B&SE Z0 14 & £9._8F 0.1z 93 7 E 0_00&3
0l/05/0Z 09:00 2.0 1l3.2 339 NHW 71 11.7 29.86 0.3 93,9 4 0.0o7z
01/0E5/0Z 10:00 6.0 13.2 250 W z8 0.0 25.390 0.Z0 99.9 10 0.03E0
01/05/0F 11:00 E & 1z.1 16 NMNE 27 0.5 #9391 o_os 933 ¥4 01874
01705402 12:00 4.5 11.0 20 NME Z5 0.3 29.89 o.on 3.3 sz 0.3311
01/0E5/0Z 12:00 2.1 6.4 353 N 40 1.5 z25.88 o.oo0 99.9 Z0Z 0.7z23
01l/0E/0F 14:00 E.1 9.6 210 Nu i3 1.7 £9.8C 0.01 Q.4 2432 1.Zz240
01705402 15:00 5.5 lz.1 z7s W 27 1z.5 29.85 o.on 54,4 88 0.315z
01/0E5/0Z 1l&:00 6.8 13.& 20Z WHW 24 12.5 29.85 o.on 91.6 104 0.3735
0l/0E/0F 17:00 EE 11l.4 202 WHW £l 1z.2 £9.828 o.on al.3 2e o.1372
01705402 18:00 6.5 15.0 307 HUO 24 11.2 29.91 o.oo 3.5 1 0.0o0zo
01705702 15:00 E.6 14.6 312 NU 24 0.7 29.9¢ 0.01 S2.6 o 0.ooo0on
0ly/05/0Z Z0:00 7.8 1.7 313 NU 24 2.5 29.99 0.0z 94,2 u} 0. 0ooo
01/0E5/0Z E1:00 8.9 17.1 309 NW 21 8.7 20.02 o.oo0 93.9 o 0.ooo0on
01/05/0F Z2:00 a9 17.1 314 MWW 23 8.5 30,02 o_on 854 a 0_nooa
0ly05/02 23:00 5.3 13.% 311 WU z4 7.5 30.05 o.on 86.0 o 0. 0ooo
01/0E5/0Z Z4:00 4.1 8.2 Z9E5 WHW =43 6.4 20.04 o.oon 85.6 o 0.oooon
Mirdmam: 3.1 6.4 1t NME in 6.4 z22.79 o.on 85. 4 o 0. 0ooo
Maximum: 3.5 28.9 353 W 71 14. 6 30.05 0.36 83.3 343 1.z340
Average: 7.8 15,3 Zzl =W 24 .9 29.92 95.9 39
Total: l.00 23883
Diaily Summ ary Report - Janusry 5, 2002 P age 1

Technical Note: The above report is generated from the hourly datatable. That’s why
you do not specify a particular datainterval.

4.17.5 Daily Rainfall Report

To run the Daily Rainfall Report, select it from the “ Reports’ menu. Then pick therain
parameter (in case you have more than one) and define the start and end dates:
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An example of an abbreviated Daily Rainfall Report is shown below:

Met Manager Report System

Report Generated 8/23/2002 7:45:26 PM

Your Company or Weather Station Name
Address or Location of the Weather Station

Other Information Y ou Want in the Header of Reports

Daily Rainfall Report

Rain
Date (in)
01/01/2002 0.00
01/02/2002 0.00
01/03/2002 0.00
01/04/2002 0.00
01/05/2002 1.00
01/06/2002 0.01
01/07/2002 0.00
01/08/2002 0.00
01/09/2002 0.00
01/10/2002 0.01
01/11/2002 0.08
01/12/2002 0.00
01/13/2002 0.00
01/14/2002 0.00
01/15/2002 0.00
01/16/2002 0.00
01/17/2002 0.00
01/18/2002 0.02
01/19/2002 0.16
01/20/2002 0.00

Date Range: January 01, 2002 to March 31, 2002

Rain

Date (in)
02/10/2002 0.00
02/11/2002 0.00
02/12/2002 0.00
02/13/2002 0. 00
02/14/2002 0.00
02/15/2002 0.00
02/16/2002 0.00
02/17/2002 0.00
02/18/2002 0.00
02/19/2002 0.09
02/20/2002 0.01
02/21/2002 0.14

2/22/2002 0.00
02/23/2002 0.00
02/24/2002 0.00
02/25/2002 0.00
02/26/2002 0.00
02/27/2002 0.00
02/28/2002 0.00
03/01/2002 0.15

Rain

Date (in})
03/22/2002 0.00
03/23/2002 0.00
03/24/2002 0.00
03/25/2002 0.19
03/26/2002 0.01
03/27/2002 0.00
03/28/2002 0.00
03/29/2002 0.00
03/30/2002 0.23
03/31/2002 0.01
Total Rain: 278

Technical Note: The above report is generated from the hourly data table.

4.17.6 Monthly Parameter Report

To run aMonthly Parameter Report, select it from the “ Reports’ menu. Then pick the
database parameter of interest and the month and year:
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An example of a Monthly Parameter Report for rain is shown below:

Met Manager Report System

Report Generated 401772002 9:57:07 AM

YOUr Company of westher station name

Ardress or location ofthe weather station

Cther infom ation you want in the header of reports

Rain {inch) - 1 meters

Monthly Parameter Report -January 2002

Hour ofthe Day

Day 1 2 3 4 m 11 12 13 14 15 16 17 18 19 20 21 22 23 24 Min Max Total
1 000 000 0 00 0,00 000 000 @00 0,00 G 00 0,00 000 000 000 0,00 0,00 000 B.00 000 @00 000 000 0,00 0,00 0. 00 0,00 0,00 0,00
i D00 0BG 0,00 0,00 @00 .00 000 080 0,00 000 0,00 @00 0,00 0,00 000 .00 000 0,00 0. 00 000 0,00 000 000 @00 0. 00 000 000
H D00 0 B0 000 0,00 @00 .00 000 000 0,00 000 0,00 @00 0,00 0,00 0. 00 .00 000 @ 00 0. 00 000 0,00 @00 000 .00 0. 00 000 000
4 000 000 0,00 0,00 B 00 000 000 0,00 0,00 000 000 0. 00 0,08 0,00 0. 00 .00 000 0. 00 0. 00 000 0,00 @00 000 .00 0. 00 000 000
5 0,00 0,00 0,00 0,06 0.0F 0,06 0.04 0.12 0.3F 0.0 0.0§ 0.00 0,00 0.01 0,00 0.00 0.00 0.00 #.0L 0.0 0.00 0.00 0.00 0,00 0,00 0,26 1.00
6 0,00 0,00 0,00 0,00 0,01 0.00 0,00 0,00 0,00 000 0.00 0.00 0,00 0,00 0,00 0.00 0,00 0.00 #.00 0.00 0.00 0.00 0.00 0.00 0,00 0,01 0,01
7 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0.00 0.00 0.00 0,00 0,00 0,00 0.00 0.00 0.00 0,00 0.00 0.00 0.00 0,00 000 0,00 0.00 0,00
i 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0.00 0.00 0.00 0,00 0.00 0,00 0.00 0.00 0.00 #.00 0.00 0,00 0.00 0,00 .00 0,00 0.00 000
] D00 0.0 0,00 0,00 B 00 .00 000 000 0,00 000 0,00 @00 0,08 0,00 0,00 .00 0,00 0,00 0,00 0,00 0,00 @00 0,00 .00 0,00 000 0. 00
L0 @00 000 0,00 0,00 #.00 000 @00 0,08 0,00 0,08 .00 0,00 0,00 0,00 0,00 000 0,01 0,00 000 0,00 0,00 0. 00 @00 6,00 @00 0,01 0,01
11 000 0,00 0.0 0.0F 000 000 .00 0,00 0,00 0,00 0,00 008 0,00 0,00 0,00 0,00 @00 0,00 @00 0,00 0,00 0,00 0,00 4,00 0,00 0.0F 0,03
L@ 000 000 .00 0,00 4. 00 000 .00 0,00 0,00 0,00 000 000 0,00 0,00 0,00 0,00 @00 0,00 @00 0,00 0,00 0,00 0,00 4. 00 0,00 0,00 0,00
12 000 000 .00 0,00 0. 00 000 .00 0,08 0,00 0,00 000 0. 00 0,00 0,00 0,00 0,00 @00 0,00 @00 0,00 0,00 0,00 0,00 4,00 0,00 0,00 0,00
14 0,00 000 0,00 0,00 0. 00 000 .00 0,00 0,00 0,00 000 0. 08 0.0 0,00 0,00 000 @00 0,00 @00 0,00 0,00 0,00 0,00 4. 00 0,00 0.00 0,00
L5 000 0,00 .00 0,00 4. 00 0. 00 @00 0,00 0,00 0,00 0,00 000 0,00 0,00 0,00 0,00 @00 0,00 @00 0,00 0,00 0,00 0,00 #.00 0,00 0,00 0,00
L6 @00 000 .00 0,00 0. 00 0. 00 .00 0,08 0,00 0,00 000 0. 00 0,00 0,00 0,00 0,00 @00 0,00 @00 0,00 0,00 0,00 0,00 4,00 0,00 0,00 0,00
L7 000 0,00 .00 0,00 #. 00 000 .00 0,00 0,00 0,00 000 0. 00 0.0 0,00 0,00 0,00 @00 0,00 @00 0,00 0,00 0,00 0,00 4,00 0,00 0,00 0,00
15 0.0 0.00 0.00 0.00 #.00 000 .00 008 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00 6,00 0. 00 @00 0.00 0.00 0.00 0.0L 4,01 0.00 0.01 0.0
19 @00 0.0L 0.00 0.00 .00 001 @.11 0.00 0.00 .08 0.01 0.00 0.00 0.00 0.00 0.00 0,00 0. 00 0. 00 0.00 0.00 0.00 0.00 #.00 0.00 0.11 0.1
0 000 000 0.00 0,00 §.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 .00 0.00 0.00 .00 0.00 0.00 6. 00 0.00 0.00 000 000 600 0.00 0.00 000
EL 000 000 0,00 0,00 B9800 000 0,00 0,00 000 000 0. 00 0. 00 0,00 000 @00 000 0,80 0. 00 000 0,00 @00 000 .00 000 000 000
EE 000 000 0,00 000 000 000 000 0. 00 0,00 000 000 0. 80 0,00 0,00 0. 00 .00 000 0 00 0. 00 000 0,00 @00 0,00 .00 0. 00 000 000
E2 000 0.1 0,00 000 000 0. 00 000 0,00 0,00 001 000 0. 00 0,00 0,00 0. 00 .00 000 0 00 0. 00 0,00 0,00 800 0,00 .00 0. 00 001 0.0¢
B4 000 000 0,00 0,00 000 0. 00 001 0.0 6,01 0.01 0,01 .00 0.0% 0,01 0. 0L @00 0,00 0 00 0. 00 0,00 0,00 000 000 .00 0. 00 0.0% 008
EE 000 000 0,00 0,00 000 000 000 0. 00 0,00 000 000 000 0,08 0,00 0. 00 .00 000 000 0. 00 .00 0,00 @00 0,00 .00 0. 00 000 000
EE 000 000 0,00 0,00 000 0. 00 000 0,00 0,00 000 000 000 mo0 B 000 000 000 o000 00 000 000 .00 000 000 0. 00 000 000
BT 000 000 0,00 000 000 000 000 0. 00 0,00 000 0,00 000 0,00 0,00 0. 00 .00 000 080 0. 00 000 0,00 @00 000 .00 0. 00 000 000
B D00 000 000 000 000 000 000 000 0,00 000 000 0,00 0 00 000 000 000 000 0,00 @00 @00 000 " ) RN TR
4 " " " m " " " n " " " " m " " " " " " " " " " "

2 " " " ) " " " n " " " " n " " " " " " " " " m "

31 " " " m " " " n " " " " n " " " " " " " " " " "

Haim: 000 0,08 000 0,00 @00 0,00 000 0,00 000 .00 000 0,00 000 0,00 000 0,00 000 0,00 6. 00 8. 00 000 0.00 0,00 400 000

Haw: 0,00 0,01 0.0 0,06 0.0& 0,06 0,11 0.12 026 0.20 0.0F 0,00 6.0 0,01 0,01 0,00 0,01 0,00 0. 0L 0.0% 0,00 0.00 0,01 4. 01 (13
Tot: 0.00 0.0F 0,02 0,18 0.040.07 0.15 0.1 0.25 0.25 @.11 0.00 0.0 @.0& 0.01 0.00 0.901 0.00 0.01 @.0& 0.00 0,900 0,01 #.01 1.41
Morthly Parameter Report - January 2002 P age 1

Technical Note: The above report is generated from the hourly datatable. Them's

denote missing data.

4.17.7 Monthly Wind Frequency Report

To run aMonthly Wind Frequency Report, select it from the “Reports” menu. Then pick
the wind speed and wind direction database parameters of interest and the month and
year. The example below uses wind speed and scalar wind direction database

parameters:
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| Technical Note: The above report is generated from the hourly data table.

4.17.8 Monthly Data Recovery Report

To run aMonthly Data Recovery Report, select it from the “Reports” menu. Then define
the month and year of interest:

An example of a Monthly Data Recovery Report is shown below:
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Technical Note: The above report is generated from the hourly data table.
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4.17.9 Chill Hour Report

To run a Chill Hour Summary Report, select it from the “Reports’ menu. Then select a
chill hour database parameter from the drop-down list, and define the date range of
interest. Units of “CH” stand for “Chill Hours.”

An example Chill Hour Summary Report is shown below:
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4.17.10 Chill Unit Report

To run a Chill Unit Summary Report, select it from the “Reports’ menu. Then select a
chill unit database parameter from the drop-down box, and define the date range of
interest. Units of “CU” stand for “Chill Units.”

An example Chill Unit Summary Report is shown below:
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4.17.11 Growing Degrees Report

To run a Growing Degrees Report (day or hour), select it from the “Reports’ menu. Then
select a growing degree day or growing degree hour database parameter from the drop-
down list, select the units, and define the date range of interest. Unitsinclude DD°C
(degree daysin °C), DD°F (degree daysin °F), DH°C (degree hoursin °C), and DH°F
(degree hoursin °F).

An example Growing Degrees Summary Report (in units of DD°F) is shown below:

Met Manager Report System Report Generated 12/9/2002 10:04:31 PM
Growing Degrees Summary Report
Growing Degree Day (86-50) (GDD{86-50))
January 01, 2000 to February 29, 2000
Method: Integration
Temperature Parameter. [3] Temperature
Base Temperature: 50 °F
Ceiling Temperature: 86 °F
Growing Cumulative Growing Cumulative
Date Degrees GD Date Degrees GD
(mmidd/yyyy) (DD°F) (DD°F) (mm/ddiyyyy) (DD°F) (DD°F)
01/01/2000 e 13.1 02/ 9.8 363.5
0 22.9 38. ( 16.5 380.0
19.9 56. 1 { 19.1 395.1
0.9 57.0 02/ 17.6 416.7
3.0 59.9 02/ 19.8 436.5
9.4 69.3 02 15.4 9
10.6 79.9 02/15/2000 20.4
9.5 89.3 02/16/2000 21.3
9.4 98.7 02/17/2000 23.0
10.1 108.8 02/18/2000 23.3
15.2 124.0 02/15/2000 8.5
21.8 145.8 02/20/2000 7.1
01/13/2000 21.0 166.8 02/21/2000 11.8
01/14/2000 7.6 174.4 02/22/2000 173
01/15/2000 11.2 185.6 02/ 18.5
01/16/2000 15.4 201.0 19.4
) C 16.3 217.2 22.1 644.
16.2 233.5 15.4 660.2
18.8 252.3 0.5 670.7
9.7 262.0 1.7 682.4
5.2 267 8.6 701.0
16.6 283.8
15.7 299.5
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4.17.12 Evapotranspiration Report

To run areference or crop Evapotranspiration Report, select it from the “Reports’ menu.
Then select a crop or reference evapotranspiration database parameter from the drop-
down list. Select units of inch or mm, and define the date range of interest.

An example Evapotranspiration Summary Report is shown below:
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4.17.13 Heating Degrees Report

To run aHeating Degrees Report, select it from the “Reports” menu. Then select a
heating degree day database parameter from the drop-down list, select the units, and
define the date range of interest. Unitsinclude DD°C (degree daysin °C), DD°F (degree
daysin °F), DH°C (degree hoursin °C), and DH°F (degree hoursin °F). Be sureto
specify DD°F or DD°C for common heating degree day units.

An example Heating Degrees Summary Report (in units of DD°F) is shown below:
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4.17.14 Cooling Degrees Report

To run a Cooling Degrees Report, select it from the “ Reports” menu. Then select a
cooling degree day database parameter from the drop-down list, select the units, and
define the date range of interest. Unitsinclude DD°C (degree daysin °C), DD°F (degree
daysin °F), DH°C (degree hoursin °C), and DH°F (degree hoursin °F). Besureto
specify DD°F or DD°C for common cooling degree day units.

An example Cooling Degrees Summary Report (in units of DD°F) is shown below:
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4.18 Window Menu
The Window menu shows various views that have been opened:

From this menu, you can cascade or tile the various views, and can easily choose an
opened view to display.

4.19 Help Menu
The Help menu currently includes the following choices:

Select “Review Software License Agreement” to review and print the agreement:

Select “About” from the Help menu to review the version of the software and the
software Licensor’s name and contact information.
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4.20 Exporting Data

Subsets of the project data tables can be exported for offline analysis or other use.
Export file types include text-based comma-separated variable (CSV), Paradox, and
dBase.

To export data, select “Export” from the File menu. The following export dialog is then
presented:

Select the datainterval of interest from the “Datainterva” list box. Met Manager will
export its data from the corresponding data table. Then select the start and end dates and
times.

If you are generating a CSV file, then check the “ Export parameter status tagsto csv file”
box to export the data values with status tags that represent valid (0), partidly valid (1),
invalid (2), calibration (3), or missing (4) status. This option appliesonly to CSV files
since parameter status tags are always exported to Paradox and dBase file types. Recall
that “partially valid” means that at least one sample was acquired for the datainterval, but
fewer than three-quarters of the possible number of samples (as defined by the sample
datarate).

Click on the “Browse” button to locate a place on your computer to save the export file:
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Y ou can also select atype of datafile to export from the “Save astype” list box. File
typesinclude CSV, Paradox, and dBase. The default file typeis*“CSV File” format.

Upon successful export, a message similar to the one below is displayed.

In the example below, an exported CSV file was imported into a Microsoft Excel
spreadsheet. The first line of the header identifies whether or not the exported file
includes the parameter statustags. The second line identifies each exported parameter’s
database tag (DB1, DB2, etc.). Thethird lineisthe“column name’ of the database
parameter. The fourth line is the measurement height (level) of the parameter above (or
below) the ground in meters. The fifth line is the exported units. These units are the
standard default ones used in the project database, and are assigned by Met Manager.
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(The above figure is an example only; your configuration may be different.)
Recall that the status tags have the following meanings:

0 =valid (at least three-fourths of the samples were acquired)
1 = partially valid (at least one, but fewer than three-fourths of the samples were

acquired)
2 =invalid
3 =calibration

4 = missing (no samples acquired)

Note: The“date” field is exported with aformat of “m/d/yyyy h:mm”. The individual
parameter fields are exported in scientific notation.

Note: In the example above, and from within the Excel spreadsheet, the header cells were
centered and the individual parameter “value” cells were centered and formatted as
“numbers’ with afixed format of 2 decimal places.

Below is an example of data that was exported without status tags:
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(The above figure is an example only; your configuration may be different.)

CAUTION: Besureto review the exported data and remove any questionable data
before using it in an analysis.

4.21 Setting up a Printer

To setup the printer (or to review its settings), select “Print Setup” from the File menu.
Then make printer configuration changes as needed.

Note: Met Manager uses a standard Windows printer interface dialog. Configuration of
| your printer is outside the scope of the Met Manager program. If you are having

| difficulty printing with your printer, contact the printer manufacturer or your printer

| supplier. You may need to update your printer driver.

4.22 Exiting the Program

To shut down Met Manager, select “Exit” from the File menu or pressthe “close
program” button in the upper right of Met Manager’ s display window. If Met Manager is
connected to a data source, then the following message is displayed:
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Pressthe Y es button if you wish to exit. Otherwise press the No button.

Note: If Met Manager was connected to a data source when shut down, then Met
Manager will automatically open its last active project folder and data source when

restarted (unless acommand line option directs Met Manager to do something else).

Refer to Appendix D on optional program startup command line options.
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5 MAINTENANCE AND CALIBRATION

5.1 Setting the Status of a Channel

To activate special maintenance functions, select the View menu, then the Instantaneous
View submenu. Then press the “Maintenance Mode” button from the I nstantaneous
View:

To set a Data Source Channel to invalid or calibrate status (or to return it to valid status),
select the channel of interest (in the left-hand column) with your mouse. Then press the
“Invalid” or “Calibrate” button. That channel, and all parameters derived from that
channel will be tagged with the new status. Thisisimportant to filter bad or questionable
data or channels undergoing a calibration, to keep that data out of the “valid” data set.

Note: When Met Manager detects that a sensor’ s value is out-of-range, then Met

Manager automatically flags the data asinvalid until the sensor is back inrange. The i
range of valid valuesis configured with the Data Source Parameters editor from the Setup
menu. See Section 3.6. ‘

5.2 Calibration

5.2.1 Overview of the Calibration Process

With Met Manager you can set the calibration coefficients of each weather sensor in the
following ways:
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1.

Two-point Method. For each of two points, enter the “as found” measurement
of a sensor channel in base units and the corresponding measurement of the
calibration standard in the same base units. Met Manager then calculates a
new calibration slope and offset for the channel. (The “as found”
measurement readings must be taken from Met Manager’ s display in “base
units”)

Corrective Slope and Offset Method. Enter in “corrective” slope and offset
values that you calculated outside of Met Manager. These slope and offset
values correct “as found” measurements in base units to values of the
calibration standard in the same base units. Met Manager then calculates a
new calibration slope and offset for the channel.

Recovery Method. Enter in a calibration slope and offset from a prior
calibration report. Thisallows you to recover the calibration of the channel if
you have to replace your hard disk, or if you relocate the Met Manager
software to another computer.

Methods 1 and 2 above are discussed in Section 5.2.2. Method 3 is discussed in Section
5.2.3. For an overview of the calibration process, see Appendix E.

5.2.2 Calibrating Sensor-based Channels

To calibrate one or more sensor-based channels, follow these steps:

1.

L ocate and review any manufacturer-supplied instructions for calibrating the
sensors of interest. Use appropriate calibration standards and ensure that the
environment will not negatively impact the calibration. For example, do not
calibrate arain gage whileit israining.

Note: ThisUser's Manual does not provide instructions for applying a
calibration standard; only for creating the calibration coefficients when the
sensor is appropriately stimulated with, or compared to a calibration standard.

Go to the Instantaneous Data view located on the View menu (see Section
5.1).

Press the “Maintenance Mode’ button from the Instantaneous View.

With your mouse, select a Data Source Channel that you wish to calibrate.
This channel islocated in the left column of the Instantaneous View. Press
the “Calibrate” button to flag the channel as being in calibration mode. This
keeps calibration data out of the “valid” data set.

Repeat step 4 for each channel that you will be calibrating. When you finish
with this step, each channel to be calibrated should have a status of
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“Calibrate”.

6. With your mouse, select the first sensor to be calibrated from the left hand
column of the Instantaneous View. Then press the “ Calculate Calibration
Coefficients’ button to show the “Calibration Calculator”:

(The above figure is an example only; your configuration may be different.)

Y ou have two methods to choose from: Two-point Method (step 7), or
Correction Slope and Offset Method (step 8).

7. Two-point Method:

a

For thefirst calibration point (see the figure above), enter the “As found”
value response from the sensor (as shown on the Instantaneous View).
[Only if you have a direct-connection ( i.e., real-time) to the data logger

may you instead press the button. Met Manager will then fill the value
in for you.]

CAUTION: The* asfound” value you enter MUST be that value that Met
Manager converted to base units after receiving it from the data logger (or
other data source). Failureto follow thisrulewill result in a faulty
calibration. You can view the “asfound” value on the |eft-hand side of
the Instantaneous View next to the “Base Unit” column. Alternatively, use
the View menu, Options item to set a column of the Data View to Base
Units. Then view the appropriate time-averaged (or totalized) “as found”
value within the Data View.
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b. Next enter the value of the calibration standard in the “Calibration
standard” field and in base units as shown near the top of the Calibration
Calculator display. Thisvalue MUST be taken over the same time period
asthe “asfound” reading.

CAUTION: Besureto enter the value of the calibration standard in the
“Calibration standard” field and in base units as shown near the top of the
Calibration Calculator display. Make sure that the value of the calibration
standard is obtained over the same time period as the “as found” reading.
Failureto follow these ruleswill result in a faulty calibration.

c. Repeat steps 7(a) and 7(b) for the second calibration point.

d. Pressthe“Apply” button to activate the new calibration for the channel.
Y ou will then get a confirmation message similar to the following:

(The above figure is an example only for illustration purposes.)

Press“Yes’ to confirm the values you entered; otherwise press “No”.
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CAUTION: If the values are not correct, then press “No”. Y ou might
think that you can press“Yes’, and then if incorrect, just go back and re-
enter the values for the two points. However, doing so will create an
invalid calibration because the new slope and offset values that were
created (when you pressed “Yes’) will now affect the new “as found”
values of the two points. Instead you will have to (a) repeat the entire
two-point calibration for the channel all over again, or (b) enter in the
recovery slope and offset fromthe prior calibration (see Section 5.2.3)
and then re-enter the two-point “ as found” and “ calibration standard”
values.

e. Remove the calibration standard and restore the sensor to its normal
operating state.

f. To select another channel to calibrate with the Two-point Method, press
the back or forward arrow in the upper right corner of the Calibration
Calculator. Then repeat step 7 inits entirety.

8. Correction Slope and Offset Method:

To use the “ Correction Slope and Offset Method”, select the “ Correction
Slope and Offset” tab near the top of the Calibration Calculator. A figure
similar to the following will then be displayed:
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a. Enter “correction” slope and offset values that you obtained somehow off-
line. These values convert “as found” readings (in base units) to match the
calibration standard (also in base units) by the following rel ationship:

Cdlibration Standard Value = (“Asfound value” x Slope) + Offset

For thefirst calibration point (see the figure above), enter the “As found”
value response from the sensor (as shown on the Instantaneous View).

CAUTION: The values you enter MUST obey the above equation and
must have been derived from “as found” and calibration standard
measurements, both in base units, where the base units are identified near
the top of the Calibration Calculator. Failureto follow thisrule will
result in afaulty calibration.

b. Pressthe“Apply” button to activate the new calibration for the channel.
Y ou will then get a confirmation message similar to the following:

(The above figure is an example only for illustration purposes.)

Press“Yes’ to confirm the values you entered; otherwise press “No”.
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CAUTION: If the values are not correct, then press “No”. Y ou might
think that you can press“Yes’, and then if incorrect, just go back and re-
enter the “ correction” slope and offset values. However, doing so will
create an invalid calibration because the new composite “calibration”
slope and offset values that were created (when you pressed “Yes") will
now affect the new “correction” values since these values are based on “as
found” measurements. Remember that the slope and offset values you
entered on the “ Correction Slope and Offset” tab are “corrective’ values;
not composite calibration values. Instead you will have to (a) repeat the
entire calibration for the channel all over again, or (b) on the “ Recovery”
tab, enter in the recovery slope and offset from the prior calibration (see
Section 5.2.3) and then on the “ Correction Sope and Offset” tab, re-enter
the “ correction” slope and offset values.

c. Remove the calibration standard and restore the sensor to its normal
operating state.

d. To select another channel to calibrate with the Correction Slope and Offset
Method, press the back or forward arrow in the upper right corner of the
Calibration Calculator. Then repeat step 8 in its entirety.

9. Restore Channel to Normal Operating M ode:

If you have a direct connection (real-time) to the data logger, then review
current data values reported by Met Manager for the channel just calibrated.
Ensure that the reported values are representative of the sensor measurements
and reflect the new calibration coefficients. For example, let’ s suppose that
you just calibrated the ambient temperature sensor at two points, and in
degrees Fahrenheit. Y ou know that the outside temperature is about 70 to 75
°F, yet the sensor, following calibration, is reporting 157 °F. Something is
wrong. During calibration, you may have entered the standard valuesin °C
instead of °F. Or perhaps the sensor was not properly restored to its normal
operating state.

If you periodically capture the data from the data logger, wait until the logger
has logged some datain its internal memory. Then instruct Met Manager to
capture the data in the usual way. Review the captured datato ensure that the
reported values are representative of the sensor measurements and reflect the
new calibration coefficients. If not, then your calibration may have been in
error.

10. Once you are sure that the calibration was completed successfully, take the
sensor channel out of calibration mode. With the sensor channel selected,
click on the“Calibrate’ button so that it is no longer depressed. The status of
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the sensor should return to “valid.” Verify that it does.
11. Repeat steps 9 and 10 for each channel that you calibrated.

12. Generate a Calibration Summary Report:

To review and print a Calibration Summary Report, select “ Calibration
Report” from the Setup menu:

An example Calibration Summary Report is shown below:

(The above figure is an example only for illustration purposes.)

This report documents the new calibration slope and offset coefficients and
date of calibration. Also, if you ever have to recover the coefficients because
of acomputer failure, you will need thisreport. Otherwise you may have to
repeat the calibration.
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5.2.3 Recovering Calibration Coefficients

Y ou may need to recover Met Manager’ s calibration coefficients because of a computer
hardware failure or other reason. To do so, first locate a hardcopy printout of the
Calibration Summary Report for the prior calibration. Second, review the Data Source
Parameters from the “ Setup” menu to ensure that the base unit conversion slope and
offsets values are correct and that the “base unit” is the same as printed on the prior
calibration report. Third, go to the Calibration Calculator by pressing the “Maintenance’
button on the Instantaneous Data View (of the “View” menu). Finaly, enter the
calibration slope and offset values from the prior Calibration Summary Report into the
“Recovery Method” tab of the Calibration Calculator:

After you enter the values, pressthe “Apply” button. A confirmation screen similar to
the following will then appear:

(The above figure is an example only for illustration purposes.)
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If the values are correct then press“Yes’. Otherwise press“No” and re-enter the values.

5.3 Activating a Debug Log

Sometimesit is useful to capture the raw data records that are being received by Met
Manager from a direct-connect type of datalogger. To capture the received datato atext
file, follow these steps:

1. Connect to the direct-connect data source. An active connection must be
made prior to turning on the debug log. Thus the data source must be of the
type “direct connect”.

2. Select “Debug Log” from the Setup menu to turn it on:

3. Specify the path and name of the log file that will hold the raw data. Y ou can
specify any filename you wish. The default name is “datacomm.log” and is
located on the project path. For example:

(The above figure is an example only; your configuration may be different.)

If you do not wish to use the default project path name (c:\weather data’ in
this example), then you will have to create the path folder (and subfoldersif
any) with Microsoft Windows File Explorer (or similar software) prior to
enabling the debug log function. Y ou can also specify afile name other than
“datacomm.log” and Met Manager will create it.
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The debug log is a date/time stamped text file that contains records received by Met
Manager from the data source. These records are the raw data from the data source and
do not reflect Met Manager’ s application of calibration coefficients or unit conversions.
To seeif thelog is enabled, go to the Setup menu. If acheck mark isin front of the
“Debug Log” submenu selection, then it is enabled. To disable the log simply select the
“Debug Log” menu item again. Closing the connection will aso disable the debug log.

Y ou can review the contents of the debug file with atext editor program such as
Microsoft’s Notepad. However, if thefileislarge, then you may have to use aword
processor or other program to review it.

CAUTION: The size of the debug log text file can grow very large and very fast
depending on the frequency of raw data received from the data source. For example, if
dataisreceived by Met Manager every second, then anew dataline is added to the
“debug log” file every second. Be sure to turn off (disable) the “ debug log” feature if
you no longer need it.

Note: If you close down and then restart Met Manager, you will need to re-enable the
debug log capability asits active state is not maintained by Met Manager.

5.4 Packing the Project Database

The project database must be periodically packed so that deleted records are permanently
removed from the database. For instance, if a 1-minute tableis "wrapped" at seven (7)
days, the records deleted from the table by the wrap function still remain in the database
file even though they are not visible to the application. Even when awrap is used, the
wrap function does not reduce the actual size of thefile. To reduce thefile size and
permanently remove the deleted records, the database must be periodically packed.

Below is arecommended pack schedule; use the minimum pack schedule (maximum
frequency) that applies to your particular data table configuration.
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Data Table Interval

(with “ Delete data older Pack Schedule

than” option set)

1 Minute Data Table Every 1 month

5 Minute Data Table Every 3 months

10 Minute Data Table Every 6 months

15 Minute Data Table Every 6 months

20 Minute Data Table Every 6 months

30 Minute Data Table Every 6 months
Hourly Data Table Once ayear

Note: You do not have to pack data tables that are setup with the “Keep data indefinitely”
option (since these data tables are not wrapped). See Section 3.8.

Note: When a pack is performed, all the data tables within the project database are
packed. That’swhy the pack schedule should be the minimum period (maximum
frequency) of the data tables assigned to the project.

IMPORTANT: Before packing, insure that there are no active connections (other than
Met Manager) to the database. Thisincludes connections by Met Viewer, Met Mirror, or
any other import/export/reporting software that is attached to the database.

For Met Manager, close the data source connection by selecting “Close connection” from
the Setup menu. See the figure below. This then enables (ungrays) the “ Pack Database’
menu item. For all other programs that may have a connection to the database, stop and
close them to remove their connection to the project database.

To pack the database and permanently remove any deleted data records, select the “ Pack
Database” menu item from the Setup menu:
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The following dialog is then displayed:

Press*“Yes’ to begin the pack operation or “No” to not continue.

Note: The pack operation can take awhile, in some cases 20 to 30 minutes (or longer)
depending on the number and size of the data tables.

The pack operation can fail for the following reasons:

e Thereisdtill an active connection to the project database (i.e., aMet Viewer or
Met Mirror may still be running). The database cannot be packed when an active
database connection exists.

e Afileerror occurs. If afile error occurswhile attempting to pack the database,
the pack operation will fail.

IMPORTANT: To pack amirrored database, use the Met Database Utility. See
Appendix C. Following the pack operation, restart Met Mirror.

5.5 Restructuring the Project Database

The project database must be restructured when changes are made to the database
parameters. If the database parameters are changed, for example adding or removing
acquired or derived parameters, the database must be modified to reflect the added or
removed fields.

IMPORTANT: Restructuring is normally performed automatically by Met Manager
when the database parameters are changed. Use the Restructure Database menu option
only if the normal restructure operation did not complete for some reason.
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IMPORTANT: Before restructuring, insure that there are no active connections (other
than Met Manager) to the database. This includes connections by Met Viewer, Met
Mirror, or any other import/export/reporting software.

For Met Manager, close the data source connection by selecting “Close connection” from
the Setup menu. This then enables (ungrays) the “Restructure Database” menu item. For
all other programs that may have a connection to the database, stop and close themto
remove their connection to the project database.

CAUTION: Before restructuring, be sure that you have a good backup copy of the
database.

To restructure the database, select the “ Restructure Database” menu item from the Setup
menu:

The following dialog is then displayed:

Press“Yes’ to begin the restructure operation or “No” to not continue.
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Note: The restructure operation can take awhile, in some cases 20 to 30 minutes (or
longer) depending on the number and size of the data tables.

The restructure operation can fail for the following reasons:

e Thereisill an active connection to the project database (i.e., aMet Viewer or
Met Mirror may still be running). The database cannot be restructured when an
active database connection exists.

e Afileerror occurs. If afileerror occurs while attempting to restructure the
database, the restructure will fail. This could cause loss of data. (That’swhy its
important to backup the project database before adding or removing parameters.)

IMPORTANT: To restructure amirrored database, use the Met Database Utility. See
Appendix C. Following the restructure operation, restart Met Mirror.
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6 TROUBLESHOOTING

6.1 Technical Requirements Related to Microsoft Windows

Met Manager uses the Microsoft Windows registry to retain information about how it
was last shut down (last open project, last active data source, and activity status of the
data source). Thus, Met Manager must be installed with read/write/create permission to
the registry.

Met Manager stores its acquired and derived datain a project database. Thusthe
Microsoft Windows log-on profile (if any) that executes Met Manager must have
read/write/create permission to the project database.

Met Manager must be closed (shut down) when changing to anew user. For proper
operation of Met Manager, do not use the fast switching capabilities of the Windows
2000 and XP operating systems.

6.2 Standard Time and Daylight Saving Time

When Met Manager is directly and continuously connected to the data logger, Met
Manager acquires the sensory data from the datalogger and assigns the Met Manager-
hosted computer-based date/time stamp to the data. Met Manager reads Microsoft
Windows' settings to determine if daylight saving timeis active, and if so, ensures that
the time tag is assigned to the database parametersin local “standard” time. Therefore it
isimportant that the date, time, daylight saving time flag, and time zone be properly set
and maintained in Windows on the Met Manager-hosted computer. During daylight
saving time, the local standard time assigned to the data stream should be exactly one
hour before the local daylight saving time reported by Windows. When daylight saving
time is not active, then the time assigned to the data stream should be the same time as
local time (i.e., local time equals standard time).

When Met Manager captures datafrom the internal 1og of the data logger (perhaps by

dial or cellular modem), then the data logger assigns its own date and time to the
individual records of thedatalog. Thus, the datalogger time must be set to local
standard time. During daylight saving time, the datalogger time will therefore be exactly
one hour before local daylight time. When daylight saving time is not active, then the
datalogger’s standard time should be the same as local time.

Met Manager records each data record within the project database in local standard time.
Currently Met Manager also displays and reports all its datain local standard time.
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IMPORTANT: Windows handles daylight saving time differently on Windows
95/98/M E computers than on NT/2000/X P computers. On Win NT/2000/X P computers,
when daylight saving timeis currently in effect and the “ Adjust for daylight saving time”
flag on the clock settings is manually disabled (unchecked), then Windows automatically
sets your PC clock time back an hour to truly put your computer back in standard time.
However, on Win 95/98/ME computers, Windows does not change the clock time. The
time has to be manually set back an hour. It isimportant to know these distinctionsin
order to ensure that synchronization of a datalogger’stime to the PC clock timeis done
inlocal standard time. Always capture some data from the data logger after its clock
time has been changed (or synchronized to the PC clock) to ensure that the datalogger’s
time baseis set to local standard time.

In summary, the PC computer’ s date, time, time zone, and daylight saving time setting
must be properly set and maintained in local time. When Met Manager is directly and
continuously connected to the data logger, Met Manager uses thisinformation to derive
“standard” time to be assigned to the individual records of the database. Met Manager
also uses thisinformation for time stamping events within its event logs, and for tagging
the date and time of reports.

When the datalogger is used to log its data into internal memory for later capture by Met
Manager, the data logger’ s date and time must be properly set and maintained in local
“standard” time. Each record of the datalog is time stamped in standard time.

Following these rules will ensure a high level of data continuity within Met Manager’s
database.

6.3 Networking

The project database created and managed by Met Manager (or Met Mirror) allows
multiple, smultaneous users. The Paradox database manager tracks the project database
users with the use of three Paradox files: PDOXUSRS.NET, PDOXUSERS.LCK, and
PARADOX.LCK. If Met Viewer, Met Manager, or Met Mirror loose their connection to
the project database because of a power loss or other network glitch, or someone aborts
Met Manager or Met Viewer instead of properly shutting them down, then the lock
(.LCK) files may not be properly updated. Met Manager or Met Viewer will report a
message “ Directory is controlled by other .NET file.” This can result in the database
being perpetually marked for exclusive access to only one program. The solutionisto
close (shutdown) al active Met Manager, Met Mirror, and Met Viewer programs that
have access to the affected project database, and then delete the two “.LCK” files from
the project (or mirrored project) database. CAUTION: It isarecipefor disaster if you
delete thelock fileswhile an application is updating the database tables.

Paradox allows 300 users to be attached to one PDOXUSRS.NET file. The Borland
Database Engine (BDE) allows 48 users. However, because of the way that Met Viewer
interacts with the database, there is usually only one or two users assigned to agiven
BDE on aworkstation.
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6.4 Frequently Asked Questions

6.4.1 Definitions

1.

What isa*“project”? Met Manager stores its database and related files within a folder
on the computer’ s hard disk or on a network file server. The project issimply the
name of the folder. The name is assigned when Met Manager creates a new project
(File menu, New Project).

What isa“project database”? Thisis acombination of files that make up the data
tables and index files maintained by Met Manager.

What isadatatable? A datatable consists of five files that contain information
related to a particular datainterval. These files contain the date and time stamp,
database parameters, and indexing information associated with that datainterval
within the overall project database. (A database usually contains several datatables;
each related to a different datainterval.)

Why do you call the data logger a“data source”? Depending on capabilities
supported by the vendor of your weather station, Met Manager is capable of acquiring
data from more than one source: datalogger, datalogger file image, and comma-
separated variable (CSV) file. That’swhy the more generic term “data source” is
used instead of “data logger”.

Why do you call adatalogger’s output channel a*data source parameter”? Perhaps
we could have called it a*“datalogger parameter”, but then if the data came from an
import file we would have had to call it a*“datafile parameter”. A more generic
description is “data source parameter” which describes the source of the data, whether
adatalogger, datafile, or other source.

What is the difference between a “data source” parameter and a “ database”
parameter? A “data source” parameter is one that comes from the source of the data,
typically adatalogger. A “database” parameter is one that the user wants to be stored
within the project database. A database parameter may be an acquired data source
parameter or a derived parameter.

6.4.2 Data Logger

7.

How do | assign anew sensor to my datalogger? Review manuals or other
documentation that came with your weather station or datalogger to determine how
best to connect the new sensor to the data logger and to define the location of the new
data associated with that sensor within the output data stream of the data logger.

| have been acquiring data from the data logger at a 5-second data rate but want to
changeit to a 1-second rate. What is required?

a. Review vendor-supplied documentation or contact your weather station vendor
to make sure that your data logger is capable of supporting the higher data
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output rate.

b. Verify that your sensors do not limit the output rate to its present 5-second limit.
For example, some wind speed sensors provide only one or two pulses per
revolution of the cup. To be able to resolve low wind speeds, the data logger
must count these pulses over atime period longer than one second.

c. If stepsaand b are limiting, then you cannot increase the datarate. If not
[imiting, then proceed to step d.

d. Program the datalogger with afaster output rate. Consult your datalogger
documentation or contact the vendor of your weather station.

e. Within Met Manager, change the “ sample rate” property of the data source to
match the datalogger output data rate (go to the Setup menu, Data Sources, then
select the appropriate data source and press the “ Properties’ button.)
IMPORTANT: These rates must match.

6.4.3 Data Source

0.

10.

11.

12.

How do | assign my datalogger to Met Manager? Y ou must create a “ data source”
within Met Manager. The data source corresponds to not only your data logger, but
how Met Manager will be using your datalogger. For example, Met Manager may be
directly connected to the datalogger and may continuously get data from the data
logger. Inthat case, specify a“Direct Connect” data source. Or Met Manager may
be directly-connected but will only periodically capture data from the logger. Specify
a“DataLog Capture (COM Port)” data source. Or Met Manager may capture data
from the logger by dial-out modem connection. Specify a*“Data Log Capture
(Modem)” data source. Go to the Setup menu, then Data Sources. |If the data source
isnot already created, then press the New button and select the appropriate data
source from the list. Then press the Properties button to review and edit the data
source’ s configuration settings.

Why can | have only one data source active in my project even though | have created
more than one? The data source parameters define the order and makeup (data types)
of the data stream that flows between the data source and Met Manager. Currently
Met Manager allows only one unique mapping of the data source parametersto the
database parameters; thus only one data source can be active.

Why isthe data source list blank when | try to connect to the data source from the
Setup menu? Y ou have not yet created a*“ data source”. Go to the Setup menu, then
Data Sources, and press the New button. Select a data source from the list to create a
new one. Then select theicon for that source and press the Properties button to
configure its settings.

| renamed my data source. Why does Met Manager no longer begin logging the data
at startup? Apparently you are using command line options (see Appendix D) when
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starting up Met Manager to force Met Manager to open a project and activate a data
source. If you renamed the data source, then you must use the new name in the
command line option; otherwise Met Manager cannot find the new source when
starting up.

6.4.4 Project

13. How can other personnel have access to the project database? Met Viewer™ isa
software product that is very similar to Met Manager. Met Viewer alows other
network users to have access to the project database. In a peer-to-peer or file server
network, Met Viewer attaches to the project database maintained by Met Manager, or
to areplicated database maintained by Met Mirror. With Met Viewer, you can recall,
view, graph, indicate, report, and export the datain a variety of ways, and in the same
way as Met Manager. The Met Viewer software product is purchased separately from
Met Manager. Met Viewer licenses are availablefor 1, 5, 10, 20, 50 and unlimited
number of users (at one physical site location).

14. Can | create anew project from an existing project? Yes, see Section 3.3. The
existing project configuration settings are copied over to the new project but the
database is not copied.

15. | want to duplicate the project database. How do | doit? There are at least three
ways as explained below, depending on your reason for duplicating the project
database; (a) use Met Mirror to create a duplicate copy, (b) create a copy with
Windows File Explorer, or (c) use backup software to duplicate the project database.

a. If you want to create an on-going copy that staysin sync with the master
database, then setup and activate Met Mirror. See Appendix B.

b. If you just want to create a static copy, then first stop Met Manager. Met
Manager must be stopped so that new data will not be written to the file while
the copy processis occurring. (Otherwise the database index files can get out of
synchronization with the rest of the database.) Second, use Windows File
Explorer to make a copy of the project folder. Finally, restart Met Manager.

c. Use backup software to backup the project folder on aregular basis.

6.4.5 Site Settings

16. Met Manager isinstalled on a Windows NT workstation. Why is the “time zone” list
box blank when | click onit? Check with your network administration to ensure that
proper user profile permissions have been installed to allow the Met Manager
program to access certain Windows information.

6.4.6 Data Tables

17. 1 have been acquiring 15-minute and hourly data for some time within my project
database. Can | add a new 5-minute data table? Y es, go to the Setup menu, then
Data Tables. Simply check (enable) the 5-minute data table and specify the wrap
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interval. See Section 3.8. Wait afew minutes for Met Manager to create the first 5-
minute database record. Then close the Data View and reopen it. Y ou should now
see anew “5-minute’ tab on the Data View display.

18. | have decided that | no longer need a data table. How do stop adding datato it? Go
to the Setup menu, then Data Tables. Uncheck the data table that you no longer want.
Met Manager will then stop adding data to that data table.

19. | have decided that | no longer need a data table, and | want to get rid of it entirely.
How do | remove it from the project database? First, uncheck (disable) the datatable
you no longer want from the Data Tables dialog (Setup menu, then Data Tables).
Second, stop Met Manager (and Met Mirror if active). Third, make a backup copy of
the project folder to protect against accidental file deletions (and in case you later
decide you really need the data). Fourth, with Windows File Explorer, locate the
“project” folder. Within that folder will be several files with names beginning with
DATTBL (or dattbl). Each file name ends with the data table interval and afile
extension. For example, a 1-minute data table has the following five files associated
with it: dattbl1.db, dattbl1.px, dattbl1.val, dattbl1.xg0, and dattbl1.yg0. Other data
tables (intervals) have similar file names. Delete all five filesfor the particular type
of datainterval (datatable) of interest from the project folder. Finally, restart Met
Manager. Review the Data View and verify that the tab is no longer shown for the
datatable (datainterval) you just deleted.

6.4.7 Data Source Parameters and Database Parameters

20. Why should | backup my project folder before adding or deleting data source or
database parameters? Adding or deleting data source or database parameters can
cause a major reconfiguration of the database and configuration settings files within
Met Manager. Deleting a database parameter will remove it from the database.
Backing up allows you to restore your dataif something goeswrong. That backup
will aso prove invaluable when you later realize that you need to run a historical
report on a parameter that you deleted. Thusit isimportant to not only periodically
backup the database but to backup the entire project folder. (Backing up the project
folder also backs up the database.)

21. | havejust installed my new weather station. | have created a new project from an
existing project using a project template from the installation CD. But | want to
remove some of the data source parameters and database parameters and add others.
How do | accomplish this? First, make sure that the connection to the active data
source is closed (Setup menu, Close connection). Next carefully review the guideline
in Section 3.6 for adding or deleting data source and database parameters. Then
remove data source and database parameters you no longer want by selecting them
one-at-a-time from their respective lists (see Sections 3.6 and 3.7), and pressing the
“delete” key. Y ou may also need to rearrange the data source parameters to match
their order within the received data stream. Next, add any new data source
parameters and finally add any new database parameters. Realize that deleting data
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22.

23.

24,

25.

source and database parameters may require reconfiguration of trend charts, the Data
View columns, report columns, wind rose, and indicators.

| want to add a new data source parameter because | added a new sensor to my data
logger. But why isit that when | go to the Setup menu, Data Source Parameters
Editor dialog, | don’'t see any datatypes? Y ou must close the connection to the data
source (Setup menu, Close connection).

| have added a new sensor to my datalogger. How do | make Met Manager aware of
anew sensor? First, close the connection to the active data source (Setup menu,
Close connection). Next carefully review the guideline in Section 3.6 for adding or
deleting data source and database parameters. Add a new data source parameter
(Setup menu, Data Source Parameters) by dragging and dropping a data type
corresponding to that sensor to a channel number of the Data Source Parameter List.
The channel number identifies the ordering of the data value within the output stream
of the data logger (which is also the input stream to Met Manager). Edit the
properties of the new data source parameter. Then create a new database parameter
by dragging and dropping the newly created parameter from the “ Acquired
Parameters’ tab of the Database Parameters Editor (Setup menu, Database
Parameters) to the Database Parameters List (see Section 3.7). Edit the properties of
the new database parameter including defining a representative (and unambiguous)
column heading name. Y ou may also wish to create additional derived database
parameters (e.g., minimums, maximums, etc.) that depend on the new data source
parameter.

How do | add a new database parameter to Met Manager? We assume that you have
not added a new sensor, and thus do not need to add a new data source parameter.
(Otherwise see the next question below). Y ou just need to add a new database
parameter. First, close the connection to the active data source (Setup menu, Close
connection). Next carefully review the guideline in Section 3.6 for adding or deleting
data source and database parameters. Then create a new database parameter by
dragging and dropping a parameter from one of the tabs of the Database Parameters
Editor (Setup menu, Database Parameters) to the Database Parameters List (see
Section 3.7). Edit the properties of the new database parameter including defining a
representative (and unambiguous) column heading name.

How do | remove a sensor from Met Manager? First, make sure that the connection
to the active data source is closed (Setup menu, Close connection). Next carefully
review the guideline in Section 3.6 for adding or deleting data source and database
parameters. Then remove the data source parameter associated with the sensor (see
Sections 3.6) by selecting the data source parameter (in the Data Source Parameter
List of the Data Source Parameter Editor dialog), and pressing the “delete” key. You
may also need to rearrange the data source parameters to match their order within the
received data stream. Finally, delete any dependent database parameters (see Section
3.7) associated with the deleted data source parameter and reconfigure or remove
trend charts and indicators.
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26.

27.

How do | remove (delete) a database parameter from the project database? First,
make sure that the connection to the active data source is closed (Setup menu, Close
connection). Next carefully review the guideline in Section 3.6 for adding or deleting
data source and database parameters. Then remove the database parameter (see
Sections 3.7) by selecting it from the Database Parameter List of the Database
Parameter Editor dialog), and pressing the “delete” key. Finally, delete or
reconfigure any dependent database parameters associated with the deleted database
parameter and reconfigure or remove trend charts and indicators.

Why do | have ared “x” on one of my database parameters in the Database
Parameters editor? One or more of the “Parameter Reference” properties of the
database parameter is not defined or isimproperly assigned. This can happen
accidentally (user error) when setting up a new database parameter, or may happen
with a data source parameter is removed, and the database parameter depends on that
data source parameter.

6.4.8 Data View

28.

29.

30.

31

How do columns of the Data View (also report listings) get named? The column
names come from the “ Column heading” property of the database parameter. See
Section 3.7 for configuring this property.

| see a parameter shown as “New Parameter” in the View menu, Options, then Data
Columns tab (also Report Columns tab). What is causing this? The “ Column
heading” name of the database parameter is blank. See Section 3.7 for configuring
this property.

Why are some of the columnsin the Data View missing their names? The “ Column
heading” names of the affected database parameters have not been defined. See
Section 3.7.

| occasionally get “p” characters following data columns in the Data View. What is
causing this? The“p” denotes that the datais“partially valid”. This occurs when at
least one, but less than three-fourths of the samples were acquired for adata interval.
This may be due to a power outage in which samples were not acquired from the data
source, or to a communication problem of some kind. Y ou may wish to go to the
View menu, then Event Logs, to review any detected communication faults.

6.4.9 Trend Charts

32.

| have a dual-axis trend chart. Why do the grid lines not overlay each other? If you
wish to auto-scale the chart, then review the “Use automatic scaling” property of both
the left and right axis. Make surethat it’s checked (enabled) for both axes. If you
wish to use afixed scale, then make sure that the number of major steps (intervals) is
the same for both axes. Also see Section 4.8.
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33. Why isn’'t atrace on my trend chart showing up? Review the “Data Traces’ tab of
the chart’strend settings. Ensure that the trace’ s check box is enabled (checked).

34. | have adual-axistrend chart. Why istheright axis and all of its assigned traces
missing? Review the “Axis Settings’ tab of the chart’s trend settings. Select the
“Right y axis’ property and make sure that the “ Show Y axis’ box is checked. This
will re-enable that axis and al of its assigned traces.

6.4.10 Indicators

35. Why are indicators reset when | startup Met Manager? Currently Met Manager does
not refresh itsindicators from the project database at startup. Thiswill be taken care
of in afuture upgrade.

36. Why are indicators showing red and do not seem to be updating? Met Manager has
lost communi cations with the data source (typically a datalogger). Check the
physical connection between the data logger and the serial communications port of
the computer that is running Met Manager. If necessary, close the connectionif itis
active (Setup menu, then Close connection). Then run the Windows Hyperterminal
program and seeif you can reestablish a connection outside of Met Manager. Follow
vendor-supplied instructions.

6.4.11 Wind Rose

37. | have amonthly wind rose, but it is shifted off afew days and does not begin at the
start of the month. Can | get a monthly wind rose that starts the first hour of the
month and ends the last hour of the month? Y es, on the Wind Rose display, pressthe
center “ Auto-snap” data navigator button on the tool bar. Thiswill snap the month to
its beginning. (This technique aso worksfor daily wind roses).

38. | have three wind direction database parameters; scalar wind direction, resultant
vector wind direction, and unit vector wind direction. Which one should | use with
my wind rose and wind frequency report? Since the wind rose and wind frequency
report are based on the frequency content of the wind speed by the direction from
which the wind blows, it is best to use scalar wind speed (normally just called wind
speed) and scalar wind direction. Unlike resultant vector wind direction, the scalar
wind direction measurement is independent of scalar wind speed.

6.4.12 Reports

39. How do | change the units on the daily rainfall report from inch to millimeter (mm)?
Go to the View Menu, then Options. Select the “Report Columns” tab. Then select
the rainfall parameter and change its unitsto “mm”.

40. Why are some of the columns in the Daily Summary Report missing their names?
The * Column heading” names of the affected database parameters have not been
defined. See Section 3.7.
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41. Why are negative temperature values not displaying on the Monthly Parameter
Report? Each valuefield of the report can only print a certain number of digits. Go
to the View Menu, then Options. Select the “Report Columns” tab. Then decrease
the number of digits shown to the right of the decimal place (Display Digits).

6.4.13 Wind Speed and Wind Direction Parameters

42. Why is the wind direction trace going to O degrees? Met Manager has detected that
the wind is calm based on measurement of wind speed below the calm threshol d.
This property is defined in the wind speed data source parameter’s properties.  When
calm wind is detected, Met Manager sets the wind direction to O degrees.

43. 1sn’t 0 degrees the same thing as 360 degrees as far as wind direction is concerned?
In some systems there may be no distinction; however, Met Manager uses O degrees
to denote a calm wind direction (i.e., there is no wind direction) and 360 degrees to
denote that the wind is from the “north”.

44. The wind speed sensor hasfailed and is reading below the calm threshold setting.
Thisis also causing wind direction to read calm. How can | disable the wind speed
sensor until | get it repaired, and in the meantime retain the wind direction reading?
Set the status of the wind speed sensor to “invalid”. Go to the View menu,
Instantaneous Data, and press the Maintenance button. Then select the wind speed
data source channel from the left column followed by pressing the Invalid button.
Met Manager will now ignore the wind speed reading. No calm winds will be
detected until the wind speed sensor is repaired and return to normal “valid” mode.

45. Wind direction goes to O degrees when the wind speed iscam. This may be fine for
some applications but | want to retain the wind direction reading all the time, even
during calm winds. Can | do this? Go to the Setup menu, Data Source parameters.
Set the “ calm threshold” property of the wind speed data source parameter to zero
(0.0). Since the wind speed can never be |ess than the threshold of 0.0, a calm will
never be detected. (But acam isindicated in the data for each wind speed of 0.0.)
This decouples the wind direction data source parameter (and dependent database
parameters) from the wind speed data source parameter.

46. There are multiple types of wind speed and wind direction parameters within the
Database Parameter Editor’s“Wind” tab. Which ones should | use? Horizontal wind
speed database parameters include scalar wind speed and resultant wind speed.
Horizontal wind direction database parameters include scalar wind direction, resultant
vector wind direction, and unit vector wind direction. Additional related parameters
include the standard deviation of wind speed and Sigma-Theta which is the standard
deviation of wind direction. USEPA or other state or local governmental
requirements may require specific parameters depending on your application. For
atmospheric modeling and industrial uses, it is recommended that you log all the
horizontal wind parameters to the database. That way, the datawill be available
should it be needed later. For general agriculture purposes, it is recommended that
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you retain scalar wind speed, standard deviation of wind speed, scalar wind direction,
and Sigma-Theta.

47. 1 can't find * peak wind speed” in the “Wind” tab of the Database Parameter Editor.
How do | set it up? Peak wind speed is actualy “maximum” wind speed. Drag and
drop a“Maximum” database parameter type (go to Setup menu, then Database
Parameters; select the “Other” tab of the Database Parameters Editor) to the Database
Parameter List. Then edit the properties of this new “Maximum” database parameter.
Rename it to “Peak Wind Speed”. Assign it a“Column heading” name of “Peak WS’
(or some other unambiguous descriptor). Set its units and display decimal digitsto
your preference. Assign to its*Parameter References’ property the corresponding
channel-based “wind speed” database parameter.

6.4.14 Communications

48. How can | tell if 1 have intermittent communication problems with my continuously-
connected datalogger? You will receive “p” (partially valid) or “m” (missing) codes
following the data columnsin the Data View. Also go to the View menu, then Event
Logsto review any detected communication faults.

6.4.15 Miscellaneous

49. How are “base units’ different from other engineering units? Base unitsarejust an
initial set of engineering units. When the data source parameter arrivesin the data
stream already in engineering units, then the base unit is usually set to be the same as
the implied engineering unit of the arriving data channel by setting the conversion
slope and offset propertiesto 1 and O respectively. However, when the data source
parameter arrives as adigital voltage or count value, then the conversion slope and
offset values are used to convert the digital voltage or count into an initial engineering
unit; that unit being called the “base unit”.

50. | seean “x” following one or more columns of data on the Data View. |t appears that
Met Manager is somehow invalidating my data. What is happening?

a.  On each new input of sensor datainto Met Manager (via a data source parameter
obtained from the data stream), Met Manager compares the data (in base units)
to an acceptance range. If within the range, the datais valid. If outside the
range, Met Manager invalidates the data and any database parameters derived
from that data. Either the sensor has malfunctioned, the range is too narrow or
incorrect, or there is some other cause. Y ou may wish to review the data source
parameter’ s properties (Setup Menu, Data Source Parameters).

b. Go to the Instantaneous View (View menu, Instantaneous data) and press the
Maintenance button. Then select the channel and verify that the channel has not
been placed into an “invalid” state. If so, then takeit out of the “invalid” state
(see Section 5.1). If it continues to show as invalid then the received data source
value (in base units) is not within the acceptance range defined for the data
source parameter (see Section 3.6).
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51. Met Manager has a direct and continuous connection to the weather station.
However, Met Manager seemsto start slower and won't generate one of my data
tables. What’swrong? Itisvery likely that a power outage occurred or that someone
shut off the computer without properly shutting down Met Manager. If Met Manager
happened to be writing data to its database when this occurred, then one or more of
the data tables of the database likely got corrupted. Y ou will have to restore the files
of the affected data table from a mirrored or backup copy (if you are lucky enough to
have set one up), or delete them if you have no mirrored copy or backup:

a. Run Met Manager. Go to the Instantaneous View and ensure that you are
properly acquiring data from the datalogger. If not, then correct the
communication problem before you continue.

b. With good communications established with the data logger, go to the Data
View. Determine which datatable is not updating. Thiswill be the corrupted
one. (There may be more than one; if so, this procedure applies to each).

c. STOPMET MANAGER AND ALL APPLICATIONSTHAT MAY BE
ACCESSING THE PROJECT DATABASE. Thisincludes Met Mirror and any
Met Viewer users.

d. With Windows File Explorer, make a backup copy of the entire project folder.
This step protects against deletions that you could accidentally make in the steps
below.

e. If you have amirrored or backup copy of the database, then with Windows File
Explorer, go to the mirrored (or backed-up) project folder. Within that folder
will be severa files with names beginning with DATTBL (or datthl). Each file
name ends with the data table interval and afile extension. For example, a 1-
minute data table has the following five files associated with it: dattbl 1.db,
dattbl 1.px, dattbl1.val, dattbl1.xg0, and dattbl1.yg0. Other dataintervals have
similar file names. Copy all fivefilesfor the particular type of datainterval
(datatable) of interest from the mirrored project folder to the project folder that
ismaintained by Met Manager. Go to step g (skip step f).

f. If you do not have amirrored or backup copy of the database, then you have to
delete the files associated with the corrupted data table. With Windows File
Explorer, go to the project folder. Within that folder will be several files with
names beginning with DATTBL (or dattbl). Each file name ends with the data
table interval and afile extension. For example, a 1-minute data table has the
following five files associated with it: dattbl1.db, dattbl1.px, dattbl1.val,
dattbl 1.xg0, and dattbl1.yg0. Other dataintervals have similar file names.
Delete dl fivefilesfor the particular type of datainterval (datatable) of interest
from the project folder.
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52.

53.

0. Restart Met Manager and verify that new data can now be added to the data
table. Thenif applicable, restart Met Mirror and Met Viewer.

From the above question, | had to delete a data table from the project folder to correct
acorrupted database. What can | do to minimize this type of problem from occurring
again? Firgt, install an uninterruptible backup power supply on your computer. This
protects your computer against short power outages. Second, make a daily backup of
your project database. That way you can at least restore most of your data. Y ou can
also use Met Mirror to make amirrored copy of the project database. If properly
installed, the mirrored copy will be more up-to-date than a daily backup.

| just packed the database with Met Manager. Why didn’t the size of one of the data
tables change? Packing has no effect on data tables that are not wrapped. These data
tables have their “Keep data indefinitely” property enabled. Also, the pack will not
work if some other software such as Met Mirror or Met Viewer is attached to the
project database. Met Manager cannot pack the database if other applications are
using it. Be sureto shut them down first.
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APPENDIX A
DATA SOURCE AND DATABASE PARAMETERS

I. List of Data Source and Derived Database Parameters

Data source parameters represent data values that come from the data stream between
the datalogger (or other source of data such as afile) and Met Manager, and that have
been converted to base units.

Data source parameters are based on data types. Data types are meant to be general; for
example, a“temperature” data type might be ambient temperature, soil temperature,
indoor temperature or some other type of temperature. The data type becomes an
“acquired” data source parameter when the user defines the properties of that data type,
such as giving the data type a specific name (e.g., ambient temperature).

Table 1
Data Source Parameters
Data Source Parameters Units
Evaporation or ET in, mm
Humidity (relative) %
L eaf Wetness 0-100 (unitless)
Moisture (soil, etc.) %
Precipitation (rain, snow, €etc.) in, mm
Pressure (barometric, etc.) inHg, mmHg, hPa, kPa, atm, mb, bar, char
Solar Energy Jm?, KIm?, MIm?, W-hr/m?, Langley
Solar Radiation (global, net, or direct) W/m*
Temperature (all types) °C, °F
User-defined Average user-supplied unit
Voltage volt, mV
Wind Direction (horizontal and vertical) deg, sector (horizontal winds only)
Wind Speed (horizontal and vertical) mph, knots, m/s

Database parameters are those acquired and derived parameters that the user has
assigned to be stored within Met Manager’ s database.

Acquired and Derived Parameters A-1 Rev: 1.5



Met Manager ™ User’s Manual Copyright © 2002
Table 2
Database Parameters

Derived - Standard Parameters Units
Dewpoint °C, °F
Heat Index °C, °F
Relative Humidity %
Solar Energy Jm?, KIm®, MIm?, W-hr/m?, Langley
Wet Bulb Temperature °C, °F
Wind Chill Temperature (After Nov 1, 2001) °C, °F
Wind Chill Temperature (Traditional) °C, °F

Wind Derived Parameters
Resultant V ector Wind Direction (horizontal) deg, sector
Resultant Wind Speed (horizontal) mph, knots, m/s
Scalar Vertical Wind Direction deg
Scalar Vertical Wind Speed mph, knots, m/s
Scalar Wind Direction (horizontal) deg, sector
Scalar Wind Speed (horizontal) mph, knots, m/s
Sigma-Phi (std dev of Vertical Wind Direction) | deg
Sigma-Theta (std dev of horizontal Wind Dir.) | deg

Standard deviation of Vertical Wind Speed mph, knots, m/s

Standard Deviation of Wind Speed (horizontal) | mph, knots, m/s

Unit Vector Wind Direction (horizontal) deg, sector

Agriculture Derived Parameters Units

Chill Hour (Standard Base Method)

CH (number of chill hours)

Chill Hour (Base with Lower Cutoff)

CH (number of chill hours)

Chill Hour (Base with Lower Cutoff and
Ceiling Negation)

CH (number of chill hours)

Chill Unit (32°F to 45°F)

CU (number of chill units)

Chill Unit (45°F and Under)

CU (number of chill units)

Chill Unit (Utah Model)

CU (number of chill units)

Chill Unit (Utah-Pomology Model)

CU (number of chill units)

Growing Degree Day (Integration)

DD°C, DD°F (degree daysin °C or °F)

Growing Degree Hour (Integration)

DH°C, DH°F (degree hoursin °C or °F)

Crop ET (Integration)

in, mm (implied in or mm per time period)

Ref. ET.s, Short, Standardized ASCE
Penman-Monteith (Integration)

in, mm (implied in or mm per time period)

Ref. ET,, Tall, Standardized ASCE
Penman-Monteith (Integration)

in, mm (implied in or mm per time period)

Energy Derived Parameters

Cooling Degree Days (Integration)

DD°C, DD°F (degree daysin °C or °F)

Heating Degree Days (I ntegration)

DD°C, DD°F (degree daysin °C or °F)
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Other Derived Parameters
Change (from successive time intervals) Unit is same as primary parameter
Difference (over sametimeinterval) Unit is same as primary parameters
Maximum Unit is same as primary parameter
Minimum Unit is same as primary parameter
Rate User-supplied unit
Standard Deviation Unit is same as primary parameter

ll. Explanation of Data Source and Derived Database Parameters

A. Data Source Parameters

Data source parameters include:

agrwbdE

No

0.

10.

11.
12.
13.

Evaporation or ET - Evaporation or evapotranspiration (ET) data type
Humidity - Humidity datatype; usualy relative humidity

Leaf Wetness - Leaf wetness data type typically scaled from 0 to 100.
Moisture - Moisture data type; for example soil moisture.

Precipitation - The generic type includesrain, snow, ice, etc., but usually
expressed as“rain” or “rainfall.”

Pressure - Pressure data type; for example barometric pressure.

Solar Energy - Solar energy data type expressed in units of Jm? KJm? MJ/nv,
W-hr/m? or Langley. A unit of MJm?is commonly used.

Solar Radiation - Solar radiation data type expressed in radiation flux units of
W/

Temperature - Temperature data type; for example, ambient temperature,
indoor temperature, soil temperature, and so forth.

User-defined Average - A datatype that represents an average value and in
which the name and units are assigned by the user.

Voltage - A voltage data type; for example, datalogger battery voltage.
Wind Direction - A wind direction data type.

Wind Speed - A wind speed data type.

B. “Derived - Standard” Database Parameters

“Standard” derived database parameters include:

1.

2.

Dewpoint - The calculation of this parameter requires ambient temperature
(same as dry bulb temperature) and relative humidity.

Heat index - The calculation of this parameter requires ambient temperature
and relative humidity. The heat index equals ambient temperature when the
ambient temperature is below 70 °F.
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Relative humidity - Normally this parameter is measured directly. However,
it can be calculated from ambient temperature and dew point (when dew point
ismeasured). Unitsarein percent (%).

Solar energy - The calculation of this parameter requires solar radiation.
Units include Jm?, kIm?, MJm? Watt-hr/m? and Langley. “MJm? isa
common selection.

Wet bulb temperature - The calculation of this parameter requires ambient
temperature, dew point and barometric pressure.

Wind chill (Nov 1, 2001) - Thiswind chill temperature is based on the joint
United States and Canadian wind-chill index effective November 2001. The
calculation requires ambient temperature and wind speed. This newer wind
chill temperature equals ambient temperature when the wind speed is less than
3 mph.

Wind chill (Traditional) - Thiswind chill temperature precedes the newest
update of November 2001. Its calculation requires ambient temperature and
wind speed. Thisolder wind chill temperature equals ambient temperature
when the wind speed is less than 4 mph.

C. “Wind” Derived Database Parameters

“Wind” derived database parameters are discussed in the U.S. Environmental Protection
Agency (EPA) document titled “ Meteorol ogical Monitoring Guidance for Regulatory
Modeling Applications,” EPA-454/R-99-005, February 2000. These parameters include:

WCoNooU~wWNE

Resultant vector wind direction (for horizontal wind)

Resultant wind speed (for horizontal wind)

Scalar vertical wind direction

Scalar vertical wind speed

Scalar wind direction (for horizontal wind)

Scalar wind speed (for horizontal wind)

Sigma-Phi, standard deviation of vertical wind direction

Sigma-Theta, standard deviation of wind direction (for horizontal wind)
Standard deviation of vertical wind speed

10 Standard deviation of wind speed (for horizontal wind)
11. Unit vector wind direction (for horizontal wind)

D. “Agriculture’ Derived Database Parameters

“Agriculture” derived database parameters include:

1.

Chill Hour (Base with Lower Cutoff and Ceiling Negation) - One chill hour
accumulates for each hour that the hourly average ambient temperature is
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between the base temperature and the lower cutoff temperature. One hour is
negated for each hour that the ambient temperature is above the ceiling

temperature.
Hourly Average Temperature | Chill Hour
TEaqg < Lower Cutoff 0.0
Lower Cutoff < TEyg < Base 1.0
Base < TEag < Celling 0.0
TEaq > Ceiling -1.0

The lower cutoff, base, and ceiling temperature values are set by the user
when the database parameter isfirst created. Default settings are: lower cutoff
temperature (32°F), base temperature (45°F), ceiling temperature (65°F).

2. Chill Hour (Base with Lower Cutoff) - This accumulation of chill hoursisthe
same as item 1 above, except there is no negation above a celling temperature.

Hourly Average Temperature | Chill Hour
TEaqg < Lower Cutoff 0.0
Lower Cutoff < TEaq < Base 1.0
TEaq > Base 0.0

Default settings are: lower cutoff temperature (32°F), base temperature
(45°F).

3. Chill Hour (Standard Base Method) - One chill hour is accumulated for each
hour that the hourly average ambient temperature is below a user-defined base
temperature. Thereisno lower cutoff temperature with this method.

Hourly Average Temperature | Chill Hour
TEag < Base 1.0
TEaq > Base 0.0

The default base temperature is 45°F.

4. Chill Unit (32°F to 45°F) - One chill unit is accumulated for each hour that the
hourly average ambient temperature is between 32 to 45°F.

Hourly Average Temperature | Chill Unit
TEag<32°F 0.0
32°F < TEaq < 45°F 1.0
TEaq > 45°F 0.0
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5. Chill Unit (45°F and Under) - One chill unit is accumulated for each hour that
the hourly average ambient temperature is 45°F or less.

Hourly Average Temperature | Chill Unit
TEaq < 45°F 1.0
TEaq > 45 °F 0.0

6. Chill Unit (Utah Model) - One chill unit, or afraction of a chill unit, is
accumulated for each hour that the hourly average ambient temperature is
within the range stated in the table below:

Hourly Avg Temperature Chill Unit

TEaq<35°F 0.0
35 < TEag< 36 °F 0.5
37 < TEag < 48 °F 1.0
49 < TEaq < 54 °F 0.5
55 < TEaq < 60 °F 0.0
61 < TEaq < 65 °F -0.5

TEaq > 65 °F -1.0

7. Chill Unit (Utah-Pomology Model) - One chill unit, or afraction of achill
unit, is accumulated (or negated) for each hour that the hourly average
ambient temperature is within the range stated in the table below:

Hourly Avg Temperature Chill Unit
TEag <34.01 °F 0.0
34.01 < TEqq < 36.01 °F 0.5
36.01 < TEaq < 48.01 °F 1.0
48.01 < TEaq < 54.01 °F 0.5
54.01 < TEqq < 60.01 °F 0.0
60.01 < TE, 4 < 65.01 °F -0.5
TEag > 65.01 °F -1.0

8. Growing Degree Day (Integration) - Daily growing degrees are calculated by
totaling (integrating) the Growing Degree Day values reported for each hour
of the day.

Hourly Average Temperature Growing Degree Days
(for the hour)
TEaq < Base 0.0
Base < TEa < Ceiling (TEayq - Base)/24
TEaq > Ceiling (Celling - Base)/24

The base and ceiling temperature settings are supplied by the user when
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creating the Growing Degree Day database parameter. The default ceiling
and base temperatures are 86°F and 50°F, respectively.

9. Growing Degree Hour (Integration) - Hourly growing degrees are
accumulated for each hour that the hourly average ambient temperature is

within the range stated in the table below:

Hourly Average Temperature Growing Degree Hours
TEaq < Base 0.0
Base < TEag < Celling (TEayg - Base)
TEaq > Ceiling (Celling - Base)

The base and ceiling temperature settings are supplied by the user when

creating the Growing Degree Hour database parameter. The default ceiling
and base temperatures are 86°F and 50°F, respectively.

10. Crop ET (Integration) - Daily Crop Evapotranspiration (ETc) is calculated by
totaling (integrating) the Crop ET values reported for each hour of the day.

For acrop ET based on areference to short grass (similar to clipped grass):

ETC = ETOS X KC X KSTRESS

For acrop ET based on areference to tall grass (similar to alfalfa):

ETc = ETs X K¢ X Kstress

where:

ETc = Crop Evapotranspiration (mm or inch per period)

ETos = Reference Evapotranspiration calculated from the

standardized short-grass ASCE Penman-M onteith equation (mm or
inch per period); seeitemsll1 and 12 below.

ET.s = Reference Evapotranspiration calculated from the
standardized tall-grass ASCE Penman-Monteith equation (mm or
inch per period); seeitemsll1 and 12 below.

K¢ = Crop coefficient (dimensionless)
Ksrress = Stress factor (dimensionless); 0to 1.0 (1.0 if no stress)

The default K¢ and K stress coefficients have values of 1.0.

11. Ref. ET,s, Short, Standardized ASCE Penman-Monteith: Daily Reference ET
(ETos) asreferenced to a short grass of 0.12 m height (similar to clipped grass)
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and calculated by totaling (integrating) the Reference ET s values reported for
each hour of the day. For further information, refer to the report on The
ASCE Standardized Reference Evapotranspiration Equation, Environmental
and Water Resources Institute of the American Society of Civil Engineers,
Standardization of Reference Evapotranspiration Task Committee, December
21, 2001.

12. Ref. ETs, Tall, Standardized ASCE Penman-Monteith: Daily Reference ET
(ET,s) asreferenced to atall grass of 0.50 m height (similar to full-cover
afafa) and calculated by totaling (integrating) the Reference ET,s values
reported for each hour of the day. For further information, refer to the report
on The ASCE Standardized Reference Evapotranspiration Equation,
Environmental and Water Resources I nstitute of the American Society of
Civil Engineers, Standardization of Reference Evapotranspiration Task
Committee, December 21, 2001.

E. “Enerqy” Derived Database Parameters

“Energy” derived database parametersinclude:

1. Cooling Degree Day (Integration) - Daily cooling degrees are calculated by
totaling (integrating) the Cooling Degree Day values reported for each hour of
the day based on the range in the following table:

Hourly Average Temperature Cooling Degree Days
(for the hour)
TEaq < Base 0.0
TEaq > Base (TEayq - Base)/24

The default base temperature is 65°F.

2. Heating Degree Day (Integration) - Daily heating degrees are calculated by
totaling (integrating) the Heating Degree Day values reported for each hour of
the day based on the range in the following table:

Hourly Average Temperature Heating Degree Days
(for the hour)
TEaq < Base (Base - TEag)/24
TEaq > Base 0.0

The default Base temperature is 65°F.
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F. “Other” Derived Database Parameters

“Other” derived database parametersinclude:

1.

Change - This parameter calculates the change of a parameter between two
successive measurement intervals (for example, change of barometric
pressure).

Difference - This parameter calculates the difference between two parameters
of the same type over the same time interval (for example, temperature
difference as the difference between the measurements from two matched
temperature probes located at different heights on a meteorological tower.

Difference = Parameter 1 - Parameter 2

Maximum - This parameter calculates the maximum (or high) of a parameter
over ameasurement interval (for example, maximum or peak wind speed).

Minimum - This parameter calculates the minimum (or low) of a parameter
over a measurement interval (for example, minimum or low ambient
temperature).

Rate of a Totalized Value - This parameter calculates the rate of atotalized
value over ameasurement interval (for example, rate of rainfall).

Rate of an Averaged Value - This parameter calculates the rate of an averaged
value over ameasurement interval (for example, rate of ambient temperature).

Standard Deviation - This parameter calculates the standard deviation of a
parameter over a measurement interval. Note that wind speed and wind
direction parameters require special processing, so their standard deviation
should be calculated by selecting an appropriate derived parameter fromthe
“Wind” tab.
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APPENDIX B
MET MIRROR UTILITY

|. Overview

Met Mirror™ is used to create and update a copy of the Met Manager database. Thisis
referred to asmirroring. The Met Mirror software is used only in a networked
environment and its useis optional.

Il. Installing Met Mirror

The Met Mirror software is automatically installed on a Windows-based workstation
during installation of the Met Manager software.

IMPORTANT: Met Mirror uses the Windows registry to retain information about its
definition files. Thisinformation isthen read from the registry on startup of Met Mirror.
Therefore, Met Mirror must be installed in away that it can have create/read/write access
to the Windows registry. Before installing Met Mirror, check with your network or
system administrator to ensure that your log-on profile is configured to allow Met Mirror
to have create/read/write access to the Windows registry.

Refer to Section 2.3 for scenarios for using Met Manager, Met Viewer, and Met Mirror.
Included are requirements for project folder read/write/create access permission
depending on your application requirements.

IMPORTANT: Configure Met Mirror to automatically startup when Windows starts up.
Place a shortcut of the Met Mirror executable program (metmrr.exe) in the Windows
“Startup” folder. Thisfolder may be located under “ Administrators’, “All Users’,
“Default Users®, or may be applicable only to your particular log-on profile depending on
your version of Microsoft Windows. Check with your network or system administrator
for the proper startup folder to contain the Met Mirror shortcut.

Command line options are not required but are useful for forcing Met Mirror to open a
particular definition file when starting up in Windows. If you use acommand line
option, you will want to assign it to the Met Mirror shortcut in the Windows “ Startup”
folder. See Appendix D.
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Ill. Using the Software

When Met Mirror isrun, the following dialog is displayed:

Select the drop down box in the upper |eft corner to add a new mirror definition name to
hold the Met Mirror settings, or to select an existing mirror definition name. Asan
example, the following figure shows that a mirror definition named “TAMU V4
Mirrored” aready exists:

(The above figure is an example only; your configuration may be different.)

Check the “Hide application on startup” option to hide Met Mirror from the desktop
whenitisrun. Met Mirror appears as an icon in the “tray” region of the Windows task
bar.

Check the “ Perform database wrap” option to wrap the mirrored database on startup of
Met Mirror with the same wrap options as performed by Met Manager. Thisisuseful if
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you periodically, but not continuously, run Met Mirror. Inany event, Met Mirror
performs this wrap function at midnight. Thusif Met Mirror isrun continuously, it’s best
to leave this box unchecked.

Check the “ Terminate application after Mirror is up-to-date” to stop Met Mirror as soon
asit has updated the mirrored database to match the original database managed by Met
Manager. For continuous mirroring, leave this box unchecked.

In the “ Source folder/directory for Met database”, enter the path and folder name to Met
Manager’ s project.

In the “ Destination folder/directory for Met database”, enter the path and folder name to

Met Mirror’s project. Thisisthe path and folder name for the destination location of the
mirrored database. The path/folder must be created outside of Met Mirror; for example,

with Microsoft Windows File Explorer software.

Select (check) each of the data tables that you want mirrored. Note that the hourly data
table is always mirrored; thus you cannot select it. It isalright to select aMet Manager
datatable that does not exist as the setting will be ignored. That way, should a new data
table later be added to Met Manager, the new table will then be automatically mirrored by
Met Mirror.

IMPORTANT: Pressthe“ Save” button to save the settings. The settings will be saved
in the Windows registry under the definition name given to the mirror.

To start the mirror activity, pressthe “ Start” button. To hide the mirror from the desktop,
but still keep its“Met” icon in the tray region of the Windows desktop, press the “Hide”
button.

Below is an example of settings for a continuously-connected mirror definition named
“TAMU V4 Mirrored”:
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(The above figure is an example only; your configuration may be different.)

IV. Auto-starting Met Mirror

For normal usage in which Met Mirror continuously maintains a mirrored copy whenever
Met Manager is running, follow these steps:

1. Run Met Mirror and add a new mirror name, or select an existing name (from the
drop down box). Then configure the settings and press the “ Save” button.

2. Setup Met Mirror to run in the Windows “ Startup” folder as discussed in Section |1
above.

IMPORTANT: If you use acommand line option when starting Met Mirror, be sure to
set the “-0” (oh; not zero) command line option with the identical name of the mirror
definition. If the name includes spaces, then you must include the entire -o and name
within quotation marks (e.g., “-oMirror Name”). In the above example (Section 11), the
command line option is“-0oTAMU V4 Mirrored” to automatically activate a definition
named “TAMU V4 Mirrored” on startup of Met Mirror.
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APPENDIX C
MET DATABASE UTILITY

|. Overview

The Met Database Utility (sometimes referred to as“MetDBU”) is used to perform
periodic maintenance on amirrored database. With this utility, you can restructure the
database, and can pack it. Restructuring is useful only to fix a structure problem with the
mirrored database, should it ever occur. Packing permanently removes all deleted records
from the database, and should be performed periodically on data tables that are wrapped.

Note: The restructure and pack capabilities are also included in the Setup menu of Met
Manager for maintenance of the database managed by Met Manager. The advantage of |
having a separate utility program is that this program can be run on mirrored copies of the |
database, and independently of Met Manager.

Il. Installing the Met Database Utility

The MetDBU utility software is automatically installed on a Windows-based workstation
during installation of the Met Manager software. Once installed, select and run the Met
Database Utility program from the Start | Program menu of the Windows desktop. Y ou
can also setup a shortcut icon on the desktop.

Note: Command line options are normally not required for MetDBU but are useful for
forcing MetDBU to start in a particular way. See Appendix D.

I1l. Restructuring the Project Database

The project database managed by Met Manager or Met Mirror must be restructured when
changes are made to the database parameters. For example, when adding or removing
acquired or derived parameters, the database must be modified to reflect the added or
removed fields.

IMPORTANT: Met Manager automatically restructures its project database when new
parameters are added or deleted. Therefore you will not normally perform a restructure
with MetDBU. The only time you will use MetDBU to perform arestructure is when
something happens to the structure of a mirrored database, and you need to repair it.

IMPORTANT: Before restructuring, insure that there are no active connections to the
database. Thisincludes connections by Met Manager, Met Viewer, Met Mirror, or any
other import/export/reporting software. Stop and close all programs that may have
connections to the database.
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CAUTION: Be sure that you have a good backup of the project database before
restructuring it.

The following dialog is displayed when the Met Database Utility softwareisrun:

To restructure a database, locate the project folder with the “Browse” button and press
the “ Restructure” button.

Note: The restructure operation can take awhile, in some cases 20 to 30 minutes (or
longer) depending on the number and size of the data tables, and speed of your network.

The restructure operation can fail for the following reasons:

e Thereistill an active connection to the database (i.e. Met Manager, Met Viewer,
or Met Mirror may still be running). The database cannot be restructured when an
active database connection exists.

e A fileerror occurs. If afile error occurs while attempting to restructure the
database, the restructure will fail.

IMPORTANT: Following the restructure operation, restart Met Mirror and any other
programs that need access to the mirrored project database.

IV. Packing the Project Database

The project database managed by Met Mirror must be periodically packed so that deleted
records are permanently removed from the database. For instance, if datafor a 1-minute
table is "wrapped" at seven (7) days, the records deleted from the table by the wrap
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function still remain in the database even though they are not visible to the application.
Even when awrap is used, the wrap function does not reduce the actual size of thefile.
To reduce the file size and permanently remove the deleted records, the database must be
periodically packed.

IMPORTANT: To pack Met Manager’ s project database, use the “Pack” operation i
located in Met Manager’s Setup menu. Only use the MetDBU utility to pack a mirrored

| project database.

Below isarecommended pack schedule; use the minimum pack schedule (i.e., maximum
frequency) that appliesto your table configuration.

Data Table Interval

(with “ Delete data older Pack Schedule

than” option set)

1 Minute Data Table Every 1 month

5 Minute Data Table Every 3 months

10 Minute Data Table Every 6 months

15 Minute Data Table Every 6 months

20 Minute Data Table Every 6 months

30 Minute Data Table Every 6 months
Hourly Data Table Once ayear

Note: You do not have to pack data tables that are setup with the “Keep dataindefinitely”
option, since these data tables are not wrapped.

Note: When a pack is performed, all the data tables within the project database are
packed. That’'swhy the pack schedule should be based on the minimum period
(maximum frequency) of the data tables assigned to the project.

IMPORTANT: Before packing, insure that there are no active connections to the
database. Thisincludes connections by Met Manager, Met Viewer, Met Mirror, or any
other import/export/reporting software that is attached to the database. For all programs
that may have a connection to the database, stop and close them to remove their
connections.

To pack the database and permanently remove any deleted data records, select the  Pack”
tab. Thefollowing dialog is then displayed:
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Locate the project folder with the “Browse” button and press the “Pack” button.

Note: The pack operation can take awhile, in some cases 20 to 30 minutes (or longer)
depending on the number and size of the data tables, and speed of your network.

The pack operation can fail for the following reasons:

e Thereisill an active connection to the project database (i.e., Met Manager, Met
Viewer, or Met Mirror may still be running). The database cannot be packed
when an active database connection exists.

e Afileerror occurs. If afileerror occurs while attempting to pack the database,
the pack operation will fail.

IMPORTANT: Following the pack operation, restart Met Mirror and any other
programs that need access to the mirrored database.

V. Met Database Utility Command Line Options

Y ou can aso start the Met Database Utility software with acommand line option. Edit
the utility’ s properties to include a command line startup option. For further instructions,
see Appendix D - Command Line Options.
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APPENDIX D
COMMAND LINE OPTIONS

|. Overview

Why would someone want to use a command line option? Command line options
provide flexibility in the startup and subsequent use of Met Manager, Met Viewer, Met
Mirror, and Met Database Utility software. For example, in conjunction with atask
scheduler (such as provided with Windows 98 and beyond), Met Manager can be
configured to startup and acquire data from a particular data source, for example a*“Data
Log Capture (Modem)” data source, and store the acquired and derived data parameters
into a particular project folder:

(Example from “ Scheduled Tasks’ of the Control Panel of Windows 2000 Workstation)

In thisway, Met Manager can retrieve data from multiple remote weather stations and
can store the data into separate projects. Or, you may wish to force the software to
startup and open a particular project and use a particular data source to override any user
configuration settings.

The command line option is defined in Windows by accessing and selecting a shortcut to
the program executable, right-clicking on the shortcut with the mouse, and then setting
the “properties’. The program executable names are:

Met Manager = metmgr.exe

Met Viewer = metvwr.exe

Met Mirror = metmrr.exe

Met Database Utility = metdbu.exe

For example, to setup the Met Manager command line, right-click on a shortcut created
from the Met Manager program executable; then select the “ Properties’ item:

Command Line Options D-1 Rev: 15



Met Manager ™ User’s Manual Copyright © 2002

or right-click on Met Manager from the Windows desktop “ Start Programs’ menu:

Then select “Properties’ and configure the “ Target” property with the desired command
line option:
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(The above figure is an example only; your configuration may be different. Also, the
setup requirements may be different for different version of Microsoft Windows. The
above exampleisfor a Windows 2000 workstation.)

An example “Target” command line for Met Manager is:

"C:\Program Files\Met Manager\Met Manager 4\metmgr.exe” "'-pC:\my
projects\weather” ""-oDirect Connect”

See below for a description of the above command line option.

IMPORTANT: Met Manager, Met Viewer, and Met Mirror use the Windows registry to
retain information about how they were last shut down. Thisinformation isthen read
from the registry on startup. Therefore, these programs must be installed in a way that
they can have create/read/write access to the Windows registry. Before installing these
programs, check with your network or system administrator to ensure that your log-on
profileis configured to allow these programs to have create/read/write access to the
Windows registry.

IMPORTANT: Also refer to Section 2.3 for scenarios for using Met Manager, Met
Viewer, and Met Mirror. Included are requirements for project folder read/write/create
access permission depending on your application requirements.
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IMPORTANT: Configure Met Manager and Met Mirror to automatically startup when
Windows starts up. Place a shortcut of the Met Manager and Met Mirror executable
programs (metmgr.exe and metmrr.exe) in the Windows “ Startup” folder. Thisfolder
may be located under “Administrators’, “All Users’, “Default Users*, or may be
applicable only to your particular log-on profile depending on your version of Microsoft
Windows. Check with your network or system administrator for the proper startup folder
to contain the shortcuts. (Y ou may aso want Met Viewer to automatically startup when
Windows starts up. If so, the same requirements apply to Met Viewer.)

Il. Met Manager

The command line format is:

.- \path\metmgr.exe [-p]l[-]1Iproject path] [-o][data source name]
where:

“.\path\” isthe path to the Met Manager executable program; in the example of
Section | as* C:\Program Files\Met Manager\M et Manager 4\”. Replace“..\path\”
with your actual path name to the Met Manager executable program on your
computer.

“MetMgr.exe” isthe name of the Met Manager executable program

-p  isthe command line option for specifying a project to open on startup or selecting
no project to be opened.

For example, to open a project in the folder <C:\My Projects\Weather>, the
command lineis:

“..\path\metmgr.exe” "-pC:\my projects\weather”

To insure that Met Manager does not open a project when it starts up, then the
command lineis:

“..\path\metmgr.exe” -p-

If no -p option is specified, then the default action is to open the project that was
active when Met Manager was last shut down. The project pathname is read from
the Windows registry.
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-0 isthe command line option for automatically opening a named data source when
the project, specified by the -p option, isopened. Thisactionisvalid aslong as
you did not rename the data source within Met Manager.

IMPORTANT: The data source name within Met Manager must exactly match
the name given in the -o option.

If no -0 option is specified, the default action isto open the named data source
that was active when Met Manager was last shut down. If Met Manager was
logging data from the data source when Met Manager was shut down, then Met
Manager will begin logging data from the named data source when started back
up. However, this default action is not implemented if a project is not opened.

For example, to open a project in the folder <C:\My Projects\Weather> and automatically
begin data collection using a pre-defined data source name of “Direct Connect” then the
command line would be:

“..\path\metmgr.exe” "-pC:\my projects\weather” “-oDirect Connect”

IMPORTANT: If acommand line option has embedded blank spacesin it, then the
entire command line option must be enclosed in double quotation marks.

I1l. Met Viewer

The command line format is:
- -\path\metvwr.exe [-p]L[-]1I[project path] [-u][user name]
where:

“.\path\” isthe path to the Met Viewer executable program. Replace“..\path\” with
your actual path name to the Met Viewer executable program on your computer.

“Metvwr .exe’ isthe name of the Met Viewer executable program

-p  isthe command line option for specifying a project to open on startup or selecting
no project to be opened.

For example, to open a project in the folder <C:\My Projects\Weather>, the
command lineis:

“_.\path\metvwr.exe” "-pC:\my projects\weather”

To insurethat Met Viewer does not open a project when it starts up, then the
command lineis:
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“_.\path\metvwr._exe” -p-

If no -p option is specified, then the default action is to open the project that was
active when Met Viewer was last shut down. The project pathnameis read from
the Windows registry.

-u isthe command line option that specifies the user view settingsto apply in Met
Viewer.

For example, to open a project in the folder <C:\My Projects\Weather> and apply the
user setup view settings for Met Viewer user <RJones>, then the command line would
be:

“..\path\metvwr.exe” "-pC:\my projects\weather” '"-uRJones"

Note: At startup, the default action if no -p command line option is specified, isto open
the project that was opened prior to shutting down Met Viewer. Similarly, the default
action if no -u command line option is specified and the same project is opened, isto use
the view settings of the last user setup that viewed the project.

IMPORTANT: If acommand line option has embedded blank spacesin it, then the
entire command line option must be enclosed in double quotation marks.

IV. Met Mirror

The command line format is:
.. \path\metmrr.exe [-o][definition name]
where:

“.\path\” isthe path to the Met Mirror executable program. Replace“..\path\” with
your actual path name to the Met Mirror executable program on your computer.

“metmrr.exe” isthe name of the Met Mirror executable program

-0 isthe command line option for specifying a mirror definition to activate on
startup. Thisdefinition is retained in the Windows registry.

For example, to run met mirror and activate the definition named <Test Mirror>, then the
command line would be:

. .\path\metmrr.exe ""-oTest Mirror"
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Note: A command argument with [/O] instead of [-0] is accepted in order to be backward
compatible with previous versions of Met Mirror. Always use“-0" (oh; not zero) instead
of “/O” to be compatible with current and future versions of Met Mirror.

Note: At startup, the default action if no -o command line option is specified, is to not
open any mirror definition.

IMPORTANT: If acommand line option has embedded blank spacesin it, then each
entire command line option must be enclosed in double quotation marks.

V. Met Database Utility

The command line format is:
- -\path\metdbu.exe [-p][project path] [-u+] [-a][{Pack}{Restructure}]
where:

“.\path\” isthe path to the Met Database Utility executable program. Replace
“.\path\” with your actual path name to the utility program on your computer.

“metdbu.exe’ isthe name of the Met Database Utility executable program

-p  isthe command line option for specifying a project to open. For example, to open
aproject in the folder <C:\My Projects\Weather>, the command lineis:

“..\path\metdbu.exe” "-pC:\my projects\weather”

To insure that MetDBU does not open a project when it starts up, then the
command lineis:

“_.\path\metdbu.exe” -p-

If no -p option is specified, then the default action is to open the project that was
active when MetDBU was last shut down. The project pathname is read from the
Windows registry.

-u isthe command line option specifying user interaction. The default is-u- for no
user interaction. For user interaction, use -u+.

-a isthe command line option for specifying the action for the database utility to
automatically perform. The action must be one of the following: “Pack” or
“Restructure’; for example:

. .\path\metdbu.exe “-pC:\my projects\weather” -u+ -aPack
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APPENDIX E
Calibration Overview

|. Data Path and Adjustments

The path from a physical weather variable to the data displayed in atable or agraphis
not trivial. Thefigure below illustrates atypical path beginning at the input to the MET
Instrument, proceeding to the Data L ogger, and on to the Met Manager™ software for
storage and presentation.
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| INSTRUMENT I | ANALOG I DIGITAL |
| | L |
I 1 |
| sensor catapil | sienad cAL. | ADC oA |
| | conDITIONING — POTS. | MATH |
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| UNITS CORRECTION UNITS |
- _
FIGURE 1

While on its path to the user, the measured weather variable may be altered in up to three
different ways:

1. Thevariable may be physicaly atered by mechanical adjustmentsinthe MET
I nstrument.

2. Thevariable may be electronicaly altered in the MET Instrument, the Data
Logger, or both. Thisusually involves amplifiers and potentiometers that alter the
analog gain and offset.

3. Thevariable may be atered by computer calculations (including digital slope and
offset adjustments) in the Data L ogger, Met Manager, or both.
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There are four reasons a weather variable may be altered:

1. Thevariableisconverted from its physical form to an electronic signal (voltage,
current, resistance, counts, pulses, etc.) with appropriate range and resolution.

2. Thevariableis converted into adigital number that can be stored, displayed, and
analyzed with the aid of a datalogger or computer.

3. Thevariableis converted into engineering units appropriate for the physical
weather variable being measured.

4. The variable should be adjusted to agree with accepted calibration standards
thereby assuring the accuracy of the measurement is suitable for its intended use.

Each of these reasons can be accomplished in one or more of the mgjor system
components. Usually, physical conversion and initial electronic signal scaling are done
in the Met Instrument. Signal scaling, conversion to digital form, and initial engineering
units conversions are often done in the Data Logger. Base unit and other engineering unit
conversions are usually donein Met Manager.

Calibration adjustments can be made in any of the three major system components. Itis
very important that calibration adjustments be made with care to assure corrections are
not erroneously applied in multiple places. Multiple calibration corrections could result
in incorrect values being stored and presented in various tables, reports, and graphs.

Il. Calibration Methods

There are pros and cons to consider when deciding where and how to adjust the
measurement to agree with calibration standards. There is usually atradeoff between
convenience, component interchangeability, and accuracy. Component
interchangeability is enhanced if the Met Instrument and Data L ogger are individually
and independently calibrated. In doing so, the Met Instrument is connected to an
appropriate calibration standard and its output is adjusted physically and/or electronically
to its specified nominal values corresponding to the values of the standard connected to
itsinput. Thisrequires an additional instrument to measure the output of the Met
Instrument. Similarly, the corresponding Data Logger channel is calibrated by
connecting itsinput to a calibration standard that provides asignal of the same physical
type (e.g. if the MET Instrument is atemperature to voltage device, then avolt meter and
source are required) as the output of the Met Sensor and adjusting the Data Logger’'s
output until it agrees with the standard. Note that this requires two standards and the
ability to accurately measure the output of the Met Instrument. It makes the accuracy and
traceability of the output of the weather instrument an additional calibration and accuracy
burden. The benefit isthat either the Met Instrument or the Data Logger can be replaced
and the measurement accuracy will remain with the limits established by the entire
ensemble of instrumentation. The calibration ensemble that affects the overall accuracy
includes:
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The Met Instrument (precision, drift, and stability)

The Data Logger (precision, drift, and stability)

AND the weather variable calibration standard (accuracy)

AND the instrument used to measure the output of the Met Instrument (accuracy)
AND the standard used to calibrate the Data L ogger (accuracy)

CAUTION: Inthe above context, it is very important that adjustments made in the Met
Instrument pertain only to the Met Instrument’ s accuracy and that adjustments made to
the Data L ogger pertain only to the Data Logger’ s accuracy.

Note: Additionally, steps should be taken during the calibration process to demonstrate
the overall integrity of the data. If the datais stored and processed by a computer that is
located downstream of the Data Logger, it isagood practice to provide calibration data
that demonstrates that the data stored and presented are in good agreement with the
weather variable calibration standard. This requires observations and recording of data
stored and displayed on the computer located downstream of the Data L ogger.

Accuracy and convenience are enhanced with an “ endpoint-to-endpoint” calibration.
With this type of calibration, a calibration standard for the weather variable is connected
to the input of the Met Instrument. Then the output of the Data L ogger, or the output of a
downstream computer, is observed. The values of intermediate signals are not relevant.
While the Met Instrument and the Data L ogger are not interchangeabl e without
calibration, the total error is reduced because the calibration ensemble (i.e. the number of
devices contributing error) has been reduced to only:

e The Met Instrument (precision, drift, and stability)
e TheDatalLogger (precision, drift, and stability)
e AND the weather variable calibration standard (accuracy)

Reducing the total error is great, but acritical question remains. If the observed output
does not agree with the standard, where should you make the required adjustments?
Should you adjust the Met Instrument or the Data Logger? In most cases, the computer
downstream of the Data Logger does not provide calibration support. Thisis not the case
with Met Manager. Met Manager facilitates “ endpoint-to-endpoint” calibrations by
providing calculationsto correct for linear errors. Met Manager also simplifies the
calibration process.

I1l. Met Manager Calibration

Met Manager provides three levels of basic signal adjustments:

e Conversion from the Data Logger’ s output format to base units.
e Correction for calibration slope and offset (optional).
e Conversion to abroad set of additional engineering units for display and analysis.
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Each of the signal adjustmentsis alinear transformation as described below:

y=mex+hb

where: x isthe value prior to adjustment
y isthe value after adjustment
mis the slope

and  bisthe offset

Each level of adjustment made by Met Manager is distinct and separate, having its own
slope and offset.

Met Manager’sinitial calibration slope and offset adjustments are assigned default values
of one and zero, respectively. If these values are not changed (viaMet Manager’s
calibration capability), then it is expected that any necessary calibration adjustments have
been made in the Met Instrument and/or the Data Logger. Thisisusually appropriate for
standal one applications where the Data L ogger is located remotely from Met Manager, or
in which the data from the Data L ogger is made available to more than one external
application. For casesin which Met Manager is directly connected to alocal Data
Logger, and isthe only direct consumer of the data from the Data Logger, theniitis
appropriate to perform an endpoint-to-endpoint calibration from the Met Instrument to
Met Manager using Met Manager’ s internal calibration capability.

IMPORTANT: If calibration adjustments are made at the Met Instrument or the Data
Logger, then ensure that Met Manager’ s calibration slope and offset are set to one and
zero respectively so that Met Manager will not apply additional calibration correctionsto
the weather variable.

IV. Additional Considerations

If an “endpoint-to-endpoint™ calibration with Met Manager is more accurate and more
convenient and component interchangeability does not drive the decision, then why
would you ever use another method? When the system operates in a stand-alone batch
mode, there may be other computers, in addition to the one running Met Manager, that
connect to the Data L ogger to extract and use the data (See Figure 2 below). If Met
Manager were used to adjust for calibration errors, then only Met Manager would have
the correct calibrated values. For the other computers to have corrected datavalues, it is
important that the data be properly calibrated at the point of distribution. Therefore, in
this case, any necessary calibration adjustments should be performed in the MET
Instrument, the Data Logger, or both. (An “end-point to end-point” calibration is still
possible if one considers the output of the Data L ogger as the “end-point” of the system
for calibration purposes.)
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What do you do if you have decided that the calibration adjustments should be made in
the MET Instrument and Data L ogger but the Data Logger is only storing relatively long-
term aggregate values such as one hour averages? This can significantly complicate the
calibration process because it may be difficult to get the calibration standard to create a
constant value for the entire averaging period. Whileit is desirable to calibrate a weather
station asit operatesin its normal configuration, some temporary configuration changes
may be required in order to get amore timely output response from the Data L ogger.
Consult the weather station or Data L ogger user manual for ways to increase the
frequency of the Data Logger’ s output (for calibration purposes) while maintaining the
integrity of post-calibration long-term aggregate values.

Note: If the DataLogger’s operating configuration is changed to facilitate calibration
adjustments, it is recommended that some data be captured, following calibration
adjustments, with the calibration standard connected and the Data L ogger reset back to its
normal configuration. This data should be transferred to, and processed by, the post Data
Logger computer. Verify that the outputs agree with the calibration standard. Otherwise,
find and fix the cause of the error.
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